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1 General Information and Warnings 
1.1 About this Manual 

This manual is divided into sections by the section number and the large text at the top of 
a page. Subsections are labelled using the 1.1 and 1.1.1 convention. The page numbers 
appear at the bottom of the pages in the “Page x of y” format. 

1.2 Text Conventions 
Key names are shown in bold and in all capital letters: F1, SELECT, PRINT, etc.  
If a key has dual functions (RPN keys), the key name will be followed by a / and the RPN 
function. For example, the SAMPLE function for the counting app is linked to the F1 key 
so it would appear in the manual as F1/SAMPLE.  

Navigational keys are displayed using directional arrows: , ,  , and  

The indicator’s ENTER key is displayed as . 

Displayed messages appear in bold type and reflect the case of the displayed message.  

1.3 Special Messages 
Special messages used in this manual are defined below. The heading words have 
specific meanings to alert users to additional information or the relative level of hazard. 

ELECTRICAL WARNING! 
THIS IS AN ELECTRICAL WARNING SYMBOL. 
ELECTRICAL WARNINGS MEAN THAT FAILURE TO FOLLOW SPECIFIC 
PRACTICES OR PROCEDURES MAY RESULT IN ELECTROCUTION, ARC BURNS, 
EXPLOSIONS OR OTHER HAZARDS THAT MAY CAUSE INJURY OR DEATH. 

 
WARNING! 
This is a Warning symbol. 
Warnings mean that failure to follow specific practices and procedures may have 
major consequences such as injury or death. 

 
CAUTION! 
This is a Caution symbol. 
Cautions give information about procedures that, if not observed, could result in 
damage to equipment or corruption to and loss of data. 

 
Note: This is a Note symbol. Notes give additional information about the product. 

  
 

1.4 Installation 
 
THE ZM223 DOES NOT CONTAIN USER-REPAIRABLE PARTS. REQUEST REPAIRS 
FROM QUALIFIED PERSONNEL. 
 
WARNING! 
Indicators with CLASS I construction must be connected to the electrical outlet 
with a protective ground connection. 
 



 

Page 8 of 224 
 

WARNING! 
Batteries (battery pack or installed batteries) should not be exposed to excessive 
heat, such as sunlight, fire, or similar sources. 

 
The ZM223 comes fitted with an AC power cable and it must be powered by an electrical 
outlet with a protective ground connection (100-240 VAC, 50/60Hz, 0.5A). To turn on the 
indicator, connect the power cable to the electrical outlet. The indicator will turn on 
automatically if it is configured (or alternatively, if the automatic shut-off function is active, 
the power button must be pressed to fully power on the indicator). Ensure that the plug is 
installed near the equipment and be easily accessible. 

1.4.1 Proper Grounding of Cables 
For the stainless-steel desktop models, cable shield wires must be grounded directly to 
the studs provided at the bottom of the enclosure close to the strain relief entry point.  

 

1.4.2 Safe Handling of Equipment with Batteries 
 

CAUTION: Danger of explosion if the battery is incorrectly replaced. Replace only 
with the same or equivalent type recommended by the manufacturer. Dispose of 
used batteries according to the manufacturer’s instructions. 

 

1.4.3 Wet Conditions 
Under wet conditions, the power supply plug must be connected to the final branch circuit 
via an appropriate socket/receptacle designed for washdown use. 

Installations within the USA should use a cover that meets NEMA 3R specifications as 
required by the National Electrical Code under section 410-57. This allows the unit to be 
plugged in with a rain tight cover fitted over the plug. 

Installations in Europe must use a socket which provides a minimum of IP56 protection to 
the plug/cable assembly. Ensure that the degree of protection provided by the socket is 
suitable for the environment. 

1.5 Routine Maintenance 
This equipment must be routinely checked for proper operation and calibration. 
Application and usage will determine the frequency of calibration required for safe 
operation. 

Always turn off the indicator and isolate it from the power supply before starting any 
routine maintenance to avoid the possibility of electric shock. 

1.6 Equipment Operation 
The operation of this equipment is subject to the following two conditions: 

1. This equipment or device may not cause harmful interference. 
2. This equipment or device must accept any interference. Including the one that 

may cause unwanted operation. 

La operación de este equipo está sujeta a las siguientes dos condiciones: 

1. Es posible que este equipo o dispositivo no cause interferencia perjudicial. 
2. Este equipo o dispositivo debe aceptar cualquier interferencia.  Incluyendo la que 

pueda causar su operación no deseada. 
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1.7 Cleaning the Indicator 
 
 
 
 
 

 
 
 
 
 
 

1.8 Training 
Users must not attempt to operate or complete any procedure on this indicator unless 
they have received the appropriate training or read the instructions. 

To avoid the risk of RSI (Repetitive Strain Injury), place the indicator on a surface which 
is ergonomically satisfactory to the user. Take frequent breaks during prolonged usage. 

1.9 Sharp Objects 
Do not use sharp objects such as screwdrivers, knives/boxcutters, or pens to operate the 
keys. 

1.10  FCC and EMC Declarations of Compliance 
United States 

This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the 
user will be required to correct the interference at his own expense. 

Canada 

This digital apparatus does not exceed the Class A limits for radio noise emissions from 
digital apparatus set out in the Radio Interference Regulations of the Canadian 
Department of Communications. 

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les 
limites applicables aux appareils numériques de la Classe A prescrites dans le 
Règlement sur le brouillage radioélectrique edicté par le ministère des Communications 
du Canada. 

European Countries 

WARNING: This is a Class A product. In a domestic environment, this product may 
cause radio interference in which the user may be required to take adequate measures. 

 

DO DO NOT 
Wipe down the outside with a clean 
cloth, moistened with water and a 
small amount of mild detergent. 

Attempt to clean the inside of the 
indicator.  

Spray the cloth when using a 
proprietary cleaning fluid. 

Use harsh abrasives, solvents, 
scouring cleaners, or alkaline 
cleaning solutions. 
Spray any liquid directly on to the 
display windows. 
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2 Introduction 
The ZM223 is a robust yet easy-to-use weight indicator ideal for both indoor and outdoor 
use. ZM223s comes in a desktop stainless steel model housed in an IP69K enclosure, 
with a large 1.5” high digit 14 segment HTN LCD display with a 4-color backlight (green, 
yellow, red, and orange), and a chemical resistant numeric keypad.  

The indicator has one USB port, two RS232 serial COM ports, an Ethernet port, and 
Bluetooth connectivity. Using these options, the ZM223 can connect to USB flash drives, 
printers, remote displays, computers, PLCs, mobile devices, and other peripheral devices 
via USB, Ethernet, serial, or Bluetooth connections.  

Available options are Analog Output and Severe Transient Voltage Suppression (desktop 
model only) module ideal when connected to large outdoor platforms that may be at risk 
of lightning strikes. This indicator also has six onboard logic level setpoints that can be 
set either as inputs or outputs. See the Specification literature for a full list of 
specifications. 

 

 
Figure 2.1 Front panel of the ZM223  
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2.1 Front Panel   
The ZM223 front panel consists of a display and 19 keys. Never press a key with 
anything but a finger. Using a sharp or rough object to press a key will cause damage to 
the overlay. 

The normal function of the keys on the front panel are listed below. Some keys will have 
special functions in certain applications. Details are provided in the individual application 
sections. In some operator and supervisor menus there is a need to navigate up, down, 
left and right. When in these menus follow the arrows in the blue area of the keys to allow 
users to move around the menu area.  

Key Function 
 

 
 

 Press the TARE key to perform a tare function.  
 Acts as the up-arrow key for menu navigation.  

 

 
  

 Press the SELECT key to toggle between the active display values.  
 Acts as the down arrow key for menu navigation. 
 Allows users to access minus and comma signs. 
 Press and hold to enter the setpoint editor. 

 

 
  

 Press the ZERO key to zero the display/scale. 

 

 
  

 Press the PRINT key to send information to a peripheral printer through one of the 
available communication ports.  

 Acts as the left arrow key for menu navigation. 
 Performs accumulator function when enabled. 

 

 
  

 Press the UNITS key to cycle through the available units of measure while in 
normal operating mode.  

 Acts as the right arrow key for menu navigation. 

 

 

 Press the F1 key to perform the application specific function setup within the 
current app. For example, F1 acts as the SAMPLE key in the Counting app, the 
IN/OUT key in the Truck app, START/STOP key in the filling app, or the TARGET 
key in the Checkweigh app.  

 Press to abort a numeric entry and acts as the ESCAPE key in the menu 
navigation.  

 Press and hold to view the password entry screen for menu access.  
 

 
  

 Press the ENTER key to accept a displayed value or function.  
 Press and hold to enter Standby Mode. 
 Press ENTER key when the indicator is in Standby Mode to turn on the indicator. 
 Press the ENTER key to accept a displayed value or function.  

 
 
 

 

 Use the numeric keypad to enter numbers in the appropriate screens.  
 Press the C (CLEAR) key to clear the last entry. 
 Entering in a number followed by the RPN activation key allows a second function 

to be activated by the key.  
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  RPN extra key function. If an RPN function is activated per key, this allows that 
key to perform a second function. Like ID, Preset Tare, Accumulator channel, PLU 
Select, Base switching, Piece weight entry, Target weight, under, over, print 
format, or Setpoint target values.  

 

2.2 App Specific Function 
The F1 key is the single app specific key. This F1 key function will change based on 
software application that is running within this indicator. Dedicated key labels can be 
used to cover the F1 key to help operators better use this indicator.   

2.3 RPN Key Functions  
An RPN function is a way to use a single key for two different functions. RPN functions 
can be assigned to the SELECT, PRINT, UNITS, F1, and ENTER keys. The available 
RPN functions are subject to the app that is running. Users must enter a number with the 
indicator’s numeric keys followed by pressing the correct RPN key to activate the RPN 
function. For more information about these RPN functions see the application sections 
below. These functions can be enabled or disabled under the supervisor menu under 
RPN. 

Av
ail

ab
le 

RP
N 

Fu
nc

tio
ns

 

 Application 
 General Accum Count Check 

Simp 
Check 

Mid 
Check 

Adv 
Check 
Grade 

Check 
by % 

Truck 
In/Out 

Batch
-ing 

P-
Hold 

Remote 
Display 

In-
Motion 

Tare X X X  X X X X X X  X X 
Base X X X X X X X X X X X X X 
ID X X X X X X X X X X X X X 
Print Format X X X X X X X X X X X X X 
I/O 4 X X X      X X X X X 
I/O 5 X X X      X X X X X 
I/O 6 X X X      X X X X X 
Accumulation 
Channel   X            

Preact 4          X    
Preact 5          X    
Preact 6          X    
Start          X    
Stop          X    
Truck ID         X     
Light Setting         X     
Under Segment 
Division    X  X  X      

Over Segment 
Division    X  X  X      

Under Division    X  X  X      
Over Division    X  X  X      
Target    X X X  X      
Target Low    X X X  X      
Tolerance Low    X X X  X      
Target High    X X X  X      
Tolerance High    X X X  X      
Piece Weight   X           
Sample Size   X           
PLU   X   X  X      

 
Note: Every ZM223 comes with a key label pack to place over a key or annunciator so it 
is correctly labeled. 
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2.4 Front Display 
The default backlight color for the General Weighing app is Green however the backlight 
color can be changed by the operator from the User Menu under the BackLt submenu 
(see page 110). 

The available Backlight colors are Green, Red, Yellow, and Orange.  

                  
Green          Red 

            
                           Yellow       Orange 

 
Backlight Off 

Depending on the app in use that is running backlight color may vary. For example, when 
using the Checkweighing app backlight colors can represent when a weight is within the 
low window, accept window, high window. 

In most apps, the backlight color is controlled by the app and can be changed from within 
the supervisor menu. 

Users can adjust the backlight brightness and contrast holding the F1 (brightness) or 
UNITS (contrast) key and use  and  to adjust the settings. The brightness and 
contrast are saved automatically and will be applied after a reboot. 
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2.5 Annunciators 
These annunciators will light during operation to inform the user of the weighing mode, 
active unit of measure, etc. The annunciators on the display are shown below 
 

 
 

 
 
 
 
  

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Number Annunciator Number Annunciator 
1 Motion 9 Ethernet Connection  
2 Center Zero 10 Total  
3 Under Over Accept Bar Graph 11 Preset Tare 
4 Units of Measure (lb,kg,& oz) 12 Tare 
5 Custom Unit of Measure    13 Net 
6 Weight Ranges 1 to 3 14 Gross 
7 2 Custom App Driven 15 Print 
8 Bluetooth 16 Scale Number 

 

2.6 Powering Up the ZM223 
The ZM223’s power setting can be configured two ways, Always On or Front Panel 
ENTER/POWER Key. 

Always On (default) 
Once the indicator is connected to a power supply it will automatically power up and 
remain on until the power source is removed. 

Front Panel ENTER/POWER Key 
With the indicator connected to a power source the indicator will only power up if the 
ENTER/POWER key is pressed. Once pressed, the indicator will turn on and display a 
Gross weight reading. To use this feature, contact your service provider. 

Turning Indicator Off 
If the indicator is configured to use the ENTER/POWER key to power down the indicator, 
press and hold the ENTER/POWER for 5 seconds. Once pressed, the display will show a 

2 1 

15 

3 4  

5 

6    7 8 9  10  

11  

12 14    13  16 
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count down from 5 to 0 before turning off. If the ENTER/POWER key is released before 
the 5 seconds are up, the indicator will revert to normal operation. 

Power Supply Used in the ZM223 
 Desktop AC power cord connected to a properly grounded outlet (100 VAC – 

240 VAC, 50 or 60 Hz) 
 

 External 24VDC battery pack connection. Recharging the battery pack must be 
done away from the indicator to avoid damage. 
 

 If fully powered from a DC power source, like a battery, there are extra power 
saving features to help prolong battery life found in the Supervisor Menus. An 
Auto shutoff feature can be activated to automatically turn off the indicator when 
there are long periods of inactivity (see page 201 for setup). 
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3 Basic Operations for General Weighing 
3.1 Zero 

Whenever there is no weight on the scale base, but the indicator displays any value other 
than 0, press the ZERO key to reset the indicator and scale base to 0.  

3.2 Gross Weighing 
To perform gross weighing, power up the indicator and follow these steps:  

1. Empty the scale and press ZERO to zero the scale …  
0 is now displayed and the center-of-zero GROSS annunciator lights up. 

2. Place the item to be weighed on the scale…  
The item’s weight is now displayed.  

3. Remove the item from the scale.  
4. Repeat steps 2 and 3 for each new item to be weighed.  

3.3 Tare 
Designed to remove or “tare-off” the weight of a container on this scale so only the 
goods/items inside the container are weighed. The weight of goods placed inside the 
container are displayed as a Net weight. Press the SELECT key to toggle the display 
between the Gross, Net, and Tare weighs.  

Net Weighing  
Net weighing allows users to see the weight of item/items without the weight of the 
container holding them factored in. Net Weighing is available via three types of tare entry 
push button tare, key in tare, and preset tare.  

1. With “Push button tare” enabled and the empty container on the scale, press TARE 
to tare the weight of the container off the scale.  

2. With “key in tare” enabled, key in a tare weight and press TARE to set.  
3. With “preset tare” enabled, press TARE to recall a preset tare numbered 1-10. 
 
Note: Pushbutton and Entered Tares can be enabled simultaneously. If Preset Tare is 
enabled, Pushbutton is automatically disabled. 
 
There is an “auto tare clear” feature. If this is enabled, after a weighment and the weight 
falls into the gross zero band, the tare is automatically cleared to show a Gross Zero 
weight. 

Using Pushbutton Tare  
To perform a net weighment using Pushbutton Tare, power up the indicator and follow 
these steps:  

1. If the display does not read 0 with nothing on the scale press ZERO …  

0 is now displayed and the center-of-zero annunciator lights.  

2. Place item to be tared-off on the scale (often a container) …  

Weight is now displayed.  

3. Press TARE …  

0 is now displayed and the Net annunciator lights up.  

4. Place material to be weighed into or on the tared item on the scale …  

Net weight of material is now displayed.  
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5. Repeatedly press SELECT to cycle the Gross, Tare, and Net values.  
6. If repeated weighments use the same tared item, do not establish a new tare 

value as described in step 2 and 3. 

Using Entered Tare  
To perform a Net weighment using Entered Tare, power up the indicator and follow these 
steps:  

1. If the display does not read 0 with nothing on the scale, press ZERO …  
0 is now displayed and the center-of-zero annunciator lights.  

2. Key in the tare weight value of the container used to hold the items being 
weighed and press TARE …  

Tare weight is now displayed as a negative value and the Net annunciator 
lights up.  

3. Place the container and materials on the scale…  
Net weight of the items is now displayed.  

4. For repeated weighments using the same tared item, do not establish a new tare 
value as described in step 2.  

5. To remove the tared weight from the scale, enter 0, then press TARE…  
The tare is cleared, and the scale will return to Gross weigh mode. 

 
OR 

 
Press and Hold the TARE key until Cleared is displayed…The display will 
switch back to Gross weight mode.  

Using Preset Tare 
The ZM223 can save up to 10 tares (numbered 1-10) in indicator. When using a Preset 
tare PT will be displayed on the indicator’s display. Preset Tares must be entered within 
the Supervisor Menu. It is best practice to ensure the scale is at Gross Zero prior to 
entering in a new preset tare. 

To perform a Net weighment using one of the preset tares, follow these steps:  

1. If the display does not read 0 with nothing on the scale, press ZERO …  
0 is now displayed and the center-of-zero annunciator lights.  

2. Press TARE …  
The Preset Tare number entry screen is now displayed.  

3. Key in the preset tare number (1-10) and press  …  
The saved Tare Weight is now displayed as a negative value and the Net 
annunciator lights up.  

4. Place the container and material to be weighed on the scale …  
Net weight of the items is now displayed.  

5. Repeat step 4 until finished using that preset tare weight. 
 

Note: If the active unit of measure is lb-oz then tare weight must be entered in the oz 
equivalent. To enter 2 lb 4.5 oz enter 36.5 oz (2 lb = 32 oz plus the 4.5). 
 
Clearing a Tare  
 Press and hold the TARE key. The scale display will be clear and the Gross annunciator 
will illuminate, and the Tare Annunciator will turn off. 

Tare Weight Parameters 
Subject to the ZM223’s site location and if any metrology requirements are turned on, a 
Tare Boundary can be enforced, resulting in limitations to taring weights outside the set 
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region weight boundaries. In this case, the indicator display will display “Cant” before 
reverting to the pervious displayed reading.   
 

3.4 SELECT Key Function  
Pressing the SELECT key allows users to cycle through and view the values. If an 
accumulation function is turned on and the scale is within the Gross Zero weight band, 
pressing the SELECT key also shows the Gross Total, Net Total, Tare Totals, 
Transaction Totals, and Count Total values. 

 When the Gross Total is displayed, both the GROSS and TOTAL annunciators 
will be lit.  

 When the Net Total is displayed, both the Net and Total annunciators will be lit.  
 When the Transaction Count is displayed, the custom annunciator will be lit. Add 

the provided Transaction Count sticker to the display.  
Additionally, when in normal operation the user can hold down the SELECT key to enter 
a quick edit mode for the Output Targets for Outputs 4 - 6 values. This only applies to 
the ZM223 Indicator Apps that allow for output configuration.  

In apps that use PLU database (Counting, Check Advanced and Check PER), a long key 
press on the SELECT Key now gets you into PLU selection. From here, you can see or 
change what the active PLU is (see page 21). 

3.5 Operator ID Entry 
An Operator ID can be entered for use with transmitted or printed transactions.  

This function is available in most ZM223 apps via the RPN function. When enabled, an ID 
can be entered by using the numerical keys followed by the assigned RPN key.   

If the RPN ID function is activated, key in the required ID number up to 7-digit ID and 
then press the selected RPN ID key.  

This ID number will now be stored within the indicator. The ID number will remain within 
indicator until the indicator is turned off or until a new ID number is entered.  

In the General App, the operator ID is automatically assigned to the F1 key.  

1. To view the Operator ID press the F1 key… 
the current ID will be flashed on the screen.  

2. To change the Operator ID, key in the new the Operator ID number and press  
to accept. The indicator will now return to normal operation. 

Reviewing the ID number, in all apps other than General can only be done using the 
Remote Assist Mobile App or the Web Browser Pages.   

3.6 Printing  
To print the current weight information, press the PRINT key. The configured print format 
will be outputted through the configured port to the connected peripheral device. For 
more on Default Print Formats refer to the complete list on page 210. 

Subjected to the configuration of the scale, some applications will only allow one print to 
be performed once the weight is stable. To perform the next print the scale needs to 
return to within the Gross Zero Band and weight reapplied to perform another print. 

In applications that use the Accumulation function, the PRINT key adds the Gross Net 
and Tare values to the stored accumulated Totals.   

If Print Total and Clear Total are enabled, a long key press on the PRINT key also prints 
out the running totals and then clears them, getting the indicator ready for the next 
product to be weighed. 
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Printing any of the configured print formats is possible using the RPN Print Format 
feature. Enter the Print Format Number, and then press the PRINT key. The selected 
print format will be transmitted out all ports that are configured to print. 

 
Note: Users can quick select a Print Format by using the keypad. For example, key in 1 9 
and press the PRINT key to print a ticket using Print Format 19, 3 5 to get Print Format 
35, etc.  
 
The ZM223 comes standard with a library of over one hundred predefined labels and 
ticket formats suitable for most applications, however, any of these print formats can be 
customized by your service provider to better meet your application requirements. 
Contact your service provider to customize your label formats.  

Alongside the standard print formats, the ZM223 also has around 20 UDF (User definable 
fields) that can be used and edited by the operator to add regularly changeable data to a 
print label format. Examples of this data include: customers name, address, part number, 
description, batch number or other. 

UDFs hold printable data that can be modified and amended from the Remote Assist 
Mobile App or the ZM223 Web Browser pages for use on print tickets or labels to add in 
customer required data that may change per label batch. 

3.7 Available Communication Ports 
To allow the ZM223 to connect to a wide range of peripheral devices like printers, remote 
displays, remote bases, scanners, PLCs, PC, cloud servers, USB keyboards, phones, 
and tablets the indicator comes standard with the following connection ports. 

 2 x RS232  
 1 x USB host  
 1 x Bluetooth  
 1 x Ethernet port (with 10 independent connections) 

− Enet / IP 
− Modbus TCP 
− FTP 
− HTTPS 
− MQTT 

3.8 Entering Alphanumeric Characters 
The ZM223 uses a fourteen segment 7-digit LCD display for displaying navigational 
menus, however due to the limited keypad it is not ideal for entering in alphanumeric text.  

Entering UDF text fields data is primally done by using the Remote Assist Mobile App or 
the ZM223 web browser pages. See page 95 for more information. 

The only alphanumeric text that can be entered in though the indicator’s front panel is for 
the Site ID submenu found inside the User Menu. 

When a text entry screen is present scroll through alphanumeric characters and symbols 
by pressing the  or  keys and move the cursor position by using the  or  
keys. Once you have the desired character move the cursor to the next position or press 

 to accept the input.  
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3.9 Entering a Negative Number or a Decimal Point 
To enter a negative number, press the C key to clear the current value from the display. 
With only one digit displayed press . The first character will be the (-) negative sign. 

Key in the rest of the digits normally and press  to accept the input. 

3.10 Base Switching Mode 
One ZM223 indicator can run two scale bases (one analog scale base and one digital 
BSQ scale base or two digital BSQ bases). The active base number is always shown in 
the bottom left had side of the display.  

When a second scale base is configured to the ZM223 users can switch between base 1 
and base 2 by using a RPN function. In the General app, the Base switching RPN 
function is set by default to the SELECT Key.   

To switch bases, follow the below steps:  

1. Press the 2 key and then the RPN activation key (SELECT)… 
The display’s Scale Annunciator will change from 1 to 2 and the live weight 
will now be coming from Scale 2.  

2. To switch back to Scale 1, press the 1 key and then the RPN activation key 
(SELECT)  

The display’s Scale Annunciator will change from 2 to 1 and the live weight 
will now be coming from scale 1.   

    
Scale 1 Annunciator      Scale 2 Annunciator 

 

 
Note: Contact your service provider to connect a ZM223 to a 2nd BSQ base. 
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3.11 Selecting a Unit of Measure 
The UNITS key switches between the primary units of measure the connected scale base 
is calibrated for (common units are lb,kg, g,oz, lb-oz, custom). The ZM223 can have up to 
four units of measure turned on within the scale. The Default Unites of Measure is lb and 
kg. 

The active unit of measure is illuminated in the top right corner of the display (shown 
below as callout 1). In the case that the unit of measure is set to Custom, the bottom right 
most annunciator will be illuminated (shown below as callout 2).  

 

 

3.12  Using PLUs  
PLU databases are available with some applications like Counting, Checkweigh 
Advanced and Percentage checkweighing. When configured internally, up to 2000 PLUs 
can be stored on the indicator’s micro-SD card.  

PLUs are used to quickly recall pre-stored tares and piece weights, along with other 
useful parameters using a PLU Slot from (1-2000).  

 Piece Weight  
 Target 
 Under Tolerances  
 Over Tolerances  

PLU 0 is a free PLU that cannot be saved over PLU1 to 2000 hold data that can be 
stored and recalled even after the indicator has been turned off.  

Due to the indicator display limitations, neither the Part number nor Description UDF 
fields can be seen, entered or edited from the ZM223 front panel. These fields can only 
be seen when using the ZM Remote Assist mobile app or web browser page. 

3.13 Recalling Saved PLUs 
Recalling a PLU can be done in four ways: 

 Press and Hold the SELECT key  
 Using RPN key function if PLU is activated. 
 Using the Remote Assist Mobile App.  
 Using the Avery Weigh-Tronix web browser page.  
1. When in an app that use PLUs, press and hold the SELECT key to access the 

PLU entry screen. 

2. Key in the required PLU number and press enter … 
The display flashes PLU and then displays the active PLU number as 
xxx 

3. Display now loads the required weight parameters for that PLU and waits for 
weight to load on the scale. If in the Counting mode, the display switches to 
counts, awaiting parts to be added, if in Checkweighing mode, the scale loads 
the High and Low weight bands, awaiting weight to be loaded on the scale.  

1 

2 
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3.14 Viewing PLU Data  
The following PLU fields can be viewed from the Supervisor Menu or viewed and 
modified directly from the Remote Assist app or Web Browser page if these fields are 
activated.  

 Piece Weight  
 Target 
 Under Tolerances  
 Over Tolerances  

3.15 UDF Fields Not Linked to the PLU Database 
The following text UDF fields that can be called up from the indicator for use on print 
tickets or labels.   

 ID 
 Part Number  
 Description 
 Lot location    
 Name   
 Address 
 10 Free UDF text fields  

These extra UDF fields are designed to allow the operator to easily add text to a known 
print label or ticket. These fields are not Linked to a PLU number and can be turned on or 
off from within the Supervisor Menu under the Mobile Field. 

The UDF fields can only be entered or edited using the Remote Assist app or the Web 
Browser page. Enabling these fields so they are visible in the Mobile app or web browser 
page is done in the Supervisor Menu under Mobile (page 208).  

Due to the basic display functions within this ZM223 indicator, only the Weight data fields 
can be entered and viewed from the supervisor menu. Any of the text UDF fields can only 
be viewed or changed using the ZM mobile app or the web browser page.  

3.16 Remote Assist Mobile Application 
There is a free Avery Weigh-Tronix Remote Assist mobile application that pairs with any 
ZM223 via Bluetooth. Remote Assist provides users with additional features to make the 
indicator more flexible.  

Using the Remote Assist app uses can: remotely view live weights, remote use of primary 
Indicator keys, view and change a wide range of app defined weight data fields, change 
UDF printable text fields that can be used on a print ticket or label, retrieve stored data 
from the ZM223 flash drive memory, store weight data to the mobile device, and use 
operator prompts to aid in using the ZM223.  

Subject to the app running on the ZM223, special fields can be viewed and used in the 
Remote Assist mobile app. However, it is recommended to keep these active fields to 
around 6 to reduce the risk of slowing down the Remote Assist mobile app.  
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3.17 Remote Assist Homepage Breakdown  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
For additional details regarding the Remote Assist mobile app, see page 95. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

User Prompt - (App Driven) 

UDF (User Defined Fields) + Custom App Buttons – (App Driven) 
• Driven using LUA Variables 
• Define which values you want displayed and their order. 
• Variable description, value, and read/write status is show. 
• Define custom buttons and colors. 

Scale Device Info: Capacity, Serial Number, Etc. – (Firmware Driven) 

Active Value, Weight, and Units – (Firmware Driven) 

Device Keys/Remote Keys – (Firmware Driven) 

Device Settings, Name, Model, Connection Type  – (Firmware Driven) 

Menu button, Scale data, Refresh button, and Bluetooth icon.  
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3.18   ZM223 Web Browser Page 
This web-based application allows operators the ability to run the indicator remotely from 
any PC or tablet that is connected to the same network that the ZM223 through any 
search browser. Using the web browser app also provides the user with additional 
features that cannot be done directly from the ZM223 indicator. 

Through the web browser app users can: remotely view live weights, use all Indicator 
keys, view and change a wide range of app defined weight data fields, change UDF 
printable text fields that can be used on a print ticket or label, retrieve stored data from 
the ZM223 flash drive memory, store weight data to the mobile device, and use operator 
prompts to aid in using the ZM223. 

 To navigate between the available webpage screens (Scale, Super, and About), 
click on the corresponding screen button in the upper right-hand corner of the 
screen shown below. 

 Within the web browser page users can view the active PLU allowing the 
operator the ability to view, edit, and adjust UDF fields. Please note that the UDF 
fields varies depending on the Indicator Application the ZM223 is currently 
running. 

 To use any of the ZM223 Indicator’s keys, click on the desired key on the 
simulated indicator display shown below.  

 To edit any of the ZM223 Information Fields click on the “Edit” button to the right 
of the field that needs to be edited.  

 
Note: IP address used in the web browser must match the inductors IP address. For 
example: 192.168.1.23 
 

 

For additional details regarding the ZM223 web browser, see pages 100. 

Usable Indicator Keys 

Available Webpage Screens 

Indicator’s Info Fields 

Subject to the 
Site Location and 
the location’s 
requirements for 
approval a Not 
Legal For Trade 
Message will 
display.  
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4 ZM223 Indicator Applications   
The ZM223 Indicator comes with 14 weighing applications that can be accessed from the 
provided SD card inside of the indicator. To access the Apps on the supplied SD card the 
app must be installed by the service provider when then indicator is initially installed. All 
ZM223’s come with the General Weighing application active.  

All applications are enabled through a password protected menu. Only one application 
can be enabled at a time.  

ZM Mobile Connection: All current ZM223 applications listed below can also be used in 
conjunction with the Remote Assist App (see page 95).  
 
ZM223 Web Browser Control: The ZM223 Web browser page can also be used if the 
indicator is connected to the same network as the PC viewing the web browser (see page 
100).  
 
Both the ZMobile app and Web browser page enhance the ZM223 functionality by 
allowing the operator quick access to view and change vital key printing data fields held 
within the ZM223 indicator.  

The Available Indicator applications are:  
 General Weighing (explained on page 26)  
 General Weighing with Accumulator (explained on page 28) 
 Truck In and Out (explained on page 32)  
 Counting (explained on page 38) 
 Checkweighing Simple (explained on page 48) 
 Checkweighing Mid (explained on page 50)  
 Checkweighing Advanced (explained on page 57) 
 Checkweighing by Percentage (explained on page 66) 
 Batching (explained on page 73)  
 Peak Hold (explained on page 79) 
 Remote Display (explained on page 82)  
 In-Motion Weighing (explained on page 84)  
 Grading (explained on page 87) 
 AutoLoc (explained on page 92) 

 

Note: All instructions concerning application setpoints are covered in the Supervisor 
Menu section starting on page 129. 
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4.1 General Weighing Application  
This section covers the ZM223’s General Weighing application. All ZM223’s come with 
the General Weighing application active. The General Weighing functions that are used 
across all apps can be found in Section 3 of this manual. Application functions that are 
specific to this application are explained below.  

This General Weighing application can be used in a wide range of general use 
applications such as simple bench weighing, floor weighing, PLC, and simple filling 
applications. 

Key Push Duration Function 
 

  
   

Press Tares off box/container weight.  

 

 
   

Press and Hold Clears Tare value 

 

 
   

Press Toggles between Gross, Tare, Net, other 

 

 
 

Press and Hold Access I/O 4-6 setpoints 

 

 
  

Press Zeros Scale 

 

 
  

Press Sends a stable weight transaction to a printer or PC  
 

 

 
  

Press Toggles between active units of Measure lb, kg, g, oz 
 

 

  
 

Press and Hold Enter Password Menu Area 

 

 
 

Press Shows ID number 
 

 

 
  

Press Accepts entered values 
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4.1.1 Special Key Functions  
F1: In the General Weighing Application, the F1 key is tied to the ID function by default. 
This allows users to enter, view, and edit ID numbers.  

1. Press F1 so current Operator ID is shown  
2. Key in new ID number and press  

SELECT: in General weighing application if linked to any outputs to drive relays, valve 
gates, stack lights or alarms, pressing and holding the SELECT key gains quick access 
to the 3 output target values for I/O4, I/O5 & I/O6. 

1. Press and hold the SELECT Key for 3 seconds… 
SETPNT is briefly displayed, followed by I/O4.  

2. Use  or  to move to the output that needs to be edited.  
3. Press  to view target value for that set point. 

A numeric entry screen is now displayed. 
4. Key in new target value and press the  to accept or press F1 to abort and 

move back to I/O x menu. 

Note: All instructions concerning an application’s Setpoints are covered in the Supervisor 
Menu Section on page 129. 
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4.2 Accumulator Application  
This section covers the ZM223’s Accumulator application. This Accumulation app allows 
users to track and monitor up to 200 different running totals at the same time. This app 
will record the accumulated Gross, Net and transaction totals for each Accumulation 
Chanel.   

With the correct Accumulation Channel active the indicator will accumulate each Gross 
and Net weight after the user presses the PRINT key to the running total for that 
Accumulator channel. 

Running totals per accumulator channels can be seen live using the Remote Assist 
Mobile App or the ZM223 web browser page. 

4.2.1 Indicator Key Functions 
Key Push Duration Function 

 

  
   

Press Picks the Accumulator channel to store 
weight in to from 1 to 200. 

 

 
   

Press Tares off box/container weight.  

 

 
   

Press and Hold Clears Tare value 

 

 
   

Press (When 
the scale is at 
Zero) 

View Gross, Net, Tare, or Transaction Totals. 

 

 
  

Press Adds weight to the accumulator total. 

 

 
 

Press  Sends a stable weight transaction to a printer 
or PC.  
 

 

Press and Hold Prints Accumulation Totals and clears 
Accumulation Channels   
 

 

 
  

Press Toggles between active units of Measure lb, 
kg, g, oz 
 

 
 
  

Press Enter Channel Numbers 
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Press Use numeric keys to enter Channel Numbers 

The following function can be set up as an RPN secondarily key function:  
 Base Switching (Default SELECT) 
 Print Format (Default PRINT) 
 Output 4, Output 5, and Output 6 (Default Press and Hold SELECT key) 
 ID (Default F1) 

4.2.2 Special Key Functions  
The F1 key controls which Accumulation Channel is accumulating. To make this easier 
for users to remember, the included Chan x key label can be placed over the F1 key or 
positioned close to it to help the operator know what the F1 key function is.  

To change Accumulator Channels, follow the below steps: 

1. Press F1… 
The active accumulator channel (chAn X) will be briefly displayed.  

2. Key in the new channel number and press  
3. The indicator will now return to normal function under the selected Accumulation 

Channel and will accumulate the Gross, Net, and Tare weights each time the 
PRINT key is pressed. 

Pressing the SELECT key allows users to cycle through and view the Gross, Net, Tare, 
Gross Total, Net Total, and Transaction Count display values. This only applies when the 
scale is within the gross zero band.  

 When the Gross Total is displayed, both the GROSS and TOTAL annunciators 
will be lit.  

 When the Net Total is displayed, both the Net and Total annunciators will be lit.  
 When the Transaction Count is displayed, the custom annunciator will be lit. Add 

the provided Transaction Count sticker to the display.  

If an output is used with this application, hold down the SELECT key to enter a quick 
edit mode for the I/O 4 - 6 values. This only applies to the ZM223 Indicator Apps that 
allow for I/O configuration. 

4.2.3 Accumulator Operation  
The Accumulator Application can be used to record totals of individual weighments.  

1. Prior to accumulating any totals, select an accumulator channel to accumulate 
weights into by pressing F1, entering the relevant accumulator channel number, 
and pressing . 

 OR 

If staring from the beginning, press and hold the PRINT key to clear any existing 
accumulator totals…  

Print Tot and then Cleared is displayed.  

To setup the Accumulator App, follow the below steps: 

2. If necessary, press ZERO to zero the scale …  
0 is now displayed.  
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3. Place item on the scale …  

The item’s weight is now displayed. 

4. Press PRINT to add more weight to the Accumulated Channel Total (each time 
the PRINT key is pressed that weight gets added to the Gross Totals, the Net 
Totals, the Tare Totals, and Transaction Totals) …  

The ACC annunciator will light up briefly.  

5. Remove weight from the scale. Weight must return to inside the gross zero band 
before another accumulation and print can be recorded.  

6. Repeat steps 2 through 4 for each weighment that needs to accumulate.  
 

Note: If enabled, press and hold the PRINT key for three seconds to print total (Prnt Tot) 
and/or clear (Clr Tot) will briefly appear on the screen before completing the toggled 
function.  

 
Note: If Clear Total is deactivated in the Supervisor Menu, pressing and holding the 
PRINT key will just print the Accumulated Totals and not clear them. To clear the 
Accumulated Totals must be done in the Supervisor Menu under Clear Channel (Clr CH). 

 

Note: If a tare is required place the empty box on the scale and press TARE key, fill the 
box or container with the parts to be accumulated and press the PRINT key. Gross, Net, 
and Tare weights will now be accumulated. 

4.2.4 Remote Assist Accumulator Control  
Viewing and controlling the Accumulator Channels 
from the ZM223 Remote Assist mobile app is ideal 
for processes that need to be observed or controlled 
from a distance and for adding customer data to a 
ticket before printing.  

All Printable text fields can be formatted to print out 
on a weight tickets or weight label. This can be 
setup by your scale service provider. 

The operator or supervisor can control which 
accumulator channel the indicator is working in.  

The Remote Assist Mobile App gives users more 
access to data. Some data cannot be shown on a 
single line indicator display without toggling 
between screens. Using the ZM223’s companion 
mobile app provides all the Gross, Net, Tare, 
Transaction Totals along with the number of 
transactions all on one screen. Additionally, it allows 
users to clear all Accumulator Channel data once. 

Below is a list of the accumulator functions that can 
be viewed or controlled via the Remote Assist app.  

 View Live weight  
 Remote Select key control function to show Gross, Net, Tare, and Transaction 

Totals  
 Remote Accumulate Print function 
 Remote Clear Channel data button 
 Remote tare function 

Remote Assist Accum Home Page  
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 Remote Zero function 
 Remote unit of measure  
 Remote Accumulator channel selection 
 Adjustable UDF printable text function  

− Part number  
− Description  
− Loc 
− Name 
− Address 
− 5-10 Free UDF fields 

All functions listed above are also available on the ZM223 Web Browser Pages when the 
indicator is running the Accumulation App.  

 
 
 
 
Note: The viewable fields in the Remote Assist Mobile App and on the Web Browser 
Page can be controlled from within the indicator under the Mobile submenu in the 
Supervisor Menu. 

 

Note: All instructions concerning an application’s Setpoints are covered in the Supervisor 
Menu Section on page 126. 

 
 

 

Accum Web Browser Home Page  
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4.3 Basic Truck In & Out Application 
This section covers the operation of the ZM223 
Truck In and Out App. The ZM223’s Truck In and 
Out app is designed to streamline the collecting of 
net weights from inbound and outbound trucks. 
This app tracks all the inbound weights and 
outbound weights to determine the net transaction 
weight of all trucks that enter or leave the site. 
Fleet IDs can be stored inside the indicator with 
known truck tare weight to speed up the 
inbound/outbound process.  

 
 

Note: Operators can view the gross, net, and tare 
display values by repeatedly pressing the SELECT 
key. 

 
 
 
 
 
 

 
 
 
 
 

 

Remote Assist Truck I/O Home Page  

Truck I/O Web Browser Home Page  
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4.3.1 Indicator Key Functions  
Key Push Duration Function 

 

    
 

Press Tares off empty truck weight. Tares are used in some 
manual filling applications while the truck is on the 
scale. 

 

   
 

Press and Hold Clears Tare value 

 

  
  

Press Toggle between Gross, Net, and Tare weights. 
 

 

 
 

Press and Hold Access I/O 4, 5, and 6 values. 

 

 
  

Press Zeros Scale 

 

  

Press Sends a stable weight transaction to a printer or PC. 
Used for inbound and outbound applications to save 
weight values while printing the required inbound and 
outbound weight ticket.   
 

 

  

Press Toggles between active units of Measure lb, kg, g, oz 
 

 

 
 

Press Fleet key 

 

 
 

Press and Hold Used to get into the Supervisor menu 

 

 
  

Press Accepts entered values – turns on scale when off  
 

C Key Press Exit Truck IO Transaction 
After entering the Truck ID, if the transaction is no 
longer required, press the “C” key and cLr trk is 
displayed to exit from the Truck IO mode.   
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The following function can be set up as an RPN secondarily key function:  
 Print Formats (Default PRINT)  
 I/O 4  
 I/O 5  
 I/O 6  
 ID (Default UNITS) 

4.3.2 Special Key Functions 
The following keys have an extra function in this application: Within the Truck In and Out 
app the F1 key functions as Truck ID key for inbound and outbound. Dedicated key labels 
can be attached to the overlay to help the operator know what the F1 key functions is 
now controlling. Operators can use the SELECT key to toggle between Gross, Net, and 
Tare weights. 

Press F1 key: to start the Inbound or Outbound process 

Press PRINT key: to print the inbound and outbound weight ticket   

Press and Hold the PRINT key: to reprint the last Print ticket 

4.3.3 Truck In & Out Operations 
The Truck Inbound/Outbound application tracks the movements of trucks when they 
enter and leave a sight. This normally involves two weighments to determine the Net 
Weight Transaction for a truck: an Inbound Weight and an Outbound Weight.     

If a truck has a known Tare Weight that is stored in the indicator as a Feet ID, it only 
requires one weighment to determine the Net Weight Transaction.  

Inbound transaction (1st weighment) 

Inbound process 
1.  With no weight on the scale, the truck drives onto the bridge and stops.   

If the weight is over the set weight threshold of 1000 lb the backlight will turn 
 red. 

2. Press the F1 key to start the Inbound process…  
Inbound comes up on the indicator display followed by the most recently entered 
Truck ID (For Example: 122). If ID Auto Generation is enabled, the Inbound 
Truck ID will be the next unused Truck ID (So 123 for this example).  

3. To accept this Inbound Truck ID, press the …  
The Inbound Annunciator will turn on. 

4. If this is not the Truck Inbound ID that needs to be used, key in an alternative Truck 
ID up to 7 digits and press … 

5. Press the PRINT key to finish the Inbound Transaction. An Inbound Weight Ticket will 
print, the Inbound Annunciator will turn off, and the backlight will change back to 
Green to allow the truck to drive off. 

OR 
If Auto Print function is enabled (Default On), once the Truck Inbound ID is accepted 
and the weight is stable, the Inbound Weight Ticket will print automatically, and the 
backlight will turn green to allow the Truck to pull off the scale. 
See an example of an Inbound Weight Ticket below.   
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Outbound Process 
6. With no weight on the scale, the truck drives onto the bridge and stops.   

If the weight is over the set weight threshold of 1000 lb the backlight will turn  
 red. 

7. Press the F1 key to start the Outbound process…  
Inbound comes up on the indicator display followed by the most recently entered 
Truck ID (For Example: 214). If ID Auto Generation is enabled, the Inbound 
Truck ID will be the next unused Truck ID (So 215 for this example). 

8. Key in the truck’s Inbound Truck ID (123 for this example) and press ...  
If this Truck ID is found in the database, the Outbound Annunciator will turn on 
while the indicator calculates the truck’s Net Weight from its Inbound and 
Outbound weights.  

9. Press the PRINT key to finish the Outbound Transaction.  
OR 

If Auto Print is enabled (Default On), once the Truck ID is accepted and the weight is 
stable, the Outbound Weight Ticket will print automatically, and the backlight will turn 
green to allow the Truck to pull off the scale. 

 
Reprint 
1. To reprint the last ticket, press and hold the PRINT key until Reprint is displayed. 

2. Press ... 

 
4.3.4 Truck In & Out Fleet Operations 

Fleet weighments are used when a Truck has a known Truck Tare Weight stored in the 
indicator under a Fleet Truck ID. Fleet Trucks only need the saved Truck Weight to 
determine the NET weight transaction.  

Use the F1/FLEET key for transactions involving Fleet Trucks that already have a stored 
tare weight. 

Until a Truck ID is entered the PRINT key can be used for General Weighing transactions 
using the configured protocols. Once a Truck ID is entered the PRINT key will be 
associated with an Inbound or Outbound Ticket transaction. 
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Fleet Weighment process 
1. With no weight on the scale, the Fleet Truck drives onto the bridge and stops.   

If the weight is over the set weight threshold of 1000 lb the backlight will turn  
 red. 

2. Press F1/FLEET to start the Fleet Process. 
Inbound comes up on the indicator display followed by the most recently entered 
Truck ID (For Example: 122).   

3. Key in the stored Fleet ID and press ... 
If the Fleet ID is found in the database, the display will flash Fleet  

4. Press the PRINT key to complete the Fleet Transaction. 
A Fleet Ticket will print, and the backlight will turn green to allow the Fleet Truck 
to drive off the scale. 

4.3.5 USB Keyboard Key Assignments 
F1 – Truck ID 

F3 – UNITS key  

F4 – Reprint / Reports 

F5 – SELECT key  

Alt-B – Green Light (START) 

Alt-Q – Red Lite (STOP) 
 
Note: A full USB keyboard allows Alphanumeric characters to be used in the Truck IDs 

 

4.3.6 Truck In Out Setpoints 
For the Truck I/O application, I/O4 controls the green light and I/O5 controls the red light 
and any edits to these setpoints will be overwritten by the application. I/O 6 can be 
configured to control a peripheral device like a printer or an alarm.  

4.3.7 Printing 
If a Truck Inbound/Outbound or Fleet transaction is in process, when PRINT is pressed 
the associated ticket print format will be transmitted through the configured port. 

If a Truck transaction is not in process, then when you press the PRINT key, the 
configured print format will be output through the configured port to the connected 
peripheral device. The indicator can be configured to only allow one print for each 
weighing sequence. If PRINT is pressed when so configured, cAnt is displayed instead 
of printing again. 

 
Note: Technicians can quick select a Print Format by using the keypad. For example, key 
in 1 9 and press the PRINT key to print a ticket using Print Format 19, 3 5 to get Print 
Format 35, etc.  

 
Printing any of the configured print formats is possible using the Numbered Print feature. 
Enter the print format number and then press the PRINT key. The selected print format 
will be transmitted out all ports that are configured to print. This feature is disabled during 
a Truck In/Out transaction sequence. 
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To clear an Inbound or Outbound transaction before printing: 

1. Press F1 and key in the correct truck ID. This will override the current ID shown in 
the scale.    

2. When the Inbound or Outbound annunciator is lit, press the C key to clear it.  
Clr TrK will flash before returning to normal gross weight mode 

Printing Reports 
The ZM223 can recall and print data of the following 
 All Inbound Truck still onsite 
 All Outbound Truck Transactions 
 All Fleet Transactions   

1. To print any of these reports, press and hold the PRINT key until REPRINT is 
displayed. 

2. Use  or  to toggle between the options (Reprint, Out Reprint, or Fleet 
Reprint) 

3. Press  to make a selection. 
4. To clear these reports, see page 144 for details.  

         Inbound Reprint        Outbound Reprint 

                                                   
Fleet Reprint 

 
Note: All instructions concerning an application’s Setpoints are covered in the Supervisor 
Menu Section on page 129. 
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4.4 Counting Application 
This section covers the ZM223’s Counting application. The application has both Basic 
Counting and Checkcounting functions.  

Basic Counting allows users to sample a set number of the same parts to quickly 
establish an accurate piece weight that can then be used to count a larger quantity of 
parts. 

Checkcounting is a combination of counting and checkweighing. Where checkweighing 
works off a weight tolerance, checkcounting works on parts being counted. This feature is 
perfect for applications where parts are boxed, bagged, or sold by a set quantity   

In checkcounting the accept window is based off the number of parts that are on the 
scale. The under and over limits are set in the supervisor menu and stored under the 
PLU number and control the number of counted parts that need to be counted for the 
accept window lights up. If the target box quantity is 100 parts and the under limit and 
over limit are set the same as 100. This means only the exact quantity of 100 parts will 
show in the accept window, 99 will show as under and 101 will show as over. 

The ZM223 multi-color backlight clearly identifies when a container is filled with the 
correct number of parts. See the default color combination for the Checkcounting app 
below.  

         
                      UNDER Target                                AT Target                                     OVER Target 

The Accept Window is set using an Under/Over limits 
per part type.  

For example, if the target box quantity is 100 parts 
and the lower limit is set to 99 and the high limit is set 
to 101 parts. When the count is under 99 parts the 
backlight will be orange, when the number of parts in 
the container is between 99 and 101 parts the 
indicator’s Display will turn from orange to green 
(ACCEPT), and if the count goes over 101 parts the 
backlight will be red.  

 
Note: The current Under, Over, and Accept backlight 
colors can be changed under the Supervisor menu 
under Backlight   

 
The generic weighing functions are found in Section 3 
and used in most of the ZM223 applications. Only 
counting features are highlighted in Section 4.4 of this 
manual. 

Remote Assist Counting Home Page 
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4.4.1 Basic Counting Principles  
Accuracy with this system can be extremely high, even with small parts, if the environment 
is controlled, parts have a consistent weight, and a large enough sample size is used. 
There are several things which affect counting accuracy 

 Environmental noise (vibration, wind, etc.)  
 Number of sample parts used 
 The weight consistency of the sample parts  
 The weight of one part. 
 Accuracy requirement.  
 The scale itself (BSQ Digital will supply a more accurate sample compared to 

an analog scale base) 
Changes in anyone of these variables can affect the accuracy of the counting application. 
If there is wind or vibration, accuracy will drop, especially if parts are small in weight. If 
parts are not a consistent weight, accuracy can be poorer but may be increased by using 
a large sample size. 

4.4.2 Using Counting Function 
The ZM223 Counting Application can be used in the following ways: 

 Sample a number of parts to establish a new piece weight, use this new 
piece weight to count a larger quantity of parts accurately. 

 Sample parts using the Bulk or Dribble methods.  
 Enter a known piece weight using the Piece Weight RPN function. 
 Recall a known piece weight from the ZM223 PLU memory. 

 
 
 
 
 

Web Browser Counting Home Page 
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4.4.3 Indicator Key Functions 
Key Push Duration Function 

 

 
 

Press Tares off box/container weight.  

 

 
 

Press and Hold Clears Tare value 

 

 
  

Press Toggles between Gross, Tare, Net, Piece 
Weight, and Counts. 
 

 

 
 

Press and Hold Select or view the active PLU number 

 

 
 

Press after 
entering RPN 
scale number 

Default RPN activation key (can be changed 
in the Supervisor Menu) 
If a second scale base is connected this 
allows you to change from base 1 to base 2 

 

 
  

Press Zeros Scale 

 

 
  

Press Sends a stable weight transaction to a Printer 
or PC  
 

 

 
 

Press and Hold Print and clear Totals when Print Total is 
activated in the Supervisor Menu 
 

 

 
  

Press Toggles between active units of Measure lb- 
kg- g -oz 
 

 

 
 

Press after 
entering a new 
Piece Weight 
Value 

Enter a new Piece Weight 
 

 

 
 

Press Sampling 
 

 

 
 

Press after 
entering a new 
sample size 
number 

Save a new sample 
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Press Accepts entered values – turns on scale when 
off  
 

 

 
 
 

Press once the 
desired number 
of parts are on 
the scale to finish 
sampling 

Changes the sample size quantity 
 

 
The following function can be set up as an RPN secondarily key function: 
 Base Switching (default SELECT) 
 PLU Selection  
 Piece Weight (default UNITS) 
 Print Format (default PRINT) 
 Sample Size (default F1) 
 ID 
 Output 4 to 6 
 Low Limit  
 High Limit 

 
Note: Turning any of these secondary key functions can be done under the supervisor 
menu under RPN (page Error! Bookmark not defined.). 

 

4.4.4 Special Key Functions  
Sampling: 
The F1 key starts the sampling process to establish a new Piece Weight. 

1. Press F1 key the scale automatically Zeros and display's the Sample quantity to 
load on the scale.  

2. Load the required sample quantity of the same parts on the scale and press  
…  

The new Piece Weight will now be used to accurately count a larger 
quantity of the same part 

       
If an active PLU from 1 to 2000 is active once the sampling process has finished, it will 
ask to Save the new Piece Weight over the current PLU number.  

3. To not save over the current PLU, with No displayed press  …  
The new piece weight will remain active but the PLU with automatically 
change to PLU 0 and remain unsaved. 

4. To save over the current PLU use  to toggle to YES and press  …  
The new Piece Weight is now saved over the old Piece Weight for the 
selected PLU.   

Note: The PLU Updated message will only be seen if the PLU Database is enabled in the 
Supervisor Menu. 

 
 
 
 
 



 

Page 42 of 224 
 

Pressing the SELECT key allows users to cycle through and view the Gross, Net, Tare, 
Count, Piece Weight. Count Total, Gross Total, Net Total, and Transaction Count can 
only be seen when the scale is within the gross zero band and Print Totals are turned on 
in the supervisor menu  
 When the Count Total is displayed, both the Count and TOTAL annunciators will 

be lit.  
 When the Gross Total is displayed, both the GROSS and TOTAL annunciators 

will be lit.  
 When the Net Total is displayed, both the Net and Total annunciators will be lit.  

If a stored PLU is active, hold down the SELECT key to until PLU is flashed on the 
display then the active PLU is shown. To change this PLU key in a new PLU, key in the 
new number and press . The active piece weight and check tolerances for that PLU 
will now be loaded.  
 
Saving sample data to a new PLU number: 

1. Press and hold the SELECT key… 
The active PLU is now displayed 

2. Key in the PLU you wish to overwrite, and press … 
3. Perform the Sampling process explained below and when prompted to update 

the PLU use  to toggle to YES and press  …  
 
Note: This PLU function will only be available if the PLU database has been enabled in 
the Supervisor Menu (see page 21). 

 
Base Switching:  
If activated, use the indicator’s numeric keys to enter in the base number (1, 2,) and 
then press the RPN activation key (SELECT by default).  
 
Automatic Base Switching  
Within this app there is also an automatic base switching feature that if turned on in the 
supervisor menu allows the sample process to be carried out on the smaller base 
capacity and then automatically switches to the larger base to carrying out the main 
counting. This allows you to get a more accurate piece weight by using the smaller 
scale.   
Subject to how this is set up in the supervisor menu you can sample on base 1 and 
count on base 2 or it can be set the other way around. 

4.4.5 Sample Operation  
The ZM223 can use two different sampling methods: Bulk and Dribble. Sampling 
methods can be selected under the Supervisor Menu.  

1. To view the sample size and begin the sample process, press the F1 key. The 
default sample size is 25.  

2. To change this sample size, first abort sampling, key in the new sample size 
and press the RPN key (F1/Sample Size). 

Sampling with a New Sample Size 
1. Press F1, zeroing, add number  
2. Add the number of components to the scale and press … 

If successful, the display will now show count quantity on the scale. 



 

Page 43 of 224 
 

If unsuccessful, the scale will ask for a larger quantity to be added to the 
scale. 

Note: If the larger quantity still fails this may mean the environmental conditions the scale 
is in are not suitable to achieve the required accuracy. Move the scale to an area away 
from drafts or vibrations. 

Dribble Sampling (Default):  

With the counting application and the bulk sampling method active, follow these steps to 
count. 

1. Press ZERO to zero the scale.  
2. Press F1/SAMPLE …  

Zeroing is briefly displayed. This means the indicator is zeroing itself. 
The current sample size is displayed as a numeric value (XX).  

3. Place the correct number of samples on the scale all at the same time… 
busy is briefly displayed, followed by one of two possible outcomes: 

a. If the sample met the minimum sample requirements and the 
weight is stable, the display will show the correct number of parts 
on the scale and the COUNT annunciator will be lit. 

b. If the sample size did not meet the minimum sample 
requirements or if the weight was unstable, Abort is briefly 
displayed, and the display returns to gross weighing mode. 
Repeat steps 3 through 5 using a larger sample size. 

 
Bulk Sampling:  

With the counting application and the bulk sampling method active, follow these steps to 
count. 

4. Press ZERO to zero the scale.  
5. Press F1/SAMPLE …  

Zeroing is briefly displayed. This means the indicator is zeroing itself. 
The current sample size is displayed as a numeric value (XX).  

6. Place the correct number of samples on the scale all at the same time… 
busy is briefly displayed, followed by one of two possible outcomes: 

a. If the sample met the minimum sample requirements and the 
weight is stable, the display will show the correct number of parts 
on the scale and the COUNT annunciator will be lit. 

b. If the sample size did not meet the minimum sample 
requirements or if the weight was unstable, Abort is briefly 
displayed, and the display returns to gross weighing mode. 
Repeat steps 2 and 3 using a larger sample size. 

 
Note: Minimum sample weight is the gross zero band value. The initial sample count is 5 
pieces. The maximum number of pieces that can be sample is 100,000. 

 

4.4.6 Reviewing Piece Weights 
A Piece Weight can be reviewed by using the SELECT key until the Piece WT 
annunciator is illuminated. Operators can view the Piece Weight directly from the ZM223 
Remote Assist mobile app or Web browser page. 
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4.4.7 Using Checkcounting Feature  
Checkcounting allows users to set an upper and lower count limit that triggers the ZM223 
Indicator to signal when the target quantity has been reached. Checkcounting can be 
turned on in the Supervisor Menu.  

1. Press the ZERO key to zero the scale 
2. With a Piece Weight already set and the indicator working in Count mode, place 

the empty box or container on the scale and press TARE. 
NET COUNT Zero should now display  

3. Place the parts to be counted in the box or container on the scale 
4. If the count is UNDER the Target Quantity the Under-Annunciator Bars is 

illuminated and the backlight will be showing Red … 
Place more parts on the scale until the center Accept Bar is illuminated 
and the display backlight goes Green. 

5. If the count quantity is OVER the target count quantity the Over Bars is 
illuminated, and the backlight color changes to Orange. 

4.4.8 Setting Target Quantity 
Target Quantities can be entered and controlled in the ZM223 1 of 5 ways 

1. PLU Database control 
2. Set the general high and low limits from inside the Supervisor menu  
3. Entered in high and low limits using RPN function 
4. Enter in high and Low limits from the Mobile app 
5. Enter in high and Low limits from the web browser app 

PLU Database: The ZM223 has an internal database that can hold up to 2000 known 
PLUs with Piece Weights and Checkcount Limit parameters.    

The PLU database must be activated in the Supervisor Menu. When active, it allows the 
operator to load any of the 1 to 2000 stored PLUs in the ZM223 internal memory. 

Once set in the PLU Database a PLU number can recall information like the Piece 
Weight Value, Hi Tol, and Lo Tol and the indicator will automatically work based off that 
saved information. 

View and Change the Active PLU: 

1. With the PLU database activated, press and hold the SELECT key for 3 seconds…  

The screen will flash PLU then the active PLU number is displayed. 

2. Press  to return to counting using the displayed PLU piece weight. 
3. To change a PLU, with the active PLU number displayed, key in the desired PLU 

number and press the .. 
The display will flash the new PLU number before returning to counting mode 
using the new piece weight values. 

General High and Low Target setting: This can only be set if Check is enabled in the 
Supervisor Menu. A general high limit and a low limit can be set to control all under Over 
and Accept bars along with backlights.  
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Entered Target Value using RPN:  
Low Targ and HI Targ RPN keys are set in the Supervisor Menu. 

Label the defined RPN keys with the Under and Over Label stickers that come with the 
ZM223 indicator  

1. Use the numeric keys to enter in the high quantity in parts followed by the High 
Target RPN key… 

The display will flash HI TARG and then display the entered target 
number in parts before going back to the count Screen  

2. Use the numeric keys to enter in the Low limit quantity in parts followed by the 
Under RPN key… 

Note: To only allow the target quantity to be in the Accept Window. Set both the under 
and over to the same quantity (ex: 100). This will ensure that only 100 is inside the 
accept window. 

Entered Target Value Using Mobile App or Web Browser Pages: 
1. With the Remote Assist app installed, pair the mobile device to the indicator… 

The app profile will now load onto into the phone app. 

2. With Hi Target and Low Target enabled in the mobile app, press the Low Targ 
and HI Targ text area in the mobile app. 

3. Now enter in the new High and Low Quantities and press SAVE… 
This saved the new High and Low Quantity in now updated back within 
the indicator. 

4. This indicator will flash HI TARG and then the new target Quantity 1000 before 
reverting to the count screen.  

 
Note: If Lo Targ and HI Targ field entry is not seen on the mobile app, this field needs to 
be activated in the indicator under the Supervisor Menu Mobile field. 

 

Note: All instructions concerning an application’s Setpoints are covered in the Supervisor 
Menu Section on page 129. 
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4.5 Checkweighing Simple-Level Application 
This section applies if the ZM223 Simple Checkweighing Application. The Simple 
Checkweighing application is a fast and efficient checkweighing application that displays 
the ± deviation from a set target point. 

The Checkweighing Simple app works based on the Target Value being 0.   

Once the known target weight is placed on the scale, press the F1 key to establish the 
target point as 0. The under and over values work off this Target Zero Point. 

4.5.1 Checkweighing Display Visuals 
Along with the display’s backlight changing color depending on how the current weight 
relates to the target parameters, the ZM223’s display also features a fine-tuning bar 
graph at the top of the display that also serves to assist operators in checkweighing. 

                                        Under Target  On Target  Over Target 

 
The fine-tuning bar graph can be used to quickly adjust the packed weight to be within 
the required Accept quantity. 

Both Under and Over bars consist of 6 segments and can be used to help the operator 
quickly see how close the weight is to the Accept Window. The default for each segment 
of both Over and Under bars equals one division. 

External Check Lights: The ZM223 can also be connected to external lights or alarms 
that can be set to outputs linked to the UNDER, OVER, ACCEPT conditions. To link in 
and setup the ZM223 external outputs please contact an approved service provider.  
Setting an Accept Window: Setting Accept Windows in the ZM223’s Checkweighing 
Simple app can be done in 4 ways  

Red – Under the Accept Window 
Green – At the Accept Window 

Orange – Over the Accept Window 

         
                     UNDER Target                                AT Target                                     OVER Target 

 

Note: All backlight colors can be changed from within the Supervisor Menu under 
the Check and the BckMode fields. 
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Note: To cancel an RPN entry and return to normal operation, press the C key. 

 

Note: Every ZM223 comes with a key label pack for users to place over a key or 
annunciator so it is correctly labeled. 

 

4.5.2 Indicator Key Functions 
Key Push Duration Function 

 

 
  

Press Toggles between Gross weight and Target weight 
deviation 

 

 
  

Press Zeros Scale 

 

 
  

Press Sends a stable weight transaction to a Printer or PC  
 

 

 
  

Press Toggles between active units of Measure lb- kg- g -oz  
 

 

 
 

Press Quick check Target 
 

 

 
 

Press with no 
weight on the 
scale 

View the accept window parameters and edit the low 
tolerance and high tolerance from the target point. 
 

 

  

Press Accepts entered values – turns on scale when off  
 

 
 
Note: Pushbutton or Preset Tare functions are not available in this application 

 
The following function can be set up as an RPN secondarily key function: 
 Print Format (Default PRINT)  
 Tol Lo 
 Tol Hi  
 ID (Default UNITS) 
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4.5.3 Special Key Functions 
The following keys have an extra function in this application: Within this Checkweighing 
app the F1 key functions as a Quick Check TARGET key. Dedicated key labels can be 
attached to the overlay to help the operator know what the F1 key is now controlling. 

F1/TARGET: With a known sample weight on the scale, press F1/TARGET key to 
perform a target point for the accept band to work off. 

The display zeros (0.000), the Accept Segment of the bar graph lights up, and 
the backlight turns green.  In this mode the required target weight is always 0 and 
the Under and Over Accept Bands work from this zero-target point. 

Underweight: The backlight will turn red and illuminate the Under-bar graph annunciator 
to visually show how far away the current weight is from the Accept Window. 

Overweight: The backlight will turn orange and illuminate the Over bar graph 
annunciator to visually show how far away the current weight is from the Accept Window. 

Press the F1/TARGET key when the scale is at Zero to view and edit the Low and High 
tolerances.  

4.5.4 Checkweighing Operation 
Switching Between Checkweighing and Normal Weighing Mode  
1. To switch between any Checkweighing app and General Weighing mode, press 

SELECT…  

When the GROSS annunciator is displayed, the unit is in normal weighing mode  

OR 
When the GROSS annunciator disappears, the unit is now in Checkweigh mode. 
The display may show a negative weight and the Under Segments of the bar 
graph annunciator may be lit if there is an active target value.  

Setting a New Target Weight  
2. If necessary, press ZERO to zero the scale… 
3. Place an item of the desired Target Weight on the scale and press F1/TARGET…  

The indicator will flash TARGET and then display the live weight as 0 with the 
center Accept segment illuminated showing that the target weight has been set 
successfully. 

 
Note: If motion is present for greater than 2-3 seconds after the F1/TARGET key press, 
the target operation will be aborted and the word cant will be displayed briefly. 

 
4. Clear the scale and place the next item on the scale …  

The bar graph and backlight will now show if the new item is over, under, or at 
the set Target Weight. 

 
Note: By default, the Accept Segment lights if the weight is within the high and low 
tolerance weight.  
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View and Set Low and High Tolerances  
Follow the steps below to view or edit the Low and High Tolerances. 

1. With no weight on the scale, press the F1 key…  
Lo-Tol is now displayed. 

2. Press … 
 The current Low Tolerance value is now displayed.  

3. To change Low Tolerance value, key in the new Low Tolerance and press  to 
accept... 

Lo-Tol is now displayed. 
4. Press … 

Hi-Tol is now displayed 
5. Press … 

The current High Tolerance value is now displayed. 
6. To change the High Tolerance, key in the new High Tolerance and press  to 

accept… 
Hi-Tol is now displayed. 

7. Press F1 to return to the normal weighing mode. 

 
Note: Viewing either low or high tolerances will time out after 5 seconds or when the 
operator presses the F1/TARGET key again to return the Checkweighing screen. 

 
Note: The tolerances can be set from 1 division to the capacity of the scale. 

 

4.5.5 RPN Functions and Checkweighing 
An RPN function is a way to use a single key for two different functions. Each Function 
key can be reassigned to perform a different function subject to the app that is running. 
Some of these functions work within app by default. 

Using RPN keys: 
Key in the value using the numeric keys and then press the RPN key that has been 
selected for that function. 

For Example: entering in a Tol low weight of 0.002 lb 

  Key in 0.002 lb and press the RPN activation key…  

Tol low then 0.002 will display before reverting to Checkweigh mode. 
The Under/Over accept bar graph along with the backlight color will now 
turn on work with the new Accept Weight Tolerance bands. 

Note: All instructions concerning an application’s Setpoints are covered in the Supervisor 
Menu Section on page 129. 

 

4.5.6   Printing and Checkweighing 
With a printer connected and configured, press the PRINT key to print out the difference 
from the Target Zero Point. 

For example: 
ACCEPT: 0.00 lb 
UNDER: -0.61 lb 
OVER:  0.30 lb 
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4.6 Checkweighing Mid-Level Application 
This section applies if the ZM223 Mid-Level Checkweighing Application is installed. The 
Mid-Level Checkweighing application works by using Tolerances and a Target Value or 
by Upper and Lower Weight Limits. The Checkweighing Mid application also allows the 
user to print the Target Weights and capture other weight data in the background. 

This app allows: 

 Quick Check key – to help speed up setup  
 Positive and negative checkweighing programs  
 Target Weight with tolerances or High and Low weight band limits 
 Back-office weight data capture stats programs  

− Standard deviation  
− X-Bar/R Stats programs 

4.6.1 Checkweighing Display Visuals 
Along with the display’s backlight changing color depending on how the current weight 
relates to the target parameters, the ZM223’s display also features a fine-tuning bar 
graph at the top of the display that also serves to assist operators in checkweighing. 

                                        Under Target  On Target  Over Target 

 
The fine-tuning bar graph can be used to quickly adjust the packed weight to be within 
the required Accept quantity. 

Both Under and Over bars consist of 6 segments and can be used to help the operator 
quickly see how close the weight is to the Accept Window. The default for each segment 
of both Over and Under bars equals one division. 

External Check Lights: The ZM223 can also be connected to external lights or alarms 
that can be set to outputs linked to the UNDER, OVER, ACCEPT conditions. To link in 
and setup the ZM223 external outputs please contact an approved service provider.  
Setting an Accept Window: Setting Accept Windows in the ZM223’s Checkweighing 
mid app can be done in 4 ways  

Red – Under the Accept Window  

 Green – At the Accept Window 

Orange – Over the Accept Window 

         
                      UNDER Target                                AT Target                                     OVER Target 
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Note: All backlight colors can be changed from within the Supervisor Menu under the 
Check and the bcKModE fields. 

4.6.2 Indicator Key Functions 
 

Key Push Duration Function 
 

 
 

Press Tares off box/container weight.  

 

 
 

Press and Hold Clears Tare value 

 

 
  

Press Toggles between Gross, Tare, and Net. 

 

 
  

Press Zeros Scale 

 

 
  

Press Sends a stable weight transaction to a Printer or PC  
 

 

 
 

Key in a Print 
Format Number 
and then press 

Changes the active Print Format 

 

 
 

Press and Hold Prints Stats Totals 

 

 
  

Press  Toggles between active units of Measure lb- kg- g -oz  
 

 

 
 

Press Quick check Target 
 

 

 
 

Press when the 
scale is at zero 

View and edit the High, Low, and Target values 

 Press Accepts entered values  
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RPN functions allowed in this app 
 ID (default UNITS key) 
 Print Format (default PRINT key) 
 Tol Low  
 Tol High  
 Target  
 Under Segment Division  
 Over Segment Division 

4.6.3 Special Key Functions 
The following keys have an extra function in this application: Within this Checkweighing 
app the F1 key functions as a Quick Check TARGET key. Dedicated key labels can be 
attached to the overlay to help the operator know what the F1 key is now controlling. 

Pressing the SELECT key allows users to cycle through and view the Gross, Net, Tare, 
Gross Total, Net Total, and Transaction Totals 
 When the Gross Total is displayed, both the GROSS and TOTAL annunciators 

will be lit.  
 When the Net Total is displayed, both the Net and Total annunciators will be lit.  
 When the Transaction Count is displayed, the custom annunciator will be lit. Add 

the provided Transaction Count sticker to the display 

F1/TARGET: With a known sample weight on the scale, press F1/TARGET key to 
perform a target point for the accept band to work off. 

Once the Target is established, the scale display will turn green, and the Accept Segment 
of the Bar Graph will light up. The Upper and Lower Tolerances work off of the newly set 
Target Weight. 

Press the F1/TARGET key when the scale is at zero, the scale displays Lo-Tol which is 
a menu prompt. You can navigate through these options to see and change the values 
for the lower tolerance, target weight, and high tolerance.   

Changing Low Tolerance:  
1. With no weight on the scale, press the F1/TARGET key...  

Lo-Tol is now displayed 

2. Press … 
The current Low Tolerance is now displayed. 

3. To change this value, key in a new value with the numeric keypad. 
4. Once you have the new value set, press  to accept… 

Lo-Tol is now displayed  
Changing TARGET: 

5. From Lo-Tol, press the …  

TARGET is now displayed  

6. Press  to view the current Target. 
7. To change this value, key in a new value with the numeric keypad. 
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8. Once you have the new value set, press  to accept… 
TARGET is now displayed.  

Changing High Tolerance:  

9. From TARGET, press the …  

Hi-Tol is now displayed  

10. Press … 
The current High Tolerance is now displayed. 

11. To change this value, key in the new value with the numeric keypad. 
12. Once you have the new value set, press  to accept… 

Hi-Tol is now displayed  
Exit: 

13. From Hi-Tol press … 
EXIT is now displayed  

14. Press  to exit the Target Menu and return to normal Checkweighing mode.  
 
Note: Viewing either low or high tolerances will time out after 5 seconds or when the 
operator presses the F1/TARGET key again to return the Checkweighing screen. 

 

4.6.4 Checkweighing Operation 
Setting a New Target Weight and Simple Checkweighing  
1. If necessary, press ZERO to zero the scale… 
2. Place an item of the desired Target Weight on the scale and press F1/TARGET…  

The indicator will flash TARGET and then display the live weight with the center 
Accept segment illuminated showing that the target weight has been set 
successfully.  

 
Note: If motion is present for greater than 2-3 seconds after the F1/TARGET key press, 
the target operation will be aborted and the word can’t will be displayed briefly. 

 
3. Clear the scale and place the next item on the scale …  

The bar graph and backlight will now show if the new item is over, under, or at 
the set Target Weight. 

 
Note: By default, the Target segment lights if the weight is within ± the high and low 
tolerance of the target weight. The over and under segments each represent 1 division. 
These can be adjusted in the Supervisor Menu to represent 1 part 

 
4.  Repeat step 3 for all other items to be checkweighed. 

4.6.5 RPN Functions and Checkweighing 
An RPN function is a way to use a single key for two different functions. Each Function 
key can be reassigned to perform a different function subject to the app that is running. 
Some of these functions work within app by default. 

Using RPN keys: 
Key in the value using the numeric keys and then press the RPN key that has been 
selected for that function. 

For Example: entering in a Tol low weight of 0.002 lb 
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  Key in 0.002 lb and press the RPN activation key…  

Tol low then 0.002 will display before reverting to Checkweigh mode. 
The Under/Over accept bar graph along with the backlight color will now 
turn on work with the new Accept Weight Tolerance bands. 

4.6.6 Negative Checkweighing  
Negative Checkweighing is available in the Mid-Level and Advanced Checkweighing 
applications. Negative Checkweighing works by taking the total weight of a container of 
items on the scale and subtracting the weight of a removed item to checkweigh the 
removed item (Under Weight, Accept, or Over Weight). This feature can reduce steps 
when used correctly in processes like dispensing out of a larger bulk container. 
Follow these steps: 

1. Place a full container on the scale and press TARE… 
The scale should read 0. 

2. Remove the desired amount of material from the container and press 
F1/TARGET.  

3. Press TARE again and start the negative checkweighing process 
4. Now whenever an item or items are removed from the container the ZM223 will 

now compare the missing weight to the checkweighing setting to checkweigh the 
removed items.  

5. Press TARE again to checkweigh the next removed item from the container. 
OR 

If Auto Tare is active in the Supervisor Menu, simply continue to remove items 
from the container to continue the Negative Checkweighing process.  

4.6.7 Standard Data Capture 
Whenever the PRINT key is pressed the scale will print the weight along with checkweigh 
statis Under, Over, or Within the Accept Weight Band. 
OVER:  12.36 lb  

OVER:  12.64 lb  

UNDER: 9.72 lb  

ACCEPT: 12.29 lb  

When Auto print is enabled, the scale will automatically print once the weight is stable. 
This ticket can be customized to meet your full data capture requirements.   

Standard Deviation: This statistical package controls and monitors each weight 
transaction and tracks all the weights each time the PRINT key is pressed. This allows 
users to see what the set Target Weights and the High and Low tolerances along with the 
Mean, Max, and Min recorded values. It also provides the samples taken and how many 
weighments fell within and outside of the Accept Window Weight. The program also 
captures standard deviation weight data in the background. A packrun quantity can be 
set to automatically print the Standard Deviation once the quantity has been reached. 

 

Report 
Example 

  

Tol Hi = 0.05 lb 

Tol Lo = 0.05 lb 

Target  = 3.00 lb 
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1. To print the Standard Deviation Report, press 
and hold the PRINT key for 3 seconds.  

If standard deviation is turned on, operators can get 
individual weights by pressing the PRINT key and the 
full statistical report when the PRINT key is held for 3 
seconds. The samples are cleared from memory 
when printed. If autoprint is enabled or the PRINT key 
is pressed a valid transaction occurs. 

Printing the Report:  
Press and hold the PRINT key for 4 seconds, display 
will flash “Std-dEv Prn-tot” and the report will be 
printed, then the samples will be cleared from 
memory. 

 
 
Note: To get the above report the Total Print Format must be set to 41. 

 

4.6.8 X-Bar/R Program  
The X-Bar/R program is designed to weigh process samples, establish the average 
weight, calculate the range between high and low weights, and the trend of deviation. If 
the X-Bar/R feature is enabled, the ZM223 will keep a queue of the average weights of 
the last eight sample sets. This queue of averages is used to print trend information on 
the statistical reports. 

 
Note: The Report Printout for the X-Bar/R program can be customized to present 
statistical data of your choosing. This information is found in the Service manual. 

 

1. With X-Bar/R running follow the below steps. 
2. With the scale at zero, place the item on the scale. 
3. When the weight is stable, press PRINT... 

If a printer or similar device is connected, a ticket is printed for this transaction 
and the transaction is stored. 

4. Remove the item from the scale. 
5. Repeat these steps until all items have been weighed. 
6. When the number of transactions reaches the specified number press and hold the 

PRINT key to print the X-Bar/R averages based on that subset, the indicator flashes 
PRN-TOT and sends the trend information to a connected device. 

Trend 
Message 

Meaning 

1 of 1 The last average in the queue has an error greater than 3x the limit 
2 of 3 Two of the last three averages in the queue have an error greater than the limit. 
4 of 5 Four of the last five averages have an error greater than the limit. 
8 of 8 Eight of eight averages are on the same side of the target weight. 

 

#  Over = 0 

# Under = 0 

#Accept = 16 

Mean = 2.84 lb 

Max Wt = 3.04 lb 

Min Wt = 0.00 lb 

Std Dev = 0.67 

C of V = 0.24 PCT 

#  Smpl = 20 
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Note: X-Bar/R are configured in a password-protected menu. 
The print format for the total format (with trend information) can be customized in a 
password-protected menu. 
If you want to print the trend information/totals, press and hold the PRINT key. 

 

Note: All instructions concerning an application’s Setpoints are covered in the Supervisor 
Menu Section on page 129. 
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4.7 Checkweighing Advanced-Level Application 
This section applies to the ZM223 Advanced 
Checkweighing Application. This application is 
identical in function to the Mid-Level application 
but with several additional features.   

Like the Checkweighing Mid Application the 
Advanced Application has: 

 Quick Check Key – to help speed up 
setup.  

 Positive and negative checkweighing 
programs.  

 Target Weight with tolerances or High 
and Low weight band limits.  

 Back-office weight data capture stats 
programs  

− Standard deviation  
− X-Bar/R Stats programs 

The additional Checkweighing Advanced 
features are: 

 1 to 500 Product Look Ups Data 
base (PLUs) for holding known Under, Over, and Accept tolerances.   

 Packrun data to track data based on known quantity of weighments needed to 
complete packrun. 

− This also enhances Standard Deviation and X-Bar to allow data to be 
automatically printed based on the packrun size. 

 

 

 

Web Browser Check Adv Home Page  

Remote Assist Check Adv Home Page  
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4.7.1 Checkweighing Display Visuals 
Along with the display’s backlight changing color depending on how the current weight 
relates to the target parameters, the ZM223’s display also features a fine-tuning bar 
graph at the top of the display that also serves to assist operators in checkweighing. 

                                        Under Target  On Target  Over Target 

 
The fine-tuning bar graph can be used to quickly adjust the packed weight to be within 
the required Accept quantity. 

Both Under and Over bars consist of 6 segments and can be used to help the operator 
quickly see how close the weight is to the Accept Window. The default for each segment 
of both the Over and Under bars equals one division. 

External Check Lights: The ZM223 can also be connected to external lights or alarms 
that can be set to outputs linked to the UNDER, OVER, and ACCEPT conditions. To link 
in and setup the ZM223 external outputs please contact an approved service provider.  
Setting an Accept Window: Setting Accept Windows for all the ZM223’s Checkweighing 
apps can only be set by either manually entering in the target weight along with the upper 
and lower tolerance setting using the RPN key function, using the ZM223 Remote Assist 
mobile app, or the web browser page.  
This target quantity can also be recalled by using a preprogramed PLU number from 1 to 
500.  

Red – Under the Accept Window 

 Green – At the Accept Window 

Orange – Over the Accept Window 

 

         
                      UNDER Target                                AT Target                                     OVER Target 

 

Note: All backlight colors can be changed from within the Supervisor Menu under the 
Check and the bcKModE fields. 

 

Note: Every ZM223 comes with a key label pack to place over a key or annunciator so it 
is correctly labeled. 
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4.7.2 Indicator Key Functions 
Key Push Duration Function 

 

 
 

Press Tares off box/container weight.  

 

 
 

Press and Hold Clears Tare value 

 

 
  

Press Toggles between Gross, Tare, and Net. 

 

 
 
 

Press and Hold To enter PLU database and view and change active 
PLU 

 

 
  

Press Zeros Scale 

 

 
  

Press Sends a stable weight transaction to a Printer or PC  
 

 

 
 
 

Press and Hold To Print Totals or Stat Totals 

 

 
 

Key in a Print 
Format Number 
and then press 

Changes the active Print Format 

 

 
  

Press Toggles between active units of Measure lb, kg, g, 
and oz  

 

 
 

Press Quick Check Target 
 

 

 
 

Press when the 
scale is inside the 
Gross Zero Band 

To view the High and Low Tolerances and the Target 
Weight value 
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Press Accepts entered values  
 

 
The following function can be set up as an RPN secondarily key function:  
 Print Formats (default PRINT)  
 Target 
 Low Tol  
 Hi Tol 
 ID (Default UNITS) 
 PLU 

4.7.3 Special Key Functions 
The following keys have an extra function in this application: Within this Checkweighing 
app the F1 key functions as a Quick Check Target for PLU 0. The Quick Check function 
will not work on PLUs 1 to 500. Dedicated key labels can be attached to the overlay to 
help the operator know what the F1 key functions is now controlling. Pressing the 
SELECT key allows users to cycle through and view the Gross, Net, Tare. Gross Total, 
Net Total, and Transaction Totals only when the scale is within the gross zero band.  

 When the Gross Total is displayed, both the GROSS and TOTAL annunciators 
will be lit.  

 When the Net Total is displayed, both the Net and Total annunciators will be lit.  
 When the Transaction Count is displayed, the custom annunciator will be lit. Add 

the provided Transaction Count sticker to the display. 
View and edit the active PLU   

1. Press and hold the SELECT key… 
The display will flash PLU and then the active PLU number is now 
displayed. 

2. To change the PLU, key in the new PLU number and press  …   
The new PLU number is now active. 

 

Note: PLU 0 is a PLU slot that cannot be overwritten or saved over.  

 

Note: PLU 1 to 500 are Stored PLUs that are stored inside the Supervisor Menu, 
pressing the F1 key with no weight on the scale only allows users to view the prestored 
PLU weight values for the Under, Over, and Accept values.   

 
F1/TARGET: With a known sample weight on the scale, press F1/TARGET key to 
perform a target point for the accept band to work off. 

Press the F1/TARGET key when the scale is at Zero to view and edit the Target Weight. 
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F1/TARGET:  

1. Place the sample on the scale prior to going through the injection machine.  
2. Press the F1/TARGET to establish the weight sample… 

Changing Low Tolerance:  
3. With no weight on the scale, press the F1/TARGET key...  

Lo-Tol is now displayed 

4. Press … 
The current Low Tolerance is now displayed. 

5. To change this value, key in a new value with the numeric keypad. 
6. Once you have the new value set, press  to accept… 

Lo-Tol is now displayed  
Changing TARGET: 

7. From Lo-Tol, press the …  

TARGET is now displayed  

8. Press  to view the current Target. 
9. To change this value, key in a new value with the numeric keypad. 
10. Once you have the new value set, press  to accept… 

TARGET is now displayed.  
Changing High Tolerance:  

11. From TARGET, press the …  

Hi-Tol is now displayed  

12. Press … 
The current High Tolerance is now displayed. 

13. To change this value, key in the new value with the numeric keypad. 
14. Once you have the new value set, press  to accept… 

Hi-Tol is now displayed  
Exit: 

15. From Hi-Tol press  … 
EXIT is now displayed  

16. Press  to exit the Target Menu and return to normal Checkweighing mode.  
 
Note: Viewing either low or high tolerances will time out after 5 seconds or when the 
operator presses the F1/TARGET key again to return the Checkweighing screen. For 
PLU 1 to 500 pressing the F1 key at zero only allows users to view the weight 
parameters for that PLU. 
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4.7.4 Checkweighing Operation 
Switching Between Checkweighing and Normal Weighing Mode  
3. To switch between any Checkweighing app and General Weighing mode, press 

SELECT…  

When the GROSS annunciator is displayed, the unit is in normal weighing mode.  

OR 
When the GROSS annunciator disappears, the unit is now in Checkweighing 
mode. The display may show weight and the Under, Over, or Accept Segments 
of the bar graph annunciator may be lit if there is an active target value.  

Setting a New Target Weight for Advanced Checkweighing  
Setting a target weight can be done 4 different ways  
4. If necessary, press ZERO to zero the scale… 

 Quick Check method, place a known target weight on the scale and 
press SELECT, set PLU 0, and press the SELECT key when there is no 
weight on the scale. 

 Recall a prestored PLU by pressing and holding the SELECT key 
 The Remote Assist Mobile App 
 Use the Web Browser Pages 

5. Place the item on the scale to initiate the checkweighing process. 

Note: If motion is present for greater than 2-3 seconds after the F1/TARGET key press, 
the target operation will be aborted and the word cant will be displayed briefly. 

 
6. Receive Checkweight.  
7. Clear the scale and place the next item on the scale …  

The bar graph and backlight will now show if the new item is over, under, or at 
the set Target Weight. 

 
Note: By default the Target segment lights if the weight is within ± the high and low 
tolerance of the target weight. The over and under segments each represent 1 division. 

 
8.  Repeat steps 2-4 for all other items to be weighed. 

4.7.5 RPN Functions and Checkweighing 
An RPN function is a way to use a single key for two different functions. Each Function 
key can be reassigned to perform a different function subject to the app that is running. 
Some of these functions work within app by default.  

Using RPN keys: 
Key in the value using the numeric keys and then press the RPN key that has been 
selected for that function. 

For Example: entering in a Tol low weight of 0.002 lb 

  Key in 0.002 lb and press the RPN activation key…  

Tol low then 0.002 will display before reverting to Checkweigh mode. 
The Under/Over accept bar graph along with the backlight color will now 
turn on work with the new Accept Weight Tolerance bands. 
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4.7.6 Negative Checkweighing Operation 
Negative Checkweighing is available in the Mid-Level and Advanced Checkweighing 
applications. Negative Checkweighing works by taking the total weight of a container of 
items on the scale and subtracting the weight of a removed item to checkweigh the 
removed item (Under Weight, Accept, or Over Weight). This feature can reduce steps 
when used correctly in processes like dispensing out of a larger bulk container. 
Follow these steps: 

1. Place a full container on the scale and press TARE… 
The scale should read 0. 

2. Remove the desired amount of material from the container and press 
F1/TARGET.  

3. Press TARE again and start the negative checkweighing process 
4. Now whenever an item or items are removed from the container the ZM223 will 

now compare the missing weight to the checkweighing setting to checkweigh the 
removed items.  

5. Press TARE again to checkweigh the next removed item from the container. 
OR 

If Auto Tare is active in the Supervisor Menu, simply continue to remove items 
from the container to continue the Negative Checkweighing process. 

4.7.7 Using PLUs  
ZM223 Indicators come standard with 
an internal database that can hold up 
to 500 PLUs or Part Look Up. PLUs 
are used to quickly recall saved piece 
weights, along with other useful 
parameters. PLUs must be set up 
through a password-protected menu. 

 Target 
 Under Tolerances by 

Weight 
 Over Tolerances by Weight 

PLU 0 is a free PLU that cannot be saved over. PLU 1 to 500 hold data that can be 
stored and recalled even after the indicator has been turned off.  

 

4.7.8 Choosing a PLU and Checkweighing 
 
Note: Over, Under, and Target values for the PLU registers are entered in a password 
protected menu. See the Supervisor Menu under PLU. 

 
Use these steps to recall a PLU for checkweighing. 
1. If necessary, press ZERO to zero the scale. 
2. Press and hold SELECT. 
        The active PLU flashes. 
3. Key in the PLU number and press ENTER. 
         The PLU has now changed, and the indicator returns to checkweighing mode. 
 
4. Place the item on the scale. 

The indicator displays the weight, the bar graph segments change according to the 
tolerances set by the PLU and the backlight changes to indicate under, accept, or 
over. 

5. Remove the item from the scale. 
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6. Repeat steps 4 and 5 until finished with the active PLU. 
 
Note: Transaction counts and accumulators are stored with each PLU. 

 

4.7.9 Standard Data Capture 
Whenever the PRINT key is pressed the scale will print the weight along with checkweigh 
statis Under, Over, or Within the Accept Weight Band. 
OVER:  12.36 lb  
OVER:  12.64 lb  
UNDER: 9.72 lb  
ACCEPT: 12.29 lb  
When Auto print is enabled, the scale will automatically print once the weight is stable. 
This ticket can be customized to meet your full data capture requirements.   

This ticket can be customized to meet your full data capture requirements.   

Packrun: Packruns allows users to set a quantity of weighments before the indicator will 
print out the totals or if enabled along with standard deviation or X Bar/R. The packrun 
quantity will then control the number of transactions taken before the stats report prints. 
Packrun can be used to independently of other Standard Data Capture functions.  

 
Standard Deviation: This statistical package 
controls and monitors each weight transaction and 
tracks all the weights each time the PRINT key is 
pressed. This allows users to see what the set Target 
Weights and the High and Low tolerances along with 
the Mean, Max, and Min recorded values. It also 
provides the samples taken and how many 
weighments fell within and outside of the Accept 
Window Weight. The program also captures standard 
deviation weight data in the background. A packrun 
quantity can be set to automatically print the 
Standard Deviation once the quantity has been 
reached. 

1. To print the Standard Deviation Report 
without a set packrun, press and hold the 
PRINT key for 3 seconds. 

If standard deviation is turned on, operators can get individual weights by pressing the 
PRINT key and the full statistical report when the PRINT key is held for 4 seconds. The 
samples are cleared from memory when printed. If autoprint is enabled or the PRINT key 
is pressed a valid transaction occurs. 

 

 

 

 

Report 
Example 

  

Tol Hi = 0.05 lb 

Tol Lo = 0.05 lb 

Target  = 3.00 lb 

#  Over = 0 

# Under = 0 

#Accept = 16 

Mean = 2.84 lb 

Max Wt = 3.04 lb 

Min Wt = 0.00 lb 

Std Dev = 0.67 

C of V = 0.24 PCT 

#  Smpl = 20 
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Printing the Report:  
Press and hold the PRINT key for 4 seconds, display will flash “Std-dEv Prn-tot” and the 
report will be printed, then the samples will be cleared from memory. 

 
Note: To get the above report the Total Print Format must be set to 41. 

 

4.7.10 X-Bar/R Program  
The X-Bar/R program is designed to weigh process samples, establish the average 
weight, calculate the range between high and low weights, and the trend of deviation. If 
the X-Bar/R feature is enabled, the ZM223 will keep a queue of the average weights of 
the last eight sample sets. This queue of averages is used to print trend information on 
the statistical reports. 

 
Note: The Report Printout for the X-Bar/R program can be customized to present 
statistical data of your choosing. This information is found in the Service manual. 

 

1. With X-Bar/R running follow the below steps. 
2. With the scale at zero, place the item on the scale. 
3. When the weight is stable, press PRINT... 

If a printer or similar device is connected, a ticket is printed for this transaction 
and the transaction is stored. 

4. Remove the item from the scale. 
5. Repeat these steps until all items have been weighed. 
6. When the number of transactions reaches the specified number press and hold the 

PRINT key to print the X-Bar/R averages based on that subset, the indicator flashes, 
“PRN-TOT” and sends the trend information to a connected device. 

Trend 
Message 

Meaning 

1 of 1 The last average in the queue has an error greater than 3x the limit 
2 of 3 Two of the last three averages in the queue have an error greater than the limit. 
4 of 5 Four of the last five averages have an error greater than the limit. 
8 of 8 Eight of eight averages are on the same side of the target weight. 

 

 
 

Note: X-Bar/R are configured in a password-protected menu. 
The print format for the total format (with trend information). 
If you want to print the trend information/totals, press and hold the PRINT key. 

 

Note: All instructions concerning an application’s Setpoints are covered in the Supervisor 
Menu Section on page 129. 
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4.8 Checkweighing by Percentage  
This section covers the ZM223 Checkweighing by Percentage app. Percentage 
checkweighing is dominantly used to monitor the percentage weight increase in meats 
when used alongside brine water injection machines.    

4.8.1 Checkweighing Display Visuals 
Along with the display’s backlight changing color depending on how the current weight 
relates to the target parameters, the ZM223’s display also features a fine-tuning bar 
graph at the top of the display that also serves to assist operators in checkweighing. 

                                        Under Target  On Target  Over Target 

 
The fine-tuning bar graph can be used to quickly adjust the packed weight to be within 
the required Accept Percentage. 

Both Under and Over bars consist of 6 segments and can be used to help the operator 
quickly see how close the weight is to the Accept Window. The default for each segment 
of both Over and Under bars equals one division %. 

External Check Lights: The ZM223 can also be connected to external lights or alarms 
that can be set to outputs linked to the UNDER, OVER, and ACCEPT conditions. To link 
in and setup the ZM223 external outputs please contact an approved service provider.  
Setting an Accept Window: Setting Accept Windows for all the ZM223’s Checkweighing 
apps can only be set by either manually entering in the target % along with the upper and 
lower tolerance % setting using the RPN key function, using the ZM223 Remote Assist 
mobile app, or the web browser page.  
This target % (5.00%) can also be recalled by using a preprogramed PLU number from 1 
to 500.  

Red – Under the Accept Window 

 Green – At the Accept Window 

Orange – Over the Accept Window 

         
                      UNDER Target                                AT Target                                     OVER Target 

 

Note: All backlight colors can be changes from within the Supervisor Menu under the 
Check and the bcKModE fields. 
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Note: To cancel an RPN entry and return to normal operation, press the C key. 

 

Note: Every ZM223 comes with a key label pack to place over a key or annunciator so it 
is correctly labeled. 

 

4.8.2 Indicator Key Functions 
Key Push Duration Function 

 

 
  

Press Toggles between Gross and Percentage Weight 

 

 
 
 

Press and Hold To enter PLU database and view and change active 
PLU 

 

 
  

Press Zeros Scale 

 

 
  

Press Sends a stable weight transaction to a Printer or PC  
 

 

 
 
 

Press and Hold To Print Totals or Stat Totals 

 

 
 

Key in a Print 
Format Number 
and then press 

Changes the active Print Format 

 

 
  

Press Toggles between active units of Measure lb- kg- g -oz  

 

 
 

Key in an ID 
Number and 
press 

Enter an ID Number 

 

 
 

Press Takes the weight of the meat sample prior to going 
through the brine injection machine. 
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Press when the 
scale is inside the 
Gross Zero Band 

To view the High % and Low% Tolerances and the 
Target % value. 

 

 
  

Press Accepts entered values  
 

The following function can be set up as an RPN secondarily key function:  
 Print Formats (default PRINT)  
 Target % 
 Low tol %  
 Hi tol % 
 PLU 
 ID (Default UNITS) 

4.8.3 Special Key Functions 
The following keys have an extra function in this application: Within this Checkweighing 
app the F1 key functions as a Sample Weight key and displays the percentage as 0.0% 

Operators can use the SELECT key to toggle between Gross and Percentage Weight.   

F1/TARGET:  

1. Place the meat sample on the scale prior to going through the injection machine.  
2. Press the F1 /1st SAMPLE to establish the 1st weight sample. 

The display will now revert to percentage mode   
3. Run the same meat sample through the brine water injection machine and weight 

again once it comes out the other side. 
The display will now show as a percentage (ex: 5.0%) the meat has gained 
based off the 1st sample weight. If the weight gain is within the required 
tolerance percentage band the backlight will turn Green, and the center ACCEPT 
bar of the bar graph will light up. If the weight is over the target the display will 
turn orange and the upper right bar graph segments, will light up. 

Changing Low Tolerance %:  
4. With no weight on the scale, press the F1/TARGET key...  

Lo-Tol is now displayed 

5. Press … 
The current Low Tolerance is now displayed. 

6. To change this value, key in a new value with the numeric keypad. 
7. Once you have the new value set, press  to accept… 

Lo-Tol is now displayed  
Changing TARGET %: 

8. From Lo-Tol, press the …  

TARGET is now displayed  

9. Press … 
The current Target weight is now displayed. 

10. To change this value, key in a new value with the numeric keypad. 
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11. Once you have the new value set, press  to accept… 
TARGET is now displayed.  

Changing High Tolerance %:  

12. From TARGET, press the …  

Hi-Tol is now displayed  

13. Press … 
The current High Tolerance is now displayed. 

14. To change this value, key in the new value with the numeric keypad. 
15. Once you have the new value set, press  to accept… 

Hi-Tol is now displayed  
Exit: 

16. From Hi-Tol press  … 
EXIT is now displayed  

17. Press  to exit the Target Menu and return to normal Checkweighing mode.   
 
Note: Viewing either low or high tolerances will time out after 5 seconds or when the 
operator presses the F1/TARGET key again to return the Checkweighing screen. 

 

4.8.4 RPN Functions and Checkweighing 
An RPN function is a way to use a single key for two different functions. Each Function 
key can be reassigned to perform a different function subject to the app that is running. 
Some of these functions work within app by default. 
Using RPN keys: 
Key in the value using the numeric keys and then press the RPN key that has been 
selected for that function. 

For Example: entering in a Tol low weight of 1.0% 

  Key in 1.2% and press the RPN activation key… 

Tol low then 1.2% will display before reverting to Checkweigh mode. 
The Under/Over accept bar graph along with the backlight color will now 
turn on work with the new Accept Weight Tolerance bands. 

4.8.5 Sample Monitoring Percentage Weight Gain 
These steps apply only if the active PLU# is 0.  

1 If necessary, press ZERO to zero the scale… 

Note: If motion is present for greater than 2-3 seconds after the F1 key press, the target 
operation will be aborted and the word CANT will be displayed briefly. 

 
2 Place the item on the scale and press F1/SAMPLE to get the 1st Sample Weight… 

Percent of item on the scale is now displayed. This should be 0.0%.  
3 Add additional weight (for example, by injection) until the target percentage has been 

reached…  
When the target percentage is reached, the backlight will turn green. 

4 Clear the scale and place the next item on the scale. Repeat steps 1 and 4. 
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The bar graph and backlight will now show if the new item is over, under, or at 
the set Target Weight. 

Note: By default, the Target segment lights if the weight is within ± the high and low 
tolerance of the target weight. The over and under segments each represent 1 division 
%. 

 

4.8.6 Using PLUs  
ZM223 Indicators come standard with 
an internal database that can hold up 
to 500 PLUs or Part Look Up. PLUs 
are used to quickly recall saved tares 
and piece weights, along with other 
useful parameters. PLUs must be set 
up through a password-protected 
menu. 

 Target % 
 Under Tolerances by % 
 Over Tolerances by % 

PLU 0 is a free PLU that cannot be saved over. PLU 1 to 500 hold data that can be 
stored and recalled even after the indicator has been turned off.  

4.8.7 Recalling a Saved PLU 
Follow the steps below to recall a PLU.  

1. If necessary, press ZERO to zero the scale. 

2. Press and hold SELECT. 

        The active PLU flashes. 

3. Key in the PLU number and press ENTER. 

         The PLU has now changed, and the indicator returns to checkweighing mode. 

4. Place the item on the scale. 

The indicator displays the weight, the bar graph segments change according to the 
tolerances set by the PLU and the backlight changes to indicate Under, Accept, or 
Over. 

5. Remove the item from the scale. 

6. Repeat steps 4 and 5 until finished with the active PLU. 

 
Note: Transaction counts and accumulators are stored with each PLU. 
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4.8.8 Standard Data Capture 
Whenever the PRINT key is pressed the scale will print the weight along with checkweigh 
statis Under, Over, or Within the Accept Weight Band. 
OVER:  5.9%  
OVER:  6.1%  
UNDER: 3.9%  
ACCEPT: 4.8%  
When Auto print is enabled, the scale will automatically print once the weight is stable. 
This ticket can be customized to meet your full data capture requirements.   

Standard Deviation: This statistical package controls and monitors each weight 
transaction and tracks all the weights each time the PRINT key is pressed. This allows 
users to see what the set Target Weights and the High and Low tolerances along with the 
Mean, Max, and Min recorded values. It also provides the samples taken and how many 
weighments fell within and outside of the Accept Window Weight. The program also 
captures standard deviation weight data in the background.  

1. To print the Standard Deviation Report, press and hold the PRINT key for 3 seconds. 

If standard deviation is turned on, operators can get 
individual % readings by pressing the PRINT key and 
the full statistical report when the PRINT key is held 
for 4 seconds. The samples are cleared from memory 
when printed. If autoprint is enabled or the PRINT key 
is pressed a valid transaction occurs. 

Printing the Report:  
Press and hold the PRINT key for 4 seconds, display 
will flash “Std-dEv Prn-tot” and the report will be 
printed, then the samples will be cleared from 
memory. 

Note: To get the above report the Total Print Format must 
be set to 41. 

4.8.9 X-Bar/R Program  
The X-Bar/R program is designed to weigh process 
samples, establish the average weight, calculate the 
range between high and low weights, and the trend of 
deviation. If the X-Bar/R feature is enabled, the 
ZM223 will keep a queue of the average weights of 
the last eight sample sets. This queue of averages is 
used to print trend information on the statistical reports. 

 
Note: The Report Printout for the X-Bar/R program can be customized to present 
statistical data of your choosing. This information is found in the Service manual. 

 

1. With X-Bar/R running follow the below steps. 
2. With the scale at zero, place the item on the scale. 
3. When the weight is stable, press PRINT... 

If a printer or similar device is connected, a ticket is printed for this transaction 
and the transaction is stored. 

4. Remove the item from the scale. 
5. Repeat these steps until all items have been weighed. 

Report 
Example 

  

Tol Hi = 0.05 % 

Tol Lo = 0.05 % 

Target  = 3.00 % 

#  Over = 0 

# Under = 0 

#Accept = 16 

Mean = 2.84 % 

Max Wt = 3.04 % 

Min Wt = 0.00 % 

Std Dev = 0.67 

C of V = 0.24 PCT 

#  Smpl = 20 
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6. When the number of transactions reaches the specified number press and hold the 
PRINT key to print the X-Bar/R averages based on that subset, the indicator flashes 
PRN-TOT and sends the trend information to a connected device. 

Trend 
Message 

Meaning 

1 of 1 The last average in the queue has an error greater than 3x the limit 
2 of 3 Two of the last three averages in the queue have an error greater than the limit. 
4 of 5 Four of the last five averages have an error greater than the limit. 
8 of 8 Eight of eight averages are on the same side of the target weight. 

 

 
Note: X-Bar/R are configured in a password-protected menu. 
The print format for the total format (with trend information). 
If you want to print the trend information/totals, press and hold the PRINT key. 

 

Note: All instructions concerning an application’s Setpoints are covered in the Supervisor 
Menu Section on page 129. 
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4.9 Batching Application 
This section covers the ZM223 Batching application. Batching allows the indicator to 
control up to three outputs. Using these three outputs allows the ZM223 to control 
connected devices (motors, timers, augers, gates, etc.) to allow for different batching 
configurations.  

There are four types of batching operation: 

 2-speed single ingredient 
 Ingredient filling (up to three ingredients) 
 Independent setpoints filling 
 Fill/discharge operation 

 
 

Note: Other parameters, that are set in a 
password protected menu, affect the batching 
operation. 

Preact: This is the amount of material in free fall 
after a hopper gate closes. For example: 1000 lbs 
of material need to be added to a scale, but when 
the supply valve closes it is always 120 lbs over 
the desired amount. To correct this, set a preact 
of 120 lbs. This causes the setpoint controlling the 
material to stop sooner and allows the material in 
free fall to be accounted for in the final weight. 
In Discharge or Negative fill applications using 
manual preact the preact weight will typically be 
entered as a negative value.  

 
 

 

 

 

Remote Assist Batching Home Page  

Web Browser Batching Home Page  
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Key Push Duration Function 
 

    
 

Press Tares off box/container weight.  

 

   
 

Press and Hold Clears Tare value 

 

  
  

Press Toggles between Gross, Tare, Net, other display 
values. 

 

 
 

Press and Hold Access Output Values (Target’s 1, 2, 3 and Pre-Act’s 
1, 2, 3) 

 

 
  

Press Zeros Scale 

 

 
  

Press Sends a stable weight transaction to a printer or PC  
 

 

  

Press Toggles between active units of Measure lb, kg, g, oz 
 

 

 
 

Press START and a STOP 
 

 

 
  

Press Accepts entered values – turns on scale when off  
 

The following function can be set up as an RPN secondarily key function:  
 Print Formats (Default PRINT)  
 I/O 4  
 I/O 5  
 I/O 6  
 Preact 4  
 Preact 5  
 Preact 6  
 ID (Default UNITS) 
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4.9.1 Special Key Functions 
The following keys have an extra function in this application: Within the Batching app the 
F1 key functions as the START and STOP key. Operators can use the SELECT key to 
toggle between Gross, Net, and Tare weights.  

4.9.2 2-Speed Filling 
The 2-Speed Filling Application is for a single ingredient with a dual speed (Fast/Slow) 
filling control. This is typically accomplished by a valve or hopper gate that can be fully 
open (Fast), partially open (Slow), or closed (Stopped). When the fill starts both I/O 4, I/O 
5, and I/O 6 are turned on (outputs activated) which should set the dual speed control to 
full open (Fast). When the I/O 4 value is reached I/O 4 is turned off and this should set 
the dual speed control to partial open condition (Slow). When I/O 5 value is reached I/O 5 
and I/O 6 are turned off to close the control device and complete filling. I/O 6 can be used 
for a Batch Cycle Active indicator.  

 
Note:  I/O 1 is defaulted to the F1 key. 

 
Press and hold SELECT to access the setpoint editor. 

1. Set Target 1 to the fast fill value and Target 2 to the slow fill 
value. For example, when filling a product to 100 lb. with the last 5 lb. on 
slow fill: Target 1 should be set to 95 and Target 2 & Target 3 should be set 
to 100. 

2. To start the filling process, press F1…  
StArt? is now displayed. Press the  key to start the process or 
ESC button to abort. 

3. To pause the filling process, press F1…  
PAuSE is now displayed. 

4. To resume the batch, momentary press F1…  
RESumE? is now displayed; press the key to resume  

OR 

Press … 
StoP? is now displayed. Press  to stop the process. 

If preacts are used, the preacts are tied to the Output Target. Follow the below steps to 
set Output Targets.  

1. Press and hold the SELECT key.  
2. Press  to toggle through Preact 1, 2, and 3.  
3. Preacts can be set to Manual or Automatic.  
4. SDet the preact to the amount expected to be in free fall so the indicator will 

now compensate for that expected free fall by switching the output off 
sooner. 
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4.9.3 Ingredient Filling 
Ingredient filling is for batching up to 3 different ingredients controlled by the values of 
Target 1, 2, and 3. If Target 2’s value is 0 then it operates as a single ingredient filler. If 
Target 3’s value is 0 then it operates as a 2-ingredient batcher. 

1. Press and hold the SELECT key to access the setpoint editor. 
2. Set Target 1 to ingredient 1’s value, Target 2 to the ingredient 2’s value, and 

Target 3 to the ingredient 3’s value. See more details on Gross or Net weight 
batching in (on page 77) 

3. To start or restart the batching process, press F1.  
The display changes to green to show that filling has started. 

4. To stop the batching process, press F1.  
The display will change to red to show the process has been paused. 

5. To restart filling, press F1 again… 
The display will ask resume?  

6. Press  to restart filling. 

4.9.4 Independent Setpoints 
Independent Setpoint works like the general weighing mode setpoints with the addition of 
start/stop controls. Negative weight/discharge numbers are also available when using this 
mode. 

1. Press and hold the SELECT key to access the setpoint editor. 

2. Set Target 1, 2, & 3’s values. 

3. Press F1 then  to start the process.  

The backlight will turn green to show the process is running 

4. To pause the process, press the F1 key. 

The backlight will turn red to show the process has been paused. 

5. To resume the process, press the F1 then the  key… 

The backlight will turn green to show the process has resumed 

6. To abort the process while paused, press the F1 key and then press  
until StoP? is displayed, then press the  key… 

The backlight will turn yellow to show that process is no longer running. 

4.9.5 Fill/Discharge 
Fill/Discharge mode is typically used for manual applications that use negative filling to 
dispense a smaller amount of product from a large vessel, tank or hopper type scale. The 
vessel (tank or hopper) is filled to a set gross weight and then multiple operations of filling 
via negative amount of weight into bags or containers can be completed before the 
vessel (tank or hopper) requires a recharge or refill. 

Fill I/O 4 (Target 1): is assigned as the gross fill amount for the vessel (tank or hopper) 
and F1 key starts the fill. The fill is based only on gross weight. If Target 1 is set to 2000 
and the scale already has 500 lb remaining, the Target 1 will cut off when the additional 
1500 is added for a total gross of 2000 lb. 

Discharge I/O 5 (Target 2): is assigned as the discharge fill amount (negative weight) 
with the TARE key used to initiate the discharge cycle. Now tare the scale prior to 
activating Target 2 an operator can perform multiple discharge operations. When the 
vessel gross weight is low, the operator will perform a manual refill. 
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1. Press and hold SELECT to access the setpoint editor. 
2. Set Target 1 to the gross fill weight in the vessel or container. Set Target 2 to 

the weight of the product to be discharged into smaller bags or containers. 
3. To start the process, press F1 then the  key. 

The backlight will change from yellow to green to show the process is 
running. Once the filling process level has reached the process will turn 
off Output 4 and wait for the manual dispensing to start. The backlight 
will turn red to show the process is now paused. 

4. Press TARE to start the filling/discharge process…  
The backlight will turn green while the bag/container is being filled.  

5. Once finished Output 2 turns off and the backlight will change to yellow until 
the next bag is ready to be filled.  

6. Repeat step 4 until the hopper is close to empty 
7. To pause the process, press F1… 

The backlight will turn red to show the process has been paused. 

8. To resume the process, press the F1 then the  key… 

The backlight will turn green to show the process has resumed 

9. To abort the process while paused, press the F1 key and then press  
until StoP? is displayed, then press the  key… 

The backlight will turn yellow to show that process is no longer running. 

4.9.6 Notes on Batching 
2 Speed Filling 
 MODE settings do not apply to Fill/Discharge 
 If DISP is set to NET, the display will remain in net weight mode after the discharge 

cycle has finished. 
 If DISP is set to GROSS, the display will remain in gross weight mode after the 

discharge cycle has finished. 
 If DISP is set to NET-A, auto tare will be performed, and the display will switch to 

gross weight mode after the discharge cycle showing what is left in the vessel. 
 If PREACT is set to AUTO it only applies during the Target 2 discharge cycle. 
 NEG FILL setting does not apply to Fill/Discharge 
 If NEG FILL is set to YES, then DISP should be set to Net so that an autotare 

occurs prior to start and the cutoffs will be based on negative entered values for I/O 
4 (Target 1) and I/O 5 (Target 2). 

 I/O 3 (input) and I/O 6 (Target 3) are used as the Active Batch Cycle indicator in 2 
Speed filling 

 
Note: If the F1 button is pressed during the batch cycle, the current ingredient fill will be 
terminated and the batch cycle will continue to the next ingredient fill. 
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Ingredients: 
 If MODE is set to AUTO, the batch process will continue until the final ingredient is 

completed. Between each ingredient there will be a slight delay to allow for motion, 
final weight and preact calculations. 

 If MODE is set to MANUAL, press F1 between each ingredient to complete the fill 
cycle. 

 If MODE is set to MANUAL and DISP is set to NET, press TARE between each 
ingredient before pressing F1 to fill the next ingredient. 

 If MODE is set to AUTO and DISP is set to NET, an autotare will occur prior to each 
ingredient and the Target 1, 2 and 3 (I/O4, I/O 5 & I/O 6) fill weights will be based on 
Net weight. 

 If DISP is set to GROSS, no autotare will occur and the Target 1, 2 and 3 (I/O4, I/O 5 
& I/O 6) fill weights would be based on the Gross weight of the accumulated 
ingredients. For example, if Ingredient 1 amount is 10, Ingredient 2 amount is 20 and 
Ingredient 3 amount is 30 then enter would enter I/O 4 = 10, I/O 5 = 30 (10 + 20) and 
I/O 6 = 60 (10 + 20 + 30). Output cutoffs are based on the actual displayed Gross 
Weight so if inaccurate amounts of ingredient are experienced during the batch, then 
it may affect the amount of each subsequent ingredient that is added. 

 If PREACT is set to AUTO, then it will be calculated for each ingredient to adjust the 
cutoff weight accordingly. 

 If NEG FILL is set to YES, it will only operate for a single ingredient with I/O 4 used 
for discharge filling based on negative weight. 

Note: All instructions concerning an application’s Setpoints are covered in the Supervisor 
Menu Section on page 133. 
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4.10 Peak Hold Application 
This section covers the ZM223 Peak Hold 
application. In certain production 
processes, testing force is required to 
understand product performance. The 
ZM223 indicator can weigh up to the failure 
point and hold the peak weight value of the 
unit before it breaks giving an accurate 
failure tolerance, all while recording the 
weight data in the background.  
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
 
 
 
 

Remote Assist Peak Hold Home Page  

Web Browser Peak Hold Home Page  
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4.10.1 Indicator Button Functions 
Key Push Duration Function 

 

  
  

Press Changes from Gross weight to the minimum recorded 
weight and then the maximum recorded weight. 

 

 
 

Press and Hold Access I/O 4, 5, and 6 values. 

 

 
  

Press Zeros Scale 

 

  

Press Sends a stable weight transaction to a printer or PC  
 

 

  

Press Toggles between active units of Measure lb, kg, g, oz 
 

 

 
 

Press Resets the min and max peak weights to the current 
gross weight. 
 

 

 
  

Press Accepts entered values – turns on scale when off  
 

The following function can be set up as an RPN secondarily key function:  
 Print Formats (Default PRINT)  
 I/O 4  
 I/O 5  
 I/O 6  
 ID (Default UNITS) 

4.10.2 Special Key Functions 
The following key has an extra function in this application: 

F1 resets the min and max peak weights to the current gross weight. 

In the Peak Hold application users can view the gross, max, and min display values by 
repeatedly pressing SELECT 

Additionally, when in normal operation the user can hold down the SELECT key to enter 
a quick edit mode for the I/O 4 - 6 values. 

4.10.3 Peak Hold Operation 
Only the highest weight applied to the scale is displayed when the peak weight value is 
selected to be displayed via the Minimum and Maximum weight display annunciators.  

With the Peak application active, follow these steps to perform and view peak 
weighments. 



 

Page 81 of 224 
 

1. Repeatedly press SELECT until the annunciators on the right of the display light up. 
This is the peak or maximum weight. 

2. With no weight on the scale, press ZERO, if necessary, press F1 to reset any 
previous peak value on the display. 

3. Apply force or weight to the product until it fails.  
The display will show the peak weight recorded during the weighment. 

4. To reset the peak, press F1 …  
5. The minimum and maximums are reset to the current gross weight. 
6. Repeat these steps to perform another peak weighment.  

 

 
The Peak Annunciator is displayed in the figure above. Add the “PEAK” and “MIN” labels 
from the label pack to the indicator’s display to help with operator.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

PEAK 
 

MIN 
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4.11 Remote Display Application  
This section covers the ZM223 Remote Display app. The indicator can be configured to 
work as a remote display with all other ZM series indicators. The ZM223’s Remote 
Display Application can be used as a Remote Display Indicator for a Primary Indicator 
through RS232 or Ethernet connection. See page 189 for full setup information.  
Furthermore, the main function keys (Tare, Zero, Print, and Units) on the remote display 
indicator will function normally.  

The Remote Assist Mobile App can also be connected to the Remote Display Indicator 
allowing for the same weight readings to displayed on a mobile device. 

 
Note: When using the Remote Assist Mobile App to view a live weight, the mobile app 
keys will not work in this setup. Because the app is connected to the Remote Display 
Indicator it just provides a remote live weight display.  
 
To use a ZM223 to function as a remote display for a separate Primary Indicator the user 
must configure settings in the Supervisor Menu and the Configuration Menu.  

Key Push Duration Function 
 

    
 

Press Sends a Tare command to the primary indicator to 
tare off the box/container weight. 

 

   
 

Press and Hold Sends a Clear Tare command to the primary indicator 
to clear the active tare weight. 

 

  
  

Press Sends a Select command to the primary indicator to 
toggle between Gross, Tare, Net, weights.  

 

 
  

Press Sends a Zero command to the primary indicator to 
zero the scale. 

 

 
  

Press Sends a Print command to the primary indicator to 
print a stable weight transaction to a printer. 
 

 

 
 

Press Reset the Max and Min weights 
 

 

 
  

Press Sends a Units command to the primary indicator to 
toggle between active units of Measure lb, kg, g, oz. 
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4.11.1 SELECT Key Default Function 
Pressing the SELECT key allows users to cycle through and view the Gross, Net, Tare, 
Gross Total, Net Total, and Transaction Count display values. This only applies when the 
scale is within the gross zero band.  

 When the Gross Total is displayed, both the GROSS and TOTAL annunciators 
will be lit.  

 When the Net Total is displayed, both the Net and Total annunciators will be lit.  
 When the Transaction Count is displayed, the custom annunciator will be lit. Add 

the provided Transaction Count sticker to the display.  
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4.12 In-Motion Application 
This section covers the ZM223 In-Motion Weighing app. In-motion weighing involves 
items moving across conveyor scales that use Entrance and Exit photo-eyes to track 
when an item moves on and off the conveyor scale to calculate a weight for that item. 
When the item is completely past the beam of the Entrance photo-eye the weight capture 
starts at the ADC rate of 80 samples per second.  When the item breaks the beam of the 
Exit photo-eye the weight capture stops, and the average of all the weight readings is 
displayed for a configured length of time or until the next item breaks the beam of the 
entrance photo-eye. 

 
 

 

 

 

The average weight value will “print” when the exit photo eye is tripped. If the averaged 
weight timer expires before the next item arrives the indicator will show dashes across 
the middle of the display. 

Below is a guide that will show how to setup/configure the ZM233 In-Motion Check-
Weighing application using Entrance and Exit photo-eyes and using the setpoint outputs 
for the Under/Accept/Over control signals. 

4.12.1 Indicator Key Functions 
Key Push Duration Function 

 

    
 

Press Tares off box/container weight.  

 

   
 

Press and Hold Clears Tare value 

 

  
  

Press Toggle between gross weight and the in-motion 
weight 

 

 

Press and Hold Access I/O 4, 5, and 6 values. 

GROSS or NET annunciator 
will signal depending on if a 
Tare value is active 

Motion weighing 
annunciator 

In-Motion Annunciators 
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Press Zeros Scale 

 

  

Press Sends a stable weight transaction to a printer or PC  
 

 

  

Press Toggles between active units of Measure lb, kg, g, oz 
 

 

 
 

Press  
 

 

 
  

Press Accepts entered values – turns on scale when off  
 

 

4.12.2 Special Key Functions 
The following key has an extra function in this application: 

Pressing the SELECT key allows users to cycle through and view the Gross, Net, Tare, 
Gross Total, Net Total, and Transaction Count display values. This only applies when the 
scale is within the gross zero band.  

 When the Gross Total is displayed, both the GROSS and TOTAL annunciators 
will be lit.  

 When the Net Total is displayed, both the Net and Total annunciators will be lit.  
 When the Transaction Count is displayed, the custom annunciator will be lit. Add 

the provided Transaction Count sticker to the display.  

Additionally, when in normal operation the user can hold down the SELECT key to enter 
a quick edit mode for the I/O 4 - 6 values. This only applies to the ZM223 Indicator Apps 
that allow for I/O configuration. 

4.12.3 In-Motion Operation 
When setting up the In-Motion App it may be helpful to think about what each I/O is 
specifically controlling on the conveyor scale. 

 I/O 1 is connected to the Entrance photo-eye and a positive edge signal will start 
the weight averaging. 

 I/O 2 is connected to the Exit photo-eye and a positive edge signal will stop the 
weight averaging. 

For In-Motion Checkweighing: 

 I/O 4 will control the Under setpoint and must be set to ACT IN (Active Inside) 

 I/O 5 will control the Accept setpoint and must be set to ACT IN (Active Inside) 

 I/O 6 will control the Over setpoint and must be set to ACT ABV (Active Above). 
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Note: The setpoint outputs can be connected directly to a light stack or to external relays 
or opto modules to control the routing of the item after exiting the conveyor. 

 

4.12.4 In-Motion Checkweighing Operation 
1. Press the SELECT key until the bottom right 2 LED’s are illuminated 

2. Start the conveyor 

3. When an item triggers the entrance photo-eye the display will 

show  

4. When the item triggers the exit photo-eye the display will show the calculated 
average weight and the appropriate check-weigh setpoint output will activate for 
the length of the DELAY timer or until the next item        passes the entrance 
photo-eye. 

5. If the DELAY timer expires before the next item arrives the display will show 
center dashes 

Additional Notes: Checkweighing is based on Net weight. Tare weight is allowed. 

Note: All instructions concerning an application’s Setpoints are covered in the Supervisor 
Menu Section on page 133. 
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4.13 Grading Application 
This section covers the ZM223s Grading app. 
Grading is a useful function that allows users to 
classify a range of weights as “grades” to help 
improve processes that require weighing large 
quantities of items with irregular weights. For 
example, any weight below weight point #1 or 
above weight point #11 will be displayed as weight. 
Any other weight will be shown as one of the 10 
Grades. The display will show grAd X, with X being 
the grade number for that weight. Remove the item 
from the scale and weigh the next item. A running 
accumulated total per grade (total weight per grade 
plus the number of transaction per grade) is 
captured and can be printed when needed. 

 
Note: You can reduce the number of grades by 
setting Grad Points to 0.  
For example: To create 3 grades, set Grad Points 
1, 2, 3 and 4 normally (4 being the top of the Grade 
point 3). Set Grad Points 5 through 11 to 0. 

 
 
 
 

 
 
 
 
 
 

Remote Assist Grading Home Page  

Web Browser Grading Home Page  
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4.13.1 Grade Classifying  
Grade classifying is the same whether the unit is configured for positive or negative 
grading. Set the weight values for each division between the grades. If the weight on the 
scale falls below or is equal to the weight value of a grade division, it is in the grade 
below the line. If it is greater than a weight value, it is in the grade above the line. The 
default value for Weight Points 2 through 10 is 0. 

It is critical to note that when setting a grate range the WHOLE scale division is included 
in that grade. For example, if each scale division is 1.001 lb set Grade 1 to 1.000 lb and 
Grade 2 to 2.000 lbs then anything from 1.001lb to 2.001 lb is classed as  Grade 1. If you 
wanted to have Grade 2 trigger at 2.000 lbs then it would need to be set to 1.999 lbs.  

 

4.13.2 Indicator Key Functions 
 

Key Push Duration Function 
 

    
 

Press Tares off box/container weight.  

 

   
 

Press and Hold Clears Tare value 

 

  
  

Press Toggles between Gross, Tare, Net, other 

 

 
 

Press and Hold Access I/O 1 - 6 values. 

 

 
  

Press Zeros Scale 

 

 
  

Press Sends a stable weight transaction to a printer or PC  
 

 

 
 

Press and hold Prints and then clears accumulator totals 
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Press Toggles between active units of Measure lb, kg, g, oz 
 

 

 
 

Press Allow users to set up and view all the grades from 1 to 
11. 
 

 

 
  

Press Accepts entered values – turns on scale when off  
 

The following function can be set up as an RPN secondarily key function:  
 Print Formats (Default PRINT)  
 Grade 1  
 Grade 2  
 Grade 3  
 Grade 4  
 Grade 5  
 Grade 6  
 Grade 7  
 Grade 8  
 Grade 9  
 Grade 10  
 Grade 11  
 ID (Default UNITS) 

 

4.13.3 Special Key Functions 
The following keys have an extra function in this application:  

With Grades defined, press F1 to view or edit the values associated with the Grades. 

Operators can use the SELECT key to toggle between Gross, Net, and Tare weights. 

4.13.4 Positive vs. Negative Grading  
The ZM223 can be configured for positive or negative grading. Positive grading classifies 
a weight as 1 of 10 weight grades.  

Negative grading is used to classify objects removed, one at a time, from a full tote or 
box. The process is described in Negative grading with Autotare enabled on page 200. 
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4.13.5 Setting Weight Grades 
Grades are set up under the Supervisor Menu. Once they are set up, in regular weighing 
mode, users can press F1 to view or edit the values for Grades 1 - 11. (This works 
regardless of whether the scale is at zero). 
 

Note: When grades are set in the Supervisor Menu they will be saved to be used 
after the indicator is turned off. 

 
Setting Weight Grades 
1. With the Grading application active, press F1. 

GRAdING is displayed. 
2. Press  … 

GRAd 1 is displayed. This is the first weight point that defines the lower 
limit of GRAD 1 

3. Press  …  
The current First Grade value flashes indicating that you can edit this. 

4. Key in the weight for this and press  … 
The indicator returns to GRAD 1. 

5. Press to move to the next grading weight point. 
The next GRAD point is displayed.  

6. Repeat steps 3 – 5 until all grade weight points have been set. 
7. Once all the GRAD points have been entered, press  multiple times to exit and 

return to weighing. 

4.13.6 Negative Grading with Autotare Enabled  
If your unit is configured for negative grading with autotare enabled, follow these steps. 
Negative Grading is enabled in the Supervisor Menu. 

1. Zero the empty scale, if necessary.  
2. Place a tote or box loaded with the items to be graded on the scale…  
3. For the first weighment the operator needs to press the TARE key to initiate autotare. 

All following weighments will be automatically tared off.  
4. Remove an item…  

The grade of the removed item is shown for 0.5 seconds and the scale autotares. 
If the removed item weight is less than the grade 1 value the scale will still 
perform the autotare when stable.  

5. Repeat step 3 until all items have been graded.  
6. Remove the tote and repeat steps 1 through 4. 
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4.13.7 Negative Grading with Autotare Disabled  
Negative Grading works by taking the total weight of a container of items on the scale 
and subtracting the weight of a removed item to Grade the removed item. This feature 
can reduce steps when used correctly in processes like dispensing out of a larger bulk 
container. 
If a ZM223 is configured for negative grading with autotare disabled, follow the steps 
below:  

1. Zero the empty scale, if necessary.  
2. Place a full container on the scale and press TARE… 

The scale should read 0. 
3. Remove an item…  

The grade of the removed item is shown.  
4. Press the TARE key.  
5. Repeat step 3 until all items have been graded.  
6. Remove the tote and repeat steps 1 through 4. 

Note: All instructions concerning an application’s Setpoints are covered in the Supervisor 
Menu Section on page 136. 

 

4.13.8 Removing the Last Graded Weight from the 
Accumulator Totals 

Occasionally the weight of more than one product is registered by the scale resulting in 
an incorrect grade weight so removing the last Graded weight from the Accumulator 
totals is a common practice when negative grading.  
 
If this happens use the RPN ACUM - (any number followed by the correct RPN key) to 
remove the last from the Accumulator grade totals.   
 

Note: ACUMM- RPN can be turned on under the Supervisor Menu under RPN. 

 

4.13.9 Recording Grade Totals 
There are two ways to add a Grade to the Grade Totals: Manual and Automatic. 

When set to Manual, each time the PRINT key is pressed the last Grade Weight will be 
added to the Grade Band Total along with the number of transactions. 

When set to Automatic, each item’s weight data is added to the total upon being graded 
to automatically record once the weight is stable.  
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4.14 AutoLoc Application 
AutoLoc is specifically designed for use in weighing livestock. Once the indicator has 
determined the animal’s weight, the indicator automatically locks on that weight, and the 
weight reading will not change as long as the animal is on the scale. This makes the 
weight easy to record since the numbers do not rapidly change as the animal moves 
around on the scale. 

4.14.1 Indicator Key Functions 
 

Key Push Duration Function 
 

    
 

Press Tares off box/container weight.  

 

  
  

Press Toggles between Gross, Tare, Net, other 

 

 
  

Press Zeros Scale 

 

 
  

Press Sends a stable weight transaction to a printer or PC  
 

 

 
  

Press Toggles between active units of Measure lb, kg, g, oz 
 

 

 
 
 

Press and hold Rechecks the weight and removes the previous 
weight from the memory channel. 

 

 
 

Press Unlock the weight. 
 

 

 
  

Press Accepts entered values – turns on scale when off  
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4.14.2 AutoLoc Operation 
Standard Mode 
1. Turn the indicator on, press the SELECT key to access gross mode 
2. Press the ZERO key. 
3. Move the animal onto the scale. 
4. WWWW is shown, the AUTO annunciator turns on, the display turns red and shows 

the animals AutoLocked weight.  
5. If auto-accumulate is on, once the weight is locked-on, the ZM223 will automatically 

accumulate to the last selected memory channel. 
6. The weight stays locked until the weight on the scale drops by the programmed 

release tolerance. (Example: weighing a 2000 lb animal with a 25% release 
tolerance, means the lock will release when weight drops below 1500 lb). 

7. If the animal is released and the weight falls below the tolerance it may be possible to 
lock on another weighment. We recommend putting in a high release tolerance like 
75% to ensure reliable operation. 

8. To prevent an inadvertent AutoLoc (Ex: someone leans/steps on the scale), we 
recommend setting the ALC MiN parameter to 50% of the expected average animal 
weight. 

9. Remove the animal from the scale. Scale returns to live weighing mode 
10. Repeat steps 2 and 3 for every animal.  
11. When a false locked weight occurs, either: the F1 key to unlock the displayed weight 

and reweigh the animal.  
OR 

To remove an accumulated weight from an accumulated value press and hold UNITS 
key to recheck the animal’s weight and to remove last weight from the memory 
channel. This will also delete from the accumulators the last locked-on weight and 
replace it with the new locked-on weight. 

Advanced Mode 
The following describes how the ZM223 can be used for weighing and recording animal’s 
weight automatically on a single animal livestock scale using the advanced AutoLoc 
mode. The indicator must be set up for AutoLoc and set for advanced (AdvANcE) mode. 
The ZM223 will lock on an animal’s weight and stay locked even after the animal is off 
the scale. A new AutoLoc weight will only be retriggered upon placing the next animal on 
the scale. 

4. Turn the indicator on, press the SELECT key to access gross mode 
5. Press the ZERO key. 
6. Move the animal onto the scale. 
7. WWWW is shown, the AUTO annunciator turns on, the display turns red and shows 

the animals AutoLocked weight.  
8. If auto-accumulate is on, once the weight is locked-on, the ZM223 will automatically 

accumulate to the last selected memory channel. 
9. To prevent an inadvertent AutoLoc (Ex: someone leans/steps on the scale), we 

recommend setting the ALC MiN parameter to 50% of the expected average animal 
weight. 

10. Remove the animal from the scale. When in Advanced Mode the AutoLoc reading will 
stay on the display until another animal walks onto the scale. This was designed to 
help with record keeping.  

11. Repeat steps 2 and 3 for all animals. 
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12. When a false locked weight occurs, either: To just unlock the displayed weight and 
reweigh the animal, press the F1 key to unlock the indicator to recheck the animal’s 
weight  

OR 
To remove an accumulated weight from an accumulated value press and hold UNITS 
key to recheck the animal’s weight and to remove last weight from the memory 
channel. This will also delete from the accumulators the last locked-on weight and 
replace it with the new locked-on weight. 
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5 Remote Assist Mobile App Walkthrough  
This section covers the free Avery Weigh-Tronix Remote Assist mobile app that pairs 
with any ZM223 via Bluetooth. Remote Assist provides users with additional features to 
make the indicator more flexible. Using the Remote Assist app uses can: remotely view 
live weights, use some of the indicator keys, view and change a wide range of app 
defined weight data fields, change UDF printable text fields that can be used on a print 
ticket or label, and use operator prompts to aid in using the ZM223. Subject to the app 
running on the ZM223, special fields can be viewed and used in the Remote Assist 
mobile app. However, it is recommended to keep these active fields to around 6 to 
reduce the risk of slowing down the Remote Assist mobile app. The Remote Assist 
mobile app is available in Android, IOS, and Windows formats and can be downloaded 
using the QR code below or directly from the Google Play or Apple App Store. 

5.1 Remote Assist Mobile App Breakdown 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Scale Device Info: Capacity, Serial Number, Etc. – (Firmware Driven) 

Active Value, Weight, and Units – (Firmware Driven) 

User Prompt - (App Driven) 

UDF (User Defined Fields) + Custom App Buttons – (App Driven) 
 Driven using LUA Variables 
 Define which values you want displayed and their order. 
 Variable description, value, and read/write status is show. 
 Define custom buttons and colors. 

Device Keys/Remote Keys – (Firmware Driven) 

Device Settings, Name, Model, Connection Type  – (Firmware Driven) 

 

Menu button, Scale data, Refresh button, and Bluetooth icon.  
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5.2 Downloading the Remote Assist Application 
Download the Remote Assist Mobile App to any smartphone or tablet from either the 
Google Play Store or the Apple App Store by searching “AWTX Remote Assist.” 

1. Follow the normal app download procedure. 
2. Once downloaded, tap the R-Assist icon shown below to launch the application.  

 

5.3 Connecting a Scale 
1. Tap the R-Assist application icon 
2. Tap “Add Bluetooth Device” 

Choose Start scanning: select the Serial Number that corresponds to the 
desired ZM223 Indicator  

OR 

Use QR code on the back of the indicator be sure to scan the Bluetooth 
Connection sticker on the back right hand side of the indicator. 

 
3. Name the device, while being sure to maintain an easy to remember naming 

convention.  

Note: We recommend that users maintain a reliable naming convention for all ZM223 
units. For example, if there are four production lines (Named: Line A, Line B, Line C, and 
Line D) that are getting four ZM223 units, name each unit the same as the line it is 
installed on so when connecting to an indicator through Remote Assist you will see Line 
A, Line B, Line C, and Line D.  

4. Tap the OK button and the mobile device is connected to the ZM223 Indicator  
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5.4 Mobile App Screen Navigation 
To navigate between the menus of the Remote Assist 
application use the Navigation Popup menu.  

To access the Navigation Popup menu, tap the Navigation 
Button on the upper left-hand side of the home screen.  

 
Note: The Navigation Button will be in the same location on 
every page of the Remote Assist Mobile App. Subject to 
the app that is running in the ZM223, some fields, like 
reports, may not be available in the app. 

 

5.5 Scale & UDF Fields Seen in the 
Remote Assist Mobile App 

Depending on the ZM223 app that is running in the 
indicator, will determine the scale fields that are available 
for the Mobile phone to use.  

All fields are fully controlled directly from the ZM223 
application running in the indicator or by enabling or 
disabling on the mobile app from the ZM223 Supervisor 
Menu. 

Configuring these fields to be On or Off is all done from the Mobile Menu under the 
Supervisor Menu (see page 208). 

5.6 Using the Active Scale Fields from the Remote Assist 
Mobile App 

Different ZM223 apps use different mobile app features. 

For example, in checkweighing the live weight color also represents if the weight is within 
the Accept / Under / Over states. 

Orange: Over 

Green: Accept  

Red: Under  

In the Batching application however, Green identifies the process is running and Red 
identifies that the process has been paused. 

Green: Process is running 

Red: Process Paused  
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Each of the scale fields that are enabled in the mobile app 
are used to provide clear visuals of the process 
parameters.  

Adjusting any fields with a pencil icon can be done 
remotely from the mobile app. To do this simply: 

1. Tap on the pencil icon area of the Remote Assist 
mobile app screen. 

2. The popup window is now displayed for that scale field. 
3. Type in your new value or description and tap the 

“Save” button in the middle of the popup window. 
4. The new value will be saved in the indicator and the 

Scale Field box in the Remote Assist mobile app 
screen will show the changed data. 

 
Note: If you enter the Supervisor menu on the ZM223 
Indicator when you return to live weight mode, it is 
recommended that you press the “Reconnect” key on the 
top right of the Remote Assist app screen. This ensures all 
new parameters are loaded correctly in the mobile app.  

 
Note: Digit colors in the Remote Assist app match those of 
the backlight settings in the ZM223.  

 

5.7 Text Prompt Messaging 
In some applications, the text prompt window area on the Remote Assist app screen is used      
to provide additional operator instructions or acknowledgements when certain steps in the 
process have been reached. 
 
These messages are built into the ZM223 Indicator application running in the indicator.  
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5.8 Mobile App Settings 
Under the Application Settings Menu users have access 
to the following fields: 

 Include date on stored transactions 
 Include time on stored transactions 
 Auto Reconnect 
 CSV Export Formats  
 Select Language 

Auto Reconnect automatically connects the mobile device 
to a previously paired indicator.  If Auto Reconnect is 
active it may be difficult for another mobile Bluetooth 
device to gain connection. 
 
Note: The Application Setting Menu also contains links to 
Avery Weigh-Tronix Privacy Policy and End User License 
Agreement.  

 
To save changes to the Remote Assist App Settings, 
make the desired changes and then tap the “OK” button 
on the lower left-hand corner of the screen shown below.  

 

5.9 Customizing Home Screen Keys 
Under the Select Device Key page, users can select what 
indicator keys and functions that appear on the Remote 
Assist home screen as well as their order. 
Tap the arrow symbols to change the order (from left to 
right) the buttons will be in on the Home Screen.  

Tap the plus button next to any of the keys under the 
Available Device Keys to add them to the Home Screen 
buttons. 

Tap the minus symbol next to any of the buttons under the 
Selected Device Keys to remove them from the Home 
Screen.  

The available keys are: 

 Tare (default) 
 Select (default) 
 Zero (default) 
 Units (default) 
 Print 
 Export (exports the stored live weights captured to 

a CSV or Excel file) 
 Store (saves live weight readings from the 

indicator inside the Remote Assist Mobile App) 

Tap the arrow symbols to change the order (from left to right) the buttons will be in on the 
Home Screen.  

Tap the plus button next to any of the keys under the Available Device Keys to add them 
to the Home Screen buttons. Tap the minus symbol next to any of the buttons under the 
Selected Device Keys to remove them from the Home Screen.  
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6 Web Browser Walkthrough 
This section covers the ZM223’s remote connectivity using the new Avery Weigh-Tronix 
web browser page. This web-based application allows operators the ability to run the 
indicator remotely from any PC or tablet that is connected to the same network that the 
ZM223 through any search browser. Using the web browser app also provides the user 
with additional features that cannot be done directly from the ZM223 indicator. 

Through the web browser app uses can: remotely view live weights, use all Indicator 
keys, view and change a wide range of app defined weight data fields, change UDF 
printable text fields that can be used on a print ticket or label, retrieve stored data from 
the ZM223 flash drive memory, store weight data to the mobile device, and use operator 
prompts to aid in using the ZM223. 

 To navigate between the available webpage screens (Scale, Super, and About), 
click on the corresponding screen button in the upper right-hand corner of the 
screen shown below. 

 Within the web browser page users can view the active PLU is allowing the 
operator the ability to view, edit, and adjust UDF fields. Please note that the UDF 
fields varies depending on the Indicator Application the ZM223 is currently 
running. 

 To use any of the ZM223 Indicator’s keys, click on the desired key on the 
simulated indicator display shown below.  

 To edit any of the ZM223 Information Fields click on the “Edit” button to the right 
of the field that needs to be edited.  

 
Note: IP address used in the web browser must match the indicator’s IP address. For 
example: 192.168.1.23 

 

 
Note: If the connection is lost and the web browser page will not reconnect, click on the 
Scale Tab to refresh the screen. It is advised to do this after changing anything in the 
Supervisor Menu to ensure any new fields that have been turned on have fully activated and 
displaying on the web browser page. 

Usable Indicator Keys 

Available Webpage Screens 

Indicator’s Info Fields 

Subject to the 
Site Location and 
the location’s 
requirements for 
approval a Not 
Legal For Trade 
Message will 
display.  
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6.1 Using the Web Browser  
Follow the steps below to connect to and operate a ZM223 Indicator from a web browser 
page. 

1. From a new web browser tab (Google Chrome, Microsoft Edge, Safari) type in 
the IP address of the ZM223 indicator you wish to connect to. 

 
Note: Remember that the ZM223 indicator must be connected to the same network for 
the web browser page to connect properly.  

 
UDF fields with an Edit/Pencell icon next to them are fields that can be changed or 
edited from the web browser screen.  

Designed to provide an easy method to add text                                                                                        
data to the transaction data or printed label data 

 Currently there are several predefined UDF fields that can be easily turned on 
from the supervisor menu  

UDF 1: Part No  UDF 2: Description  UDF 3: Loc     
UDF 4: Name    UDF5: Address 

 There are also 10 unnamed UDF fields that can be                                                                                
quickly turned on, edited & used.  

UDF 6  UDF 10  UDF 14 

UDF 7  UDF 11  UDF 15 

UDF 8  UDF 12 

UDF 9  UDF 13 

6.2 Live Weight 
The web browser page will mirror the ZM223 display overlay and constantly show the live 
weight from the indicator. All ZM223 keys on the web browser, like TARE, SELECT, 
ZERO, PRINT, UNITS and F1 work the same as they do on the indicator.  
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6.3 Web Browser Page Supervisor Tab  
The Supervisor Tab is password protected with the same password as the indicator’s 
Supervisor Menu. 

Any of the UDF fields can be modified/renamed from the Web Browser page (see screen 
capture below).  

To gain access to the Supervisor 
Menu enter the Supervisor password 
(1793). 

From the Supervisor Menu managers 
can enable, disable, or edit any UDF 
field.  

1. To activate or deactivate a UDF 
field, click or tap the switch button 
next to the desired UDF filed to 
toggle it on or off.  

2. To edit a UDF field, click or tap on 
UDF field bar and select the 
desired UDF value from the popup 
menu. 

 

6.4 Mobile and Web Browser 
Operator Prompts  

Unlike the indicator which is limited by the display the web browser screen and the 
mobile app screen both offer an additional text field area that allows additional operator 
prompts to be seen and viewed to aid the operator in carrying out the tasks in hand. 
These prompts will vary depending on the app. 

 

 

 

 

 

 

 

 

 

 

 

 

UDF linked Print Tokens   
UDF 1 PrintTokens[151] 
UDF 2 PrintTokens[152] 
UDF 3 PrintTokens[153] 
UDF 4 PrintTokens[154] 
UDF 5 PrintTokens[155] 
UDF 6 PrintTokens[156] 
UDF 7 PrintTokens[157] 
UDF 8 PrintTokens[158] 
UDF 9 PrintTokens[159] 
UDF 10 PrintTokens[160] 
UDF 11 PrintTokens[161] 
UDF 12 PrintTokens[162] 
UDF 13 PrintTokens[163] 
UDF 14 PrintTokens[164] 
UDF 15 PrintTokens[165] 
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6.5 Viewable Data Fields for Mobile and Web Browser 
Pages 

The Remote Assist Mobile App and web browser pages will show other useful data fields 
that have been turned on depending on the app. 

 

6.6 UDF Printable Fields  
The new web browser view also allows users to view and edit other UDF fields directly 
from any web browser. 

The following UDF fields can be turned on from within the Supervisor menu are:  

 Part Number  

 Description 

 Lot Location 

 Name 

 Address 

 10 UDF Text Fields   
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 Application 
 

General Accum Count Check Check 
Grade 

Check 
by % 

Truck 
In/Out 

Batch-
ing 

P-
Hold 

Remote 
Display In-Motion AutoLoc 

Simp Mid Adv 
Tare Weight X X X  X X X X X X X X X X 
ID X X X X X X X X X X X X X X 
I/O 4-6 X X      X X X X X X X 
Accumulation 
Channel   X            X 

Preact 4 – 6          X     
Gross, Net, Tare         X      
Description   X            
Inbound WT         X      
Outbound WT         X      
PLU   X   X  X       
Grade 1-11       X        
Transaction         X      
Target   X  X X  X      X 
Low   X X X X  X      X 
High   X X X X  X      X 
Piece Weight   X X X X         
Part Number   X X X X  X       
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7 Menus 
The ZM223’s different menu levels allow users to set up different weighing apps, change 
available settings, and access stored PLUs for the ZM223. All Menu levels available in 
the ZM223 indicator are accessed through passwords. Users can customize and 
configure the indicator for their purposes from these menus. The menus are always 
explained in a sequential manner to cover all information in a logical fashion. Users will 
most likely never access all the menu items in this manner. Use the provided menu maps 
to navigate to the menu item(s) that needs to be modified. 

The menu levels and their passwords are shown below: 

Password Menu Level Accessed Menus 
111 USER User, About, Audit 
1793 SUPER Application specific items. See User manual. 

 

7.1 Accessing Menus 
Follow these steps to access the menus in the ZM223. 

1. With the indicator powered up and in normal operating mode, press and hold F1 
…  

PASS is now displayed, prompting the user to enter the password. 
2. Key in the password for the needed menu and press …  

The first item in the top level of the accessed menu is now displayed. 
3. Use the navigation keys ( , , , or ) to navigate through the menu 

structure. 

7.2 Menu Annunciators 
The ZM223’s menu structure is made up of menu items, parameters, value entry 
screens, and lists that the operator can pick from. To help users know where they are in 
the menu, the bar graph at the top of the display is on while the indicator is in the menus 
and will change appearance according to the following rules: 

 
All segments flashing:  This means users are in the menu structure but 

not in any of the following screens. 
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Center flashing/others off:  This refers to a numeric entry screen or the 

Quick Code prompt screen. Enter in the 

appropriate Quick Code and press  to 
accept. 

 
Right flashing/others off:  This refers to a list. Scroll through the choices 

with the  and  keys and press  to 
accept. 

 
Left flashing/others off:  This refers to a data entry.  

 
Every alternate segment flashing:  This refers to octet entry for IP, Subnet, or 

Gateway address. 
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7.3 Exiting Menus 
1. Use F1 to escape and move up one level without accepting the choice or value. 

From that point, press  repeatedly until …  
SAvE No is now displayed. This means “Do not save changes.“ 

2. Press  to scroll through the choices: SAVE no, SAvEYES, and CANcEl. 
Press  to accept the displayed choice. 

Select SAvE No or SAvEYES to have the indicator exit the current menu 
and returns to normal weighing mode.  

OR 
Select CANcEl for the indicator to remain in the current menu. 

7.4 User Menu 
The USER level contains the User, About, and Audit menus as shown below.  

 To access the USER level, from normal weighing mode, press and hold the F1 
key. 

 Enter password 111 and press the  key. 

 

7.4.1 Time 
User ↓ Time 

Time: This lets users set the clock and choose the style of the time display 
12 hr, 12 hr a.m./p.m., or 24 hr. The Time can be used in print formats. 

1. Access the User menu and Press … 

tiME is now displayed. Use this to set the time and clock style. 

Set time 
Time ↓ Set 
Set: Enter in the hour, minute, and second.  
2. From tiME, press … 

SEt is now displayed 

3. Press … 

h-     x is now displayed, with the x flashing. This is a numeric 
entry screen for the hour value. 

4. Key in the hour of the day using military (24 hr) time and press 

 to accept… 

M-   x is now displayed, with the x flashing. This is a numeric entry 
screen for the minute value. 
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5. Key in the minute value and press  to accept… 

S-    x is now displayed, with the x flashing. This is a numeric entry 
screen for the second value. 

6. Key in the seconds value and press  to accept… 

SEt is now displayed. 

Style  
Time ↓ Set → Style 
Style: Choose the style of the time display (12 hr, 12 hr a.m./p.m., or 24 hr 
military) 
7. From SEt press  … 

StYLE is now displayed.  

8. Press  … 

12hr is now displayed. 

9. Press  or to scroll through the 
choices. Press  when your choice is now displayed … 

StYLE is now displayed. 

10. Press  … 

tiME is now displayed. 

7.4.2 Date 
User ↓ Time → Date 

Date: This allows users/technicians set the year, month, day, and 
the style of the displayed date. The Date can be used in print 
formats. 

1. From tiME, press  … 

dAtE is now displayed.  

Set date 
Date ↓ Set 
Set: Enter in the date’s year, month, and day.  
2. From dAtE press  … 

SEt is now displayed. 

3. Press  … 

y-    x is now displayed, with the x flashing. This is a 
numeric entry screen for the year value. 

4. Key in the year and press  to accept … 

M-   x is now displayed, with the x flashing. This is a numeric entry 
screen for the month. 

5. Key in the month value and press  to accept … 

d-   x is now displayed, with the x flashing. This is a numeric entry 
screen for the day value. 
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6. Key in the day value and press  to accept … 

SEt is now displayed. 

Style 
Date ↓ Set → Style 
Style: Choose the style for how the date display (MMDD2Y, MMDD4Y, 
DDMM2Y, and DDMM4Y) 

 

7. Press … 
StYLE is now displayed. Choices are MMDD2Y, MMDD4Y, DDMM2Y, 
and DDMM4Y. 

8. Press  … 

MMDD4Y is now displayed. 

9. Press  or to scroll through the choices. Press  when your 
choice is now displayed …  

StYLE is now displayed. 

10. Press  … 

dAtE is now displayed. 

7.4.3 Site ID 
User ↓ Time → Date → Site ID 

Site ID: This allows users/technicians to enter a Site 
ID. Use the alphanumeric keys to enter a Site ID 
(maximum 7 digits). Site ID can be used in a print 
format.   

 
1. From dAtE, press  item… 

SitE id is now displayed.  
2. Press  … 

A string entry screen is now displayed.  

3. Key in the site ID number on the numeric keypad and press  to accept 
… 

SitEid is now displayed. 
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7.4.4 Seal 
User ↓ Time → Date → Site ID → Seal 

Seal: This allows users/technicians to view 
the seal status of the physical seal jumper 
inside the indicator. If the unit is sealed, no 
changes can be made to the configuration of 
the indicator. For more information, see the 
note below.  

1. From SitE id, press  … 

SEAL is now displayed. 

2. Press  … 

Either no SEAL or SEALd is now displayed. This is the status of the 
physical seal jumper inside the indicator. If the unit is sealed, no 
changes can be made to the configuration of the indicator. 

   
3. Press F1 to return to the SEAL display 

7.4.5 Archive or Alibi Memory 
User ↓ Time → Date → Site ID → Seal → Archive 

Alibi Memory: Normally used for legal for trade 
traceability, this provides a consecutive number 
for each transaction which is stored in three 
different locations within the indicator’s internal 
memory (can hold around 5000 transactions). 
This item appears only if configured in the 
ADMIN menu. 

USB drive: When a USB drive is connected it 
can hold around 100,000 additional transactions. Printing to USB requires that a USB 
flash drive is connected to the indicator host USB. Printing to USB will create a folder on 
the flash drive and a comma separated file with the data. 

Micro SD memory: When a Micro SD Card is connected it can hold around 100,000 
additional transactions. Printing to a Micro SD Card requires that the Micro SD Card. 
Printing to USB will create a folder on the flash drive and a comma separated file with the 
data. 

7.4.6 Diagnostics 
User ↓ Time → Date → Site ID → Seal → Archive → Diagnostics  

Diagnostics: This allows users to view and change basic diagnostics 
settings for the indicator and any connected scale bases.  
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7.4.7 Backlight 
User ↓ Time → Date → Site ID → Seal → Archive → Diagnostics → Backlight 

BackLt: This allows users to set the 
primary back light color for the indicator. 
Some of the Indicator apps will override 
the primary back light color. In these apps 
the back light control setting can be 
modified from within the Supervisor Menu. 

Color: This allows the user to set the 
color of the primary backlight (Green, 
Yellow, Orange, or Red). The “None” 
option turns off the backlight putting the 
indicator in Outdoor mode.   

State: This allows the user to turn the backlight on, off, or to automatically trigger when 
the indicator is interacted with. 

Timeout: This allows the user to set the length of time before the backlight turns off.  

Users can adjust the backlight brightness and contrast holding the F1 (brightness) or 
UNITS (contrast) key and use  and  to adjust the settings. The brightness and 
contrast are saved automatically and will be applied after a reboot. 
13. From diAg, press  … 

BackLt is now displayed.  
14. Press  … 

Color is now displayed. Press  again and use  or cycle through the 
available backlight colors. 

15. Press  to choose the displayed color option… 
Color is now displayed 

16. From Color press  … 

State is now displayed. Press  again and use  or  to cycle through 
the available options. 

17. From State press  … 

Timeout is now displayed. Press  again to enter in the timeout limit [between 
0-60 seconds]. 

18. Press  to accept the displayed value… 

TiMout is now displayed. 

19. Press … 
diSPlAy is now displayed 
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7.4.8 Ethernet  
User ↓ Time → Date → Site ID → Seal → Archive (when enabled) → Diagnostics → Backlight → 
Ethernet 

Enet: Stands for Ethernet. Use this to view and edit the network addresses. If the 
indicator is connected to an Ethernet network, the values displayed will be the current 
assigned addresses. 

 

1. From bAcKlt, press … 
EnEt is now displayed. Use this item to view the values for the IP, Subnet, 
Gateway and MAC addresses. 

IP 
Enet ↓ IP Addr 
IP: Use this to view and edit the Indicator’s IP address. To edit any part of the address, 
navigate to the octet that needs to be edited and key in the desired changes. 

2. From EnEt press  … 

iP Addr is now displayed. Use this item to view and edit the four-part IP address. 

3. Press  … 

1-xxx is now displayed. This is the first octet of the IP address 

4. Press  … 

2-xxx is now displayed. This is the second octet of the IP address. 

5. Press  … 

3-xxx is now displayed. This is the third octet of the IP address. 

6. Press  … 
4-xxx is now displayed. This is the fourth octet of the IP address. 

7. Press   … 

iP Addr is now displayed. 

Subnet 
Enet ↓ IP Addr → SubNEt 
Subnet: Use this to view and edit the Subnet address. To edit any part of the address, 
navigate to the octet that needs to be edited and key in the desired changes. 

8. From iP Addr press  … 

SubNEt is now displayed. 

9. Press  … 

1-xxx is now displayed. This is the first octet of the Subnet address. 

10. Press  … 

2-xxx is now displayed. This is the second octet of the Subnet address. 
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11. Press  … 

3-xxx is now displayed. This is the third octet of the Subnet address. 

12. Press  … 
4-xxx is now displayed. This is the fourth octet of the Subnet address. 

13. Press   … 

SubNEt is now displayed       

Gateway 
Enet ↓ IP Addr → Gateway 
Gateway: Use this to view the Gateway address. To edit any part of the address, 
navigate to the octet that needs to be edited and key in the desired changes. 

14. From SubNEt press  … 

GAtEwAy is now displayed. 

15. Press  … 

1-xxx is now displayed. This is the first octet of the Gateway address. 

16. Press  … 

2-xxx is now displayed. This is the second octet of the Gateway address. 

17. Press  … 

3-xxx is now displayed. This is the third octet of the Gateway address. 

18. Press  … 
4-xxx is now displayed. This is the fourth octet of the Gateway address. 

19. Press   … 

GAtEwAy is now displayed       

DNS 
Enet ↓ IP Addr → DNS 
DNS: Domain Name System translates human-readable domain names (like 
www.example.com) into machine-readable IP addresses (like 192.168.1.1). Use this to 
view the DNS address. To edit any part of the address, navigate to the octet that needs 
to be edited and key in the desired changes. 

20. From GAtEwAy press  … 

dNS is now displayed. 

21. Press  … 

1-xxx is now displayed. This is the first octet of the Gateway address. 

22. Press  … 

2-xxx is now displayed. This is the second octet of the Gateway address. 

23. Press  … 

3-xxx is now displayed. This is the third octet of the Gateway address. 

24. Press  … 
4-xxx is now displayed. This is the fourth octet of the Gateway address. 
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25. Press   … 
dNS is now displayed. 

DHCP 
Enet ↓ IP Addr → DNS → DHCP 
DHCP: Dynamic Host Configuration Protocol assigns an IP Address to a device. DHCP is 
the opposite is a Static IP Address. Static IPs are industry standard but there are some 
circumstances where DHCP is used.  

26. From dNS press  … 

dHCP is now displayed. 

27. Press  … 
OFF is now displayed 

28. To enable DHCP, press  … 
ON is now displayed 

29. Press   … 
dHCP is now displayed. 

FTP 
Enet ↓ IP Addr → DNS → DHCP → FTP 
FTP: File Transfer Protocol is a standard network protocol used to transfer files between 
a client and server on a computer network. 

30. From dHCP press  … 

FTP is now displayed. 

31. Press  … 
ON is now displayed 

32. To disable FTP, press  … 
OFF is now displayed 

33. Press   … 
dHCP is now displayed. 
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7.5 About Menu 
Use the About Menu to display information about the ZM223 and its software.  

 

7.5.1 Bootloader, Firmware, and App 
About ↓ Boot → Firmware → Application 

About: Used to display information about 
the indicator and its software.  

Bootloader: Software that makes the 
electronics run. 

Firmware: Embedded system software 
that creates core functions of the product. 

App: Specific software that controls the 
behavior for a given installation. 
PArtno: This allows users to view part 
numbers in two parts. Press  or  
to toggle the display between the first and 
second parts of the part number.  
Version: This allows users to view the 
version of the bootloader. 

 
1. From the About Menu press  … 

boot is now displayed. 
2. Press  … 

PArtno is now displayed. 
3. Press  … 

The first part of the bootloader part number is now displayed. 
4. Press  or  to toggle the display between the first and second part of the part 

number. 
5. Press  to return to the PArtno item. 
6. Press  … 

VErSion is now displayed  
7. Press  … 

The bootloader version number is now displayed. 
8. Press  to return to the VErSion item. 
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9. Press  to return to the boot item. 
10. The above steps also allow users to view the PN and Versions for both Firmware and 

App fields. 

7.5.2 Serial 
About ↓ Boot → Firmware → Application → Serial 

Serial: This allows users to view the Serial 
Number of the indicator. The number is now 
displayed in two parts. Press  or  to 
toggle the display between the first and 
second parts of the serial number. The Serial 
Number should match the serial number that 
is printed on the indicator ID tag and is also 
included in the printed calibration report. 

1. With APP displayed, press  to move to the next item in this level … 

SEriAL is now displayed. 

 

2. Press  … 
The first part of the indicator’s serial number is now displayed. 

3. Press  or  to toggle the display between the first and second 
parts of the serial number. 

4. Press  to return to the SEriAL display. 

7.5.3 Option 
About ↓ Boot → Firmware → Application → Serial → Option 

Option: This allows users to view the 
description and version of an installed 
option card. 

Bus 1: Refers to Bus 1, where the 
option card is attached. There is only 
1 Bus in the ZM223. 

Card 1: Refers to the installed Option 
Card. There is only 1 Card in the 
ZM223. 

1. From SEriAL, press … 
oPtion is now displayed. Use this to view the version and type of installed option 
card. 

2. Press  … 

buS 1 is now displayed. 

3. Press  … 

CArd 1 is now displayed. 

4. Press  … 

TyPE is now displayed. 

5. Press  to see the type of the installed option card ... 

The type of card is now displayed. If there is no installed option card, NoNE is now 
displayed. 
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6. Press  ... 

TyPE is now displayed. 

7. Press … 

VErSioN is now displayed. 

8. Press  to see the version of the installed option card... 

The version is now displayed. If there is no installed option card, NoNE is now 
displayed. 

9. Press  ... 

VErSioN is now displayed. 

10. Press  3 times ... 

OPtioN is now displayed. 

7.5.4 Enet 
About ↓ Boot → Firmware → Application → Serial → Option → Enet 

 
Enet: Stands for Ethernet. Use this to view the network addresses. The network address 
may be changed under the Admin menu when it comes to internet security. If the 
indicator is connected to an Ethernet network, the values displayed will be the current 
assigned addresses. 

1. From oPtion, press  … 
EnEt is now displayed. Use this item to view the values for the IP, Subnet, 
Gateway and MAC addresses. 

IP 
Enet ↓ IP Addr 
IP: Use this to view the IP address.  

2. From EnEt press  … 

iP Addr is now displayed. Use this item to view the four-part IP address. 

3. Press  … 

1-xxx is now displayed. This is the first octet of the IP address 

4. Press  … 

2-xxx is now displayed. This is the second octet of the IP address. 

5. Press  … 

3-xxx is now displayed. This is the third octet of the IP address. 
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6. Press  … 
4-xxx is now displayed. This is the fourth octet of the IP address. 

7. Press   … 

iP Addr is now displayed. 

Subnet 
Enet ↓ IP Addr → Subnet 
Subnet: Use this to view the Subnet address.  

8. From iP Addr press  … 

SubNEt is now displayed. 

9. Press  … 

1-xxx is now displayed. This is the first octet of the Subnet address 

10. Press  … 

2-xxx is now displayed. This is the second octet of the Subnet address. 

11. Press  … 

3-xxx is now displayed. This is the third octet of the Subnet address. 

12. Press  … 
4-xxx is now displayed. This is the fourth octet of the Subnet address. 

13. Press   … 

SubNEt is now displayed. 

14. When finished, press  to return to the Enet menu item. 

Gateway 
Enet ↓ IP Addr → Subnet → Gateway 
Gateway: Use this to view the Gateway address.  

15. From SubNEt press  … 

GAtEwAy is now displayed. 

 

16. Press  … 

1-xxx is now displayed. This is the first octet of the Gateway address 

17. Press  … 

2-xxx is now displayed. This is the second octet of the Gateway address. 

18. Press  … 

3-xxx is now displayed. This is the third octet of the Gateway address. 

19. Press  … 
4-xxx is now displayed. This is the fourth octet of the Gateway address. 

20. Press   … 

GAtEwAy is now displayed. 
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21. When you are finished, press  to return to the Enet menu item. 

MAC 
Enet ↓ IP Addr → Subnet → Gateway → MAC 
MAC: Use this to view the MAC address.  

22. From GAtEwAy press  … 

MAC is now displayed. 

23. Press  … 

1-xxx is now displayed. This is the first octet of the MAC address 

24. Press  … 

2-xxx is now displayed. This is the second octet of the MAC address. 

25. Press  … 

3-xxx is now displayed. This is the third octet of the MAC address. 

26. Press  … 
4-xxx is now displayed. This is the fourth octet of the MAC address. 

27. Press  … 

5-xxx is now displayed. This is the fifth octet of the MAC address. 

28. Press  … 
6-xxx is now displayed. This is the sixth octet of the MAC address. 

29. Press   … 

MAC is now displayed. 

30. When you are finished, press  to return to the Enet menu item. 
 

Note: The IP, Subnet, and Gateway addresses are a series of octets with each octet 
having a value between 0 and 255. The MAC address is a series of six double digit 
values: 1  XX, 2  XX, 3  XX, etc. 

 

7.5.5 Download 
About ↓ Boot → Firmware → Application → Serial → Option → Enet → Dload 

 
The Download menus are used for security and licensing purposes. To upload a 
configuration file, the license number of the Configurator (Ztools) software must match 
one of the license numbers in the indicator. Contact AWTX Technical Support for 
assistance. 

This allows someone to check what Ztools license was used to create the configuration 
file found inside the indicator along with which Ztools license this was used to download 
this file configuration into the scale.  

To upload a Ztools configuration file from the scale, the Ztools license used to upload the 
file from the scale must match with the license that created it. If it does not match, the file 
will not be allowed to upload. If the license number of your Configuration Software 
application does not match either the SSerial or DSerial numbers you will be unable to 
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upload the existing configuration file from the indicator. Contact AWTX Technical Support 
for assistance 

Dload: Stands for download. Use this to view the Sserial and Dserial menus 

1. From EnEt press  … 
dLoAd is now displayed. This stands for download.  

Sserial 
Dload ↓ Sserial  
Sserial: This allows users to view the license number that created the 
configuration file. 

2. From dLoAd press  … 

SSEriAL is now displayed. 

3. Press  … 

The 1st third of the serial number of the creating application of the configuration 
file is now displayed. 

4. Press  to show the 2nd third. 
5. Press  to show the final third of the serial number. 
6. Press F1 … 

SSEriAL is now displayed. 

Dserial 
Dload ↓ Sserial → Dserial 
Dserial: This allows users to view the license number that 
downloaded the configuration file. 

7.  From SSEriAL press  … 

dSEriAL is now displayed. 

8. Press  … 

The 1st third of the serial number of the downloading application of the 
configuration file was downloaded to, is now displayed. 

9. Press  to show the 2nd third. 
10. Press  to show the final third of the serial number.  
11. Press F1… 

dSEriAL is now displayed. 

DNAME 
Dload ↓ Sserial → Dserial → DNAME 
DNAME: this allows users to view the licence name. 

12. From DSEriAL press  … 

DNAME is now displayed. 

13. Press  … 

The 1st third of the license name of the 
downloading application of the configuration file was downloaded to, is now 
displayed. 

14. Press  to show the 2nd third. 
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15. Press  to show the final third of the serial number.  
16. Press F1… 

DNAME  is now displayed. 

17. Press  twice … 

About is now displayed. 

7.5.6 BSQ 
About ↓ Boot → Firmware → Application → Serial → Option → Enet → Dload → BSQ 

 
Scale 1 or Scale 2 
BSQ ↓ Scale 1 → Scale 2 
Scale 1 or 2: This allows users to select which of the two 
QuartzellTM  bases’ information they want to view. 

1. From BSQ, press  … 
Scale 1 is now displayed 

2. Press  to cycle between Scale 1 and Scale 2,  

SW Part 
BSQ ↓ Scale 1 ↓ SW Part 
SW Part: This allows users to view the firmware PN for the 
QuartzellTM that is connected.   

3. From Scale 1 or Scale 2, press   … 
SW Part is now displayed 

4. Press  … 
AWT30 is now displayed 

5. Use  or  to cycle through the whole PN 

Version 
BSQ ↓ Scale 1 ↓ SW Part → Version 
Version: This allows users to view the firmware version for 
the QuartzellTM that is connected.   

6. From SW Part, press   … 
VErSion is now displayed 

7. Press  … 
The version number is now displayed. 

8. Use  or to cycle through the whole version 
number. 
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Cur Ser 
BSQ ↓ Scale 1 ↓ SW Part → Version → Cur Ser 
Current QuartzellTM Serial Number: This allows 
users to view the Serial Number of the QuartzellTM 

that is connected.    

9. From VErSion, press   … 

Cur Ser is now displayed 

10. Press  … 
The serial number is now displayed. 

11. Use  or to cycle through the whole serial number 

Cal Ser 
BSQ ↓ Scale 1 ↓ SW Part → Version → Cur Ser → Cal Ser 
Cal Ser: This allows users to view 
the Serial Number of the QuartzellTM 

that was connected when last 
calibrated.  

12. From Cur Ser, press   … 

Cal Ser is now displayed 

13. Press  … 
The serial number is now 
displayed. 

14. Use  or to cycle through the whole serial number 

7.5.7 Site 
About ↓ Boot → Firmware → Application → Serial → Option → Enet → Dload → BSQ → Site 

Site: This allows users to choose the geographical location of the indication between 
USA, Great Britan, Canada, Europe, China, India, and Sri Lanka. When using the 111 
User Menu, you can only view the 
site location and not change it. 

1. From BSQ press  … 

Site is now displayed. 

2. Press  … 
3. Use  or  to cycle through all the Site options. 

7.5.8 Main Board Hardware 
About ↓ Boot → Firmware → Application → Serial → Option → Enet → Dload → BSQ → Site → 
HW Rev  

HW Rev: This allows users to identify the main PC Board build level without opening the 
back of the indicator. 

1. From Site press  … 

HW REv is now displayed. 

2. Press  … 
The PC Board build level number is now displayed 

3. Press Press   … 
HW REv is now displayed.  
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7.5.9 bLE MAC 
About ↓ Boot → Firmware → Application → Serial → Option → Enet → Dload → BSQ → Site → 
HW Rev → blE MAC 

blE MAC: This allows users to view the Indicator’s Bluetooth Low Energy unit’s MAC 
address. 

1. From HW REv press  … 

bLE MAC is now displayed. 

2. Press  … 
The 1st half of the bLE MAC address is now displayed. 

3. Press  to show the 2nd half of the bLE MAC address. 
4. Press F1… 

blE MAC is now displayed. 

5. Press  … 

About is now displayed. 
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7.6 Audit Menu 
Use the Audit menu to 
display audit counters for 
configuration and calibration 
and to print the information.  

 

 

 

 

 

 

 

 

7.6.1 Counter 
Audit ↓ Counter 

Counter: This allows users to view the number of times the indicator has 
been calibrated or has had its configuration changed. The Counter has 3 main 
counter areas that can track changes made to the indicator.      

1. Access the Audit menu and press  … 

countEr is now displayed.  

Configuration 
Counter ↓ Config 
Config: Shows the number of times a change to the configuration 
parameters has been made. This counter only controls metrology-based 
configuration settings.  

2. From countEr Press  … 

conFig is now displayed. 

3. Press  again … 

A number appears showing how many times the indicator has been 
configured. 

4. Press   … 

conFig is now displayed. 
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General 
Counter ↓ Config → General 
General: Shows the number of times the indicator has had a non-
metrology-based configuration change done to it. These changes 
cover functions and features not controlled by any legal for trade 
setting such as display backlight color, IP addresses and other. 

5. From conFig Press  … 

General is now displayed. 

6. Press  again … 

Any changes to either the conFig or cALib menus will now display. 

7. Press   … 

General is now displayed. 

Calibration 
Counter ↓ Config → General → Calib 
Calib: Shows the number of times the scale has been 
calibrated.  

8. From General press  to move to the next item in 
this level … 

cALib is now displayed. 

9. Press  … 

A number appears showing how many times the indicator has been calibrated. 

10.  Press  … 

cALib is now displayed. 

11.  Press  … 

countEr is now displayed. 

7.6.2 Print  
Audit ↓ Counter → Print 

Print: This allows users to 
choose which available 
connection port to print Audit or 
General Reports from Port1, 
Port 2, USB, or SD.  

Audit: Audit reports log only 
changes to legal for trade 
settings. 

General: General reports show 
all changes to settings, 
including legal for trade. 

1. From countEr press  … 

PriNt is now displayed.  
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Port 1/Port 2/USB/SD 
Print ↓ Port 1 → Port 2 → USB → SD 
Print: This allows users to print off Audit Counters or General Counter information. 

Port 1: Under Port 1 choose to print to a column or ticket printer.  

Port 2: Under Port 2 choose to print to a column or ticket printer.  

USB: Printing to USB requires that a USB flash drive is connected to the indicator host 
USB. Printing to USB will create a folder on the flash drive and a comma separated file 
with the data. Printing to USB requires that a USB flash drive is connected to the 
indicator host USB. Printing to USB will create a folder on the flash drive and a comma 
separated file with the data. 

SD: Printing to SD requires that the Micro SD Card is connected to the indicator. Printing 
to SD will create a folder on the card and a comma separated file with the data. 
2. From PriNt press  … 

Audit is now displayed. Use  or to choose between Audit and General. 
The steps are the same for both Audit and General. 

3. Press  … 

Port 1 is now displayed. This is the first of four choices: Port 1, Port 2, USb and 
Sd. Use these to select which port to print the Audit report through. 

4. Press  or to scroll through the choices and press  to select an option …  

Audit is now displayed. 
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8 Supervisor Menus 
The Supervisor Menus allow technicians and supervisors to setup and change the functions of 
any of the configurable indicator applications that come with the ZM223.  

Wherever there is an option to print information in the any of the Supervisor’s Menus, the 
information will print out of Port 1, Port 2, or to USB, whichever is configured. 

Access the Supervisor Menu using the password 1793. Please note that the Supervisor menu 
changes based on the active application running and that the menus are always explained 
sequentially. Technicians can navigate to the area of the menu that needs to be changed by 
using the navigation keys. 

List of what is under the Supervisor Menu: 

 Setpoint: This allows users to set setpoints and output values (starting on page Error! 
Bookmark not defined.). 

 Tare: This allows users to set up and store Preset Tare values if enabled in the Admin 
Menu (page 137). 

 App Related Configuration: Each app has different configurable settings. 
− Accumulation App (page 140) 
− Truck In & Out App (page 144) 
− Counting App (page 145) 
− Checkweighing Simple App (page 160) 
− Checkweighing Mid App (page 164) 
− Checkweighing Adv App (page 171) 
− Check Percentage App Supervisor Menu (page 178) 
− Batching App Supervisor Menu (page 184)  
− Remote Display Supervisor Menu (page 189) 
− In-Motion App Supervisor Menu (page 196) 
− Grading App Supervisor Menu (page 200) 
− AutoLoc App Supervisor Menu (page  AutoLoc Setup201) 

 
 PLU: This is where PLUs are set up for apps that use an internal database. 
 Battery: This controls some power saving functions when the indicator is connected to a 

DC power source (page 201). 
 RPN: This allows users to set secondary key functions (page Error! Bookmark not 

defined.). 
 Mobile: This enables what User Defined Fields and scale fields that are available when 

using the Remote Assist Mobile App or web browser pages (page 208). 
 App Info: This shows users the app and software revisions currently running on this 

indicator (page 209). 
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8.1 General App Supervisor Menu 
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8.1.1 Setpoints for the General – Accumulation – Truck 
In/Out Applications 

Super ↓ Setpoint 
Setpoints: Setpoints are specific weight values that trigger outputs when reached. The 
triggered outputs can control relays connected to valves, lights, other machinery, etc. 
Setpoint outputs are configured in the Setpoint Menu. 

In other applications like Counting, Checkweighing, Grading, and Batching, the app will 
control the inputs in the same way, but the outputs will be controlled differently. Please 
refer to the “Reverent Supervisors” app menu section for more details.  

When using an external battery like the ZQbat to run the indicator, setpoint output #3 can 
be configured for shutting down the battery for power saving.  

A setpoint value can be entered ranging from +/- scale capacity. For the negative 
numeric entry process. Turn off or disable any setpoints you are not using.  

1. Access the Supervisor menu and press SuPEr, press … 

SETPNT is now displayed. Use this to: 

 Set the mode of outputs operation 
 Enter the output values 
 Set backlight colors for outputs 
 Select function for the inputs 
 Print the setpoint settings 
 Reset all setpoint settings to factory defaults. 

Inputs I/O 1 – I/O 3 
Setpoint ↓ Edit ↓ I/O 1-3 (Inputs) 
Inputs: are electrical inputs that can trigger a required input like to Zero the scale, to  
Tare off the scale to start or stop a process.  In most ZM223 apps the 1st 3 set points I/O 
as programed to be just inputs. 

2. Press … 
Edit is now displayed. 

3. Press … 

I/O1 is now displayed. This stands for input 1. Use this to assign a function to 
input 1 when an external switch is tripped.  

4. Press … 

The current choice is now displayed. 

5. Use  or  to scroll through the choices and when your choice is displayed, 
press  to accept … 

I/O1 is now displayed. 

6. Press … 

I/O2 is now displayed. 

7. Repeat steps 3 through 5 for I/O2 and I/O3. 
8. Press when finished … 

Edit is now displayed. 
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Outputs I/O 4 – I/O 6  
Setpoint ↓ Edit ↓ I/O 1-3 → I/O 4-6 (Outputs)  

 
Note: All outputs are deactivated by default. To activate an Output, navigate to the Mode 
x area for the Output and select how it will operate. 

 
Outputs: are used to turn on or off relays to control external processes like stack lights, 
alarms, hopper, valve gates, actuators, and more. The ZM223 indicator apps are mostly 
programed to use the last 3 Set points, I/O4, I/O5, and I/O6 as outputs. setting up the 
outputs is explained below. 

There are 3 steps to setting an Output: 
1. Set the mode of how the output with turn on and off in.  
2. Set the output on-trigger point or the off-trigger point values. 
3. Determine if the backlight will follow the Output on trigger point. 

EditX: This determines the value that triggers the output. Weather a weight must be 
above or below the set value depends on the Mode.  
ModeX: This determines when the output triggers. For example, the Act Above mode 
means the output is active when a weight is above the set value. Likewise, the Act Below 
means the output is active when the weight is below the set value. 

BacklightX: This is used to tie the backlight to the Output On trigger. Please note, the 
backlight only activates on the Output On trigger and will not turn off with the Output Off 
trigger. 

Due to this, if only one Output is used and a backlight color is linked to it, a second 
Output will be needed to change the backlight back to the original color. 

9. From I/O 3, press … 

I/O 4 is now displayed. Technicians can access I/O 4 by pressing the  key. 
The following instructions apply to any of these three outputs. 

10. Press … 

EdITX is now displayed. X being the number of the output. 

11. Press  … 

MOdEX is now displayed. This menu item sets the function of the output. 

Mode selection must be made before entering the Out value. 

12. Press … 

The current Mode setting for the selected Output is now displayed. The Mode 
settings are listed below: 

diSAblE (default): The output remains off. 
ACT-Abv: The output turns on when the weight is above the set weight value 
and turns off when the weight returns to below. 

ACT-bEl: The output turns on when the weight is below the set weight value and 
turns off when the weight returns to above. 

ACT-IN: The output turns on when the weight is inside of the low and high set 
values. 

ACT-OUT: The output turns on when the weight is outside of the low and high 
set values. 
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ACTAbv2: The output turns on immediately when the weight is above the 
configured value but when it is below the value it does not turn on until there is 
no motion.  

ACTbEl2: The output turns off immediately when the weight is below the 
configured value, forbut when it is above the value it does not turn on until there 
is no motion.  

13. Use  or  to scroll through the Setpoint Modes (ACT-Abv, ACT-bEl, ACT-IN, 
ACT-OUT, ACTAbv2, ACTbEl2) 
 

For ACT-Abv or ACT-bEL, set the Edit X value to the required trigger weight point. 

14. From ACT-Abv or ACT-bEL, press … 
MOdEx is displayed  

15. Press …  

EdITX is now displayed  

16. Press … 
A numeric entry screen is displayed. Key in the desired above or below output 
value. 

17. Press  to accept the value… 

EdITX is now displayed. 

For ACT-IN, ACT-OUT, ACTAbv2 or ACTbEl2, I/O XLO and I/O XHI are displayed 
under EdITX. Set the Edit X high and low limits to the required trigger points. 

18. From ACT-IN, ACT-OUT, ACTAbv2 or ACTbEl2, I/O XLO and I/O XHI, press 
… 

MOdEx is displayed  

19. Press …  

EdITX is now displayed  

20. Press … 

I/O XLO is now displayed 

21. Press … 
A numeric entry screen is displayed. Key in the desired above or below output 
value. 

22. Press  to accept the value… 
I/O XLO is now displayed 

23. Press  … 

I/O HI is now displayed. 

24. Press … 
A numeric entry screen is displayed. Key in the desired above or below output 
value. 

25. Press  to accept the value… 
I/O HI is now displayed. 
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26. Press the  key until I/O x is now displayed. 
27. Repeat steps 9 through 26 for I/O 5 and I/O 6. 

Linking Backlights to Outputs 
Setpoint ↓ Edit ↓ I/O 1-3 →  I/O 4-6 ↓ Edit X →  Mode X →  Backlight X 
Backlight: This determines what color the backlight is when the specific output is 
triggered. (Default is green) When linking a backlight color to the I/O mode, this only 
controls the backlight color turning on. It will not turn off the backlight when the Output 
turns off. To turn the backlight back to the original color, a 2nd output setting is required 
to trigger the backlight color to change back. 

28. From MOdEX, press … 

bKLT X is now displayed.  

29. Press … 
The default primary backlight color is now displayed (GrEEN, yEllow, OrANgE, 
REd, NoNE) 

30. Use  or  to scroll through the backlight colors and press  to make a 
selection … 

 bKLT X is now displayed.  

For example: If the line requires the output to turn the backlight from red to green once a 
specific weight is reached I/O4 would have to be set to: 

Mode 4:  Act in 

Edit 4:   lo 1 lb    

              hi 10 lb  

BackLt 4:  Green 

To have the backlight return to red, I/O5 would have to be set to: 

Mode 5:  Act Above 

Edit 5:   10 lb 

BackLt 5:  Red 

 
Print 
Setpoint ↓ Edit →  Print 
Print: this allows users to choose which 
available connection port Print Commands 
are sent to: Port1, Port 2, or USB. A USB 
drive must be plugged into the USB port 
for any data to be Printed/Saved.   

31. Press  … 

PriNt is now displayed. Use this to print the settings under SETPNT. 

32. Press  … 

Port 1 is now displayed. 

33. Press F1 to abort the print process or press  to scroll to the desired port and 
press  to print the information … 

PriNt is displayed after either action. 
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Reset 
Setpoint ↓ Edit →  Print →  Reset  
Reset: Use this to reset the settings under Edit 
to factory defaults. 
34. Press … 

RESEt is now displayed.  

35. Press … 

No is now displayed. 

36. Press F1 to abort the reset or press … 

YES is now displayed. 

37. Press  to reset the settings to factory defaults … 

RESEt is now displayed. 

38. Press … 

SETPNT is now displayed. 

8.1.2 Setpoints for the Checkweighing Apps 
Super ↓ Setpoint  

In all checkweighing apps and the counting app the only available setpoint sections are 
I/O 1 to 3 inputs which are covered below. All outputs control the Under, Over, and 
Accept weight bands set in the Supervisor Menu.  

8.1.2.1 Setpoints for the Batching App 
Super ↓ Setpoint 

In the Batching App the only available setpoint sections are I/O 1 to 3 inputs which are 
covered on page 126. All output settings depend on the type of batching app that is 
running (2 Speed, Ingredient, Indep, or Fill Discharge). Targets and Preacts are all set 
from a long press on the SELECT key or under the setpoint menu below. 

1. With the indicator powered up and in normal operating mode, press and hold F1 …  
Pass is now displayed, prompting the technician or user to enter the password. 

2. Key in the Supervisor Password (1793) and press … 
SuPEr is now displayed. 

3. Press …  
SETPNT is now displayed. 

4. Press … 
Edit is now displayed. Use this to edit values for outputs, preacts and to choose 
the type of input.  

Inputs 
Setpoint ↓ Edit ↓ I/O1 
I/O 1 to I/O 3 stands for input 1 to 3. Use this to assign a function to Input 1 when an 
external switch is tripped.  

5. Press …  
I/O1 is now displayed. This is the weight value for setpoint 1. 

6. Press …  
StArt is now displayed. This is the default value for I/O1.  
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7. Use  or  to toggle between the choices and press  to accept the 
displayed choice… 

I/O1 is now displayed. 
8. Repeat steps 6 through 8 for I/O2 (Input 2) and I/O3 (Input 3). 
9. When finished, press … 

I/O 4 is now displayed. 
Outputs 
Setpoint ↓ Edit ↓ I/O1 → I/O2 → I/O3 → I/O4  
I/O 4 to I/O 6 stands for Output 1 to 3. Use this to assign a function to Output 1 when an 
external switch is tripped. Select the output from I/O 4 to I/O 6 and set the target weight 
for that setpoint to work from. In the Batching App the Setpoint target values work 
differently depending on the Mode that is running. 
10. From I/O4, press …  

The target weight for I/O 4 now flashes. 
11. Key in the new target weight and press  …  

I/O4 is now displayed. 
12. Press …  

I/O5 is now displayed. 
13. Repeat steps 10 through 12 for I/O 5 (Output 2) and I/O 6 (Output 3). 
14. When finished, press … 

PREACT4 is now displayed. 

Preact 
Setpoint ↓ Edit ↓ I/O1 → I/O2 → I/O3 → I/O4 → I/O5 → I/O6 → Preact 4  
Preact: Preacts can be used to compensate for product weight that continues to fill into a 
bag or container after the setpoint output turns off and before the final weight stabilizes. 
Key in values for these items if Preacts are set to Manual or Auto. The entered values are 
used in either case but for Auto preacts the value is adjusted automatically by the 
indicator as it runs multiple batches. In other words, it learns what the correct preact 
should be. The actual cutoff weight will equal the entered setpoint value minus the preact 
value. 

15. With PREACT4 displayed, press …  
The current value is now displayed for preact 4 (which is associated with output 
1). 

16. Press  to accept the displayed value or key in a new value and press  to 
accept…  

PREACT4 is now displayed. 
17. Press …   

PREACT5 is now displayed. 
18. Repeat steps 15 through 17 for PREACT5 and PREACT6.  
19. When finished, press  until Edit is displayed. 

Print 
Setpoint ↓ Edit → Print 

20. Press …  
Print is now displayed. Use this to print the settings under SETPNT. 

21. Press …  
Port 1 is now displayed. 

22. Press F1 to abort the print process or press  to scroll to the desired port and press 
 to print the information…  
Print is now displayed after either action. 
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Reset 
Setpoint ↓ Edit → Print → Reset 
23. Press …  

RESEt is now displayed. Use this to reset the settings under Edit to factory 
defaults. 

24. Press …  
No is now displayed. 

25. Press F1 to abort the reset or press …  
YES is now displayed. 

26. Press  to reset the settings to factory defaults…  
RESEt is now displayed. 

27. Press …  
SETPNT is now displayed. 

8.1.3 Setpoints for the In-Motion App 
The setpoints for the In-Motion App all work from Outputs I/O 4 to I/O6 as shown below in 
a useful guide to best set up the outputs for In-Motion App. 

For the best In-Motion weighing performance the outputs must be set the following way: 

I/O4: Mode set to Act in - Backlight Set to: RED (UNDER)  

I/O5: Mode set to Act in - Backlight Set to: GREEN (ACCEPT)  

I/O6: Mode set to Act above - Backlight Set to: ORANGE (OVER) 

1. Press and hold SELECT key…  

  I/O 4 is now displayed. 
2. Press … 

I/O 4LO is displayed. A weight value equivalent to about 10 divisions is 
recommended.  

3. Press  and enter the I/O 4 Lo value.  

4. Press …  

  I/O 4LO is now displayed. 

5. Press …  

I/O 4HI is now displayed. The I/O 4Hi value should be entered as the minimum 
accept Target weight value 

6. Press  and enter this value and then press …  

  I/O 4HI is now displayed. 

7. Press  until I/O 4 is displayed 

8. Press …  

  I/O 5 is now displayed. 

9. Press … 

I/O 5LO is displayed. The I/O 5LO value is also the minimum accept Target 
weight and must equal the entered I/O 4HI value. 
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10. Press  and enter the same as the I/O 4HI value and press …  

  I/O 5LO is now displayed 

11. Press …  

I/O 5HI is now displayed. The I/O 5HI value is the maximum accept Target 
weight 

12. Press  and enter this value and then press …  

  I/O 5HI is now displayed 

13. Press … 

  I/O 5 is now displayed 

14. Press …  

I/O 6 is now displayed 

15. Press  and enter the same as the I/O 5HI value and press …  

I/O 6 is now displayed 

16. Press  until the display returns to normal operation 

  
Note: Required settings for proper checkweigher operation 
I/O 4 Lo = min 1 division, maximum is up to the weight of lightest item 
I/O 4 Hi = min Accept wt 
I/O 5 Lo = min Accept wt 
I/O 5 Hi = max Accept wt 
I/O 6= max Accept wt 

 
Setting No Weight Mode Backlight Color 
This setting allows users to configure the indicator’s backlight behavior during the 
weighing process. Setting the backlight color here controls the display color in the time 
between an item entering and existing the photoeye. 
1. From the User Menu (password 111), press … 

TiME is now displayed 

2. Press  until BAcKlt is displayed 
3. Press … 

Color is now displayed 
4. Press … 

The current choice is now displayed. 
5. Press  until NoNE is displayed and press … 

Color is now displayed 
6. Press  to return to normal operation… 

SAvE No is now displayed. 
7. Press  to scroll to SAvEYES and press  to save the changes. 
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8.1.4 Setpoints for the Grading App 
All Grading band settings are set up in the Supervisor Menu under the Grading Submenu 
or directly from the front panel by pressing the F1 key. In the Grading app all setpoints 
are programed to be outputs. This means the 1st 6 grading bands can be linked to 
individual light stacks that can be above the grading bin to help the operator know which 
bin the graded item needs to go in. 

8.1.5 Tare 
Super ↓ Setpoint → Tare 

When Preset Tare is enabled within the Admin Menu the 
operator can recall up to 10 pre-stored Tares by pressing the 
Tare key and entering in the preset tare number from 1 to 10. 
If Preset Tare is not enabled, skip to step 7. 

If it is enabled continue to the next step. 

1. From SETPNT, press  … 

TARE is now displayed. 

Use this to: 

 set values for up to 10 preset tares 
 print the values of the preset tares 
 reset all preset tares to factory defaults of 0 

The following steps describe the procedures. 

Tare Register 1-10 
Tare ↓ Edit ↓ Tare 1-10 
2. Press  … 

Edit is now displayed. 

3. Press  … 

tArE 1 is now displayed. This is the first of the 10 preset 
tare values you can set. 

4. Press  … 

The current value is displayed with a flashing right digit. 

 
Note: If the active unit of measure is lb-oz then tare weights must be entered in the oz 
equivalent. To enter 2 lb 4.5 oz you would need to enter 36.5 oz (2 lb = 32 oz plus the 
4.5) 

 
5. Press  to accept the displayed value or key in a new value and press 

to accept … 

tArE 1 is now displayed. 

6. Press  … 

tArE 2 is now displayed. 

7. Repeat steps 4 through 6 for tArE 2 through tArE 10. Press TARE when finished … 

Edit is now displayed. 
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Printing 
Tare ↓ Edit → Print 
Print: This allows users to choose which available 
connection port Print Commands are sent to: 
Port1, Port 2, or USB. A USB drive must be 
plugged into the USB port for any data to be 
Printed/Saved.   

8. Press  … 

Print is now displayed. Use this to print 
the preset tare values. 

9. Press  … 

Port 1 is now displayed. 

10. Press F1 to abort the print process or press  to scroll to the desired port and 
press  to print the information … 

Print is now displayed after either action. 

Reset 
Tare ↓ Edit → Print → Reset 
Reset: Use this to reset all the preset tares to the factory default of 0. 

11. Press  … 

rESEt is now displayed.  

12. Press  … 

no is now displayed. 

13. Press F1 to abort the reset or press 
 … 

YES is now displayed. 

14. Press  to reset the settings to factory defaults … 

rESEt is now displayed. 

15. Press  … 

TARE is now displayed. 
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8.2 Accumulation Supervisor Menu 
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8.2.1 Accumulation App Supervisor Menu Setup   
Super ↓ Setpoint → Tare → Accum 

Print Total: This allows users to print the Total Print Format by holding down the PRINT 
key. This prints an accumulated total for the day, shift, etc. rather than the current value 
of the current run. If enabled, during normal operation the technician or user can press 
and hold PRINT for three seconds and the selected total print format (see step 8 below) 
will be sent out any port that is set up to printed. 

Total Print Format: This allows users to choose a Print Format by entering the 
corresponding Print Format Number. To see a complete list of available Print Formats go 
to page 210.  

Clear Total: When enabled, this allows users to clear a Transaction at the end of an 
accumulation by pressing and holding the PRINT key. The Transaction Totals will be 
printed followed by clearing the Transaction Totals for that Accumulator Channel. The 
display will flash PRN-TOT. When disabled, the only way to clear a Transaction is 
through the Supervisor Menu by using the Clear Channel or Reset function.  

Clear Channel: This is used to clear the Transaction for just the selected Accumulator 
Channel. Enter the desired Accumulator Channel to clear and press the key.  
Print: This allows the supervisor to print all the Accumulator Channel Transaction Totals. 
Choose which available connection port to print the report is to be sent out of: Port1, Port 
2, or USB. A USB drive must be plugged into the USB port for any data to be 
Printed/Saved. 

Reset: This allows users to reset all the accumulator channel totals back to 0. 

1. With the indicator powered up and in normal operating mode, press and hold F1 …  
Pass is now displayed, prompting the technician or user to enter the 
password. 

2. Key in the Supervisor Password (1793) and press … 
SuPEr is now displayed. 

3. Press …  
SETPNT is now displayed. 

 

4. Press  until ACCUM is displayed. Use this to set the items relating to 
accumulation. Under ACCUM users can do the following: 

 Enable/Disable the ability to print the accumulated total (Prt TOT). 
 Key in a print format number for printing the total accumulated weight 

information (ToT FMt). 
 Enable/Disable the ability to clear the total accumulation information 

when the total is printed (clr TOT). 
 Clear a specific Accumulator Channel’s total (clr CH). 
 Print the accumulation report for all 200 memory channels (PriNt). 
 Reset all 200 accumulator memory channel values to 0 (RESEt). 

The following steps describe the procedure to set these items. 

Print Total 
Accum ↓ Print Total 
5. From ACCUM, press …  

Prt TOT is now displayed. 
6. Press …  

ON is now displayed. 
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7. Press  to keep the print total function disabled or press  or  to toggle to 
OFF and press  to enable printing of the accumulated total…  

Prt TOT is now displayed.  

Note: If the Print Return to Zero setting is on, after the PRINT key is pressed, the scale 
must return to inside the Gross Zero Band before the next Print Transaction can be 
initiated.  

 
Total Format 
Accum ↓ Print Total → Total Format 
8. Press …  

ToT FMt is now displayed. This stands for the total print format. 
9. Press …  

The current print format number is now displayed with a flashing right-most digit. 
(Default is format 8) 

10. Press  to accept the existing setting or key in a new print format number and 
press  to accept … 

ToT FMt is now displayed. 

Clear Total 
Accum ↓ Print Total → Total Format → Clear Total 
11. Press …  

clr TOT is now displayed. This stands for clear total. Choose “on” to enable 
clearing the accumulated total when the PRINT key is pressed and held. Choose 
OFF to disable this function. If enabled, the total is cleared if the user presses 
and holds the PRINT key for three seconds. The message CLEAREd will flash. If 
off, the Accumulator Totals can only be cleared from the Supervisor Menu by 
using Clear Channel or Reset functions. 

12. Press …  
The current setting is now displayed. 

13. Press  or  to toggle between the option and press  to make a choice…  
clr TOT is now displayed. 

Clear Channel 
Accum ↓ Print Total → Total Format → Clear Total → Clear Channel 
14. Press …  

clr CH is now displayed. 
15. Press …  

A numeric entry screen is displayed. 
16. Enter the Accumulator Channel number (1 to 200) and press … 

CLEAR is now displayed. 
17. Or Press to switch to AbORT to cancel clearing process.  
Print 
Accum ↓ Print Total → Total Format → Clear Total → Clear Channel 
→ Print 
18. Press …  

Print is now displayed. This stands for print the accumulation report. Choose a 
port to print the accumulated totals report for all 200 memory channels. 

19. Press …  
Port 1 is now displayed. 
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20. Press F1 to abort the print process or press  to scroll to the desired port and 
press  to print the information…  

Print is now displayed and the print data is sent to the printer connected to the 
selected port.  

Reset 
Accum ↓ Print Total → Total Format → Clear Total → Clear Channel 
→ Print → Reset 
21. Press …  

rESEt is now displayed. Use this to reset all the Accumulator Channels back to 
zero. 

22. Press …  
No is now displayed. With No displayed, press F1 to abort the reset. 

23. Press … 
Yes is now displayed 

24. Press  to clear all accumulator data stored in channels 1 to 200…  
rESEt is now displayed 

25. Press … 

Accum is now displayed 

26. This completes the Supervisor menu for the Accumulation application. Repeatedly 
press F1 until the indicator returns to normal weighing mode. The current weight 
value is displayed. 
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8.3 Truck In & Out App Supervisor Menu 
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8.3.1 Truck In & Out App Supervisor Menu Setup 
Super ↓ Setpoint → Tare → Truck 

Edit: This allows users to set up Fleet IDs with known Tare Weights, enter or delete 
Truck IDs, or edit the print format for Inbound, Outbound, and Fleet Reports 

Lite: This allows users to manage the Stop Light Functions. In the Threshold field, users 
can enter or edit the threshold weights for the backlight and stop light (outputs) to signal 
for trucks to Stop and Go. 

Print: This allows users to choose which of the three Truck In & Out Reports prints when 
prompted Truck-In Report, Truck-Out Report, or Fleet Report.  

Import: This allows for transfer of a Truck Scale Database File from a USB memory 
device inserted into the USB port of the indicator. 

Export: This allows for transfer of a CSV (Comma Separated Values) file containing the 
Truck Scale Database to a USB memory device inserted into the USB port of the 
indicator.  
Auto Gen: This allows the indicator to auto generate a Truck ID when the F1 key is 
pressed. 
Auto print: This allows the indicator to automatically print the Inbound or Outbound 
weight ticket once the weight becomes stable. This is on by default. When turned off, the 
operator MUST press the PRINT key to print and Inbound or Outbound ticket.  

RetZero: This forces the scale operator to remove the truck from the scale and the 
weight to return to zero before the next inbound or outbound truck ID / transaction can 
take place. 

IdAlPhA: Allows alphabetic character entry from the front panel of the indicator. 

Note: When a USB keyboard is attached to the ZM223 alphanumeric truck IDs can be 
entered without activating IdAlPhA. 

1. Press and hold F1 …  
PASS is now displayed. 

2. Key in the Supervisor Password (1793) and press … 
SuPEr is now displayed. 

3. Press …  

SETPNT is displayed.  

Edit 
Truck ↓ Edit 
Edit: This allows users to clear unnecessary Inbound/Outbound records, delete individual 
Outbound Records, create new or edit existing Fleet Truck IDs and their Tare Weights, or 
delete individual Fleet Truck Records. 
 
4. From SETPNT, press … 

TRUCK is now displayed.  

5. Press … 

Edit is now displayed.  

6. Press … 

IN is now displayed.  
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7. Use the  or  keys to scroll the choices (in, io, FLEEt and REPort). 
IN: Use this to clear an existing Inbound transaction that has not been closed by 
an Outbound transaction. 

IO: Use this to delete a Truck I/O record. 

FLEET: Use this to create, edit or delete a Fleet ID record. 

REPORT: Use this to print a reports showing all the inbound and out bound 
Truck IDs still active in the indicator  

8. Press the  to make a selection. 
 

Clear Inbound Records 
Truck ↓ Edit ↓ IN 
9. From IN, press  … 

A value entry screen is displayed. 

10. Key in the Truck ID and press the  key … 

CLEAR is displayed. 

11. Press  … 

No is displayed. 

12. Press  to toggle between YES and No.  
13. Press  when YES is displayed to clear the Inbound record … 

buSy is briefly displayed and then IN is displayed. 

14. Repeat from step 9 for any other inbound records you want to remove. 
 

Clear Outbound records 
Truck ↓ Edit ↓ IN → IO 
15. From IN, press … 

IO is now displayed  
16. Press  … 

A value entry screen is displayed. 

17. Key in the Truck ID and press the  key … 

dELEtE is displayed. 

18. Press  … 

No is displayed. 

19. Press  or  to toggle between YES and No.  
20. Press  when YES is displayed to delete the Outbound record. This will delete all 

transaction totals for the selected Truck ID … 

buSy is briefly displayed and then IO is displayed. 

21. Repeat from step 15 for any other outbound records you want to delete 
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Edit Fleet records 
Truck ↓ Edit ↓ IN → IO → Fleet 
22. From IO, press … 

FlEEt is now displayed  
23. Press … 

A value entry screen is displayed. 

24. Key in the Fleet Truck ID and press  … 

If this is an existing ID, FlEEt is briefly displayed then TArE.  

If this is a new ID, NOT FNd (not found) is briefly displayed followed by AddING, 
followed by TArE. 

If the ID entered is already an inbound or outbound number, the display will say 
CANt. In this case that Inbound or Outbound Number needs to be canceled, or a 
different Fleet Number must be used. With ArE displayed you can either edit the 
Fleet Tare weight or enter a Fleet ID.  

25. With TArE displayed, press   … 

dELEtE is displayed. 

26. Press … 

No is now displayed. 

27. Press … 

YES is now displayed. 

28.  To delete the Fleet ID. To edit a Fleet Tare weight, press  … 

buSy is briefly displayed, followed by FlEET. 

29. With TArE displayed you can either edit the current Fleet Tare weight, abort, or store 
a new live weight of the empty Fleet Truck on the scale.  

 
Viewing a Fleet Tare Weight:  
30. With the scale at Zero and from TArE, press  … 

The current Tare Value is displayed. If you do not need to change the Tare 
Value, Press F1 to abort. 
 

Editing a Fleet Tare Weight:  
31. With the scale at Zero and from tArE, press   … 

The current Tare Value is displayed. 
32. Key in the Tare Value and press  … 

TArE is now displayed. 
 

Saving a New Fleet Tare Weight Using a Live Weight:  
33. With the empty Fleet truck on the scale and from TArE, press  … 

The indicator will now grab the live weight of the truck that is on the scale to use 
at this Tare Weight for this Fleet ID. 

34. Press  to save the new Fleet Tare Weight… 
TArE is now displayed. 
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Note: If the Tare value is not greater that the Gross Zero Band, the ID will not be saved. 

 
New Fleet Truck ID 

If the weight on the scale is below the Gross Zero Band (GZB) then 0 is displayed. Use 
numeric entry to manually enter the Fleet truck tare weight. 

Otherwise the Saved live weight is displayed. Press  to store this value or use 
numeric entry to manually enter the Fleet truck tare value. 

Existing Fleet Truck ID 

If the weight on the scale is below the GZB the PT announcer is illuminated and the 
stored Fleet tare weight is displayed. Use the numeric entry prompt to change or press 

 to continue to use this as the Fleet truck tare value. 

Otherwise, the Saved live weight is displayed. Press  to store the live weight or use 
numeric entry to manually enter the Fleet truck tare value. After pressing  to save 
the value, tArE is displayed. 

35. To add more Fleet ID's press the  key to return to step 22. 
Delete Fleet ID 

36. From FlEEt, press … 
A numeric entry screen is now displayed. 

37. Enter the Fleet ID and press … 
TArE is now displayed. 

38. Press  … 
dELEtE is displayed. 

39. Press … 

No is displayed.  

40. Press  or  to toggle between YES and No.  

41. Press  to select an option… 

If you choose no, the ID is not deleted, and the display shows dELEtE. 

If you choose YES, buSy is briefly displayed, the ID is deleted and FLEEt is 
displayed. To delete more Fleet IDs return to step 36 or press  to return to 
normal operation. 

Editing Report Formats 
Truck ↓ Edit ↓ IN → IO → Fleet → Report 
42. From FlEEt press  … 

REPort is displayed. This menu item lets you assign a print format number to the 
various print tickets and reports. The choices are Inbound Report (INFmt), 
Outbound Report (OutFmt), and Fleet Report FLEFmt. Each one has a separate 
print format assigned for the Ticket Transaction, the Header, the Body and the 
Footer. 

43. Press … 

INFMt is now displayed. 
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Under INFMt are these items: 

IN TicK: This defines which print format is used during the Inbound ticket 
transaction. 

IN HEAd: This defines which print format is used for the header or top of the 
Inbound report. 

In body: This defines which print format is used for the body of the Inbound 
report 

In Foot: This defines which print format is used for the footer or bottom of each 
Inbound report. 

Under OutFMt, there are the same items except the prefix is changed to Out: 
Out TicK, Out HEAd, Outbody, OutFoot 
Under FltFMt, there are the same items except the prefix is changed to Flt: 
FltTicK, FltHEAd, Fltbody and FltFoot. 
 
Report Print Formats 
For example, the Ticket transaction might print the Truck ID, the time/date, and 
associated weight values for the type of transaction. 

The Header might print the scale owner’s company name, address and time/date 
of the report and appropriate labels to align with the information contained in the 
Body of the report. 

The Body would print the Truck ID and associated weights and times (Inbound 
only). The Body print format performs automatic “loop” printing of the data 
contained in the print format. The “loop” is controlled by the Truck In, Truck Out 
and Fleet ID’s print tokens and will continue to repeat the print format for all ID’s 
that are stored in their respective areas of the database. 

The Footer might only print “End of xxxxx Report” or just send a form feed 
character for proper paper advance upon completion. 

Report Printing Structure 
When a report is printed, all 3 associated print formats, Header, Body and 
Footer, are automatically sent to the assigned or binded port. Proper editing of 
these print formats using the internal Editor or the PC software application tool 
may be necessary for specific application requirements. 

Editing of a print format requires access to a password protected menu and will 
not be covered in this manual. 
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Default Report Print Format Numbers 
 

Report Ticket Header Body Footer 

Inbound 48 49 50 51 

Outbound 52 53 54 55 

Fleet 56 57 58 59 

 
44. From REPort, press  … 

Edit is displayed. 

Lite Menu 
Truck ↓ Edit →  Lite 
Lite: This allows users to configure setpoint 1 & 2 to control an external traffic light, 
device based on GTN operations, or the indicator’s backlight conditions. This can be 
likened directly to the RPN/Lite function to change the backlight and output. 

 Press 1 and the RPN/Lite key will turn on output 1 (and switch the back light 
Green)  

 Press 2 and the RPN/Lite key will turn on output 2 (and switch the back light 
Red) 

45. From Edit, press … 

LitE is displayed.  

 
Note: Outputs #1 and #2 must be enabled for the set point controls to function properly. 

 
 

46. Press … 

EnAbLE is displayed. Choose from these three options under enable: 

Manual: BOTH the set point outputs #1 & #2 and the serial commands for the 
XR4500TL are controlled by the RPN light function. 

Auto: This can work with the weight threshold to turn the backlight to red once 
the weight threshold is reached. 

BOTH the set point outputs #1 & #2 and the serial commands for the XR4500TL 
are controlled as follows:  

 Set point #1 is active for green light when scale is considered at ZERO 
while inside gross zero band, or when the PRINT key has been 
processed. (Scale Configuration Parameter) 

 Set point #2 is active for red light when gross weight is above the 
threshold value. 

 Set point #3 is available for standard configuration (cutoff) as long as 
the battery saver feature is not used. 

OFF: Set point controls are controlled by standard configuration settings (cutoffs) 
and ONLY the XR4500TL works when the RPN light function is enabled. 
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47. From EnAbLE press the  key … 

T-Hold is displayed. This stands for Threshold. Use this to configure the weight 
value that must be exceeded for the light control to activate the red light (set 
point #2) when configured for the AUTO mode of operation 

48. From T-Hold press  … 
LitE is now displayed. 

Print Menu 
Truck ↓ Edit → Lite → Print 
49. From LitE, press  … 

Print is displayed. This menu item allows users to print the transaction reports.  

IN RPt: Prints the report of all the Trucks that have recorded an Inbound 
transaction but have yet to complete the Outbound transaction.  

OUT RPt: Prints the report of all the Truck ID’s and associated totals that 
have completed an Outbound transaction.  

FLT RPt: Prints the report of all the Fleet Truck ID’s and tare weights 
and associated totals.  

50. To exit the reports level, press  … 

PriNt is displayed. 

Reprinting Tickets 
Truck ↓ Edit → Lite → Print 
To reprint any other tickets, follow the following steps: 

51. Press and hold the F1 key 
52. Key in the Supervisor Menu password (1793) … 

SuPEr is now displayed. 

53. Press … 

Setpnt is now displayed 

54. Press … 

Truck is displayed. 

55. Press  … 

Edit is now displayed 

56. Press until Print is displayed. 
57. Press  … 

In rPt is now displayed 

58. Use the  or  keys to scroll through the other three choices. When your choice 
is displayed, press  to print the report. Below are explanations for each report: 

in rPt: Prints the report of all the Trucks that have recorded an Inbound 
transaction but have yet to complete the Outbound transaction. Individual 
or all Inbound records can be cleared in the Supervisor menu. 

out rPt: Prints the report of all the Truck ID’s and associated totals that 
have completed an Outbound transaction. Individual or all Outbound 
records can be deleted in the Supervisor menu. 
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FLt rPt: Prints the report of all the Fleet Truck ID’s and tare weights and 
associated totals. Individual or all Fleet records can be deleted in the 
Supervisor menu. 

Import 
Truck ↓ Edit →  Lite →  Print →  Import 
The Import menu allows for transfer of a Truck Scale database file from a USB memory 
device when inserted into the USB port of the indicator. 

For a typical truck scale operation the only reasons to import a database would be to: 

 Add Fleet Truck ID’s and Tare weight records into the scale without having to 
use the EDIT menu 

 Edit existing totals to correct errors or missing weighments such as failure to 
record an Outbound transaction or using an incorrect Truck ID. 

To successfully Import the truck scale database into the indicator the file must be in the 
proper CSV (comma separated value) format. To insure that the CSV file format is 
acceptable, the following procedure is recommended. Perform an In/Out transaction, and 
if the operation uses Fleet trucks, add at least one Fleet Truck ID/Tare weight in the EDIT 
menu. Then EXPORT the database file to the USB thumbdrive. The database file will 
show the required data fields that must be maintained.  

Open the file using Excel and copy and paste a row containing the entered Truck values 
into the number of rows necessary. Edit the pasted rows with the required data and be 
sure to put 0’s into unused columns.  

Save the file on the thumbdrive and IMPORT back to the indicator to update the Truck 
database 

 
Note: The USB thumbdrive must be installed before accessing the Import or Export 
menus. 

 
59. From PriNt, press … 

IMPort is now displayed. 

 
Note: The database can contain up to 10000 separate truck records. Importing a 
database file will overwrite all existing Truck records stored in the indicator. This 
database file includes all Truck In/Out and Fleet ID’s, open Inbound transactions with 
time, date and weight, and Gross, Net, Tare, and Transaction Count totals for completed 
In/Out and Fleet transactions. 

 
60. With IMPort displayed, press … 

buSy and doNE are briefly displayed as the database file is imported. 
IMPort will be displayed when finished. 
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Export 
Truck ↓ Edit →  Lite →  Print →  Import →  Export 
The Export menu allows for transfer of a CSV (Comma Separated Values) file containing 
the Truck Scale database to a USB memory device when inserted into the USB port of 
the indicator. 

61. From IMPort, press  … 

EXPort is displayed.  

62. Press  … 

buSy and doNE are briefly displayed as the database file is exported. 
EXPort is displayed when finished. 

Below is a sample of a CSV file structure: 
 

truckid tareFleet weight1 weight1date weight1time grossTotal netTotal tareTotal transCount units 
111 0 0   300000 200000 100000 10 lb 
222 0 0   800000 400000 400000 20 lb 
123 12300 0   1500000 1000000 500000 30 lb 
456 14550 0   39550 25000 14550 1 lb 
1 11240 0   62480 40000 22480 2 lb 
5 0 16210 2/3/2025 4:51:00 0 0 0 0 lb 

 
Reset 
Truck ↓ Edit → Lite → Print → Import →  Export →  Reset 

63. From EXPort, press  … 
rESET is now displayed. 

64. Press  … 

IN is displayed. 

65. Use  or  to scroll through the choices: IN, IO, FLEET or ALL. With the 
type of record you want to clear or delete displayed, press  … 

No is displayed. 

66. Press  to select YES. 
67. Press  to clear the record … 

The display will show buSy and then return to IN, IO, FLEET or ALL 
depending on which menu item was selected. 

 
Note: Resetting the IN records will clear all stored Inbound records that have not yet 
completed an Outbound transaction. 
Resetting the OUT records will delete all stored Truck I/O ID’s and associated Totals. 
Reset the FLEET records will delete all stored Fleet Truck ID’s, Tare weights and 
associated Totals. 
Deleting ALL will delete all the above Truck records from the database. 

 
68. Repeatedly press  to exit back to normal operation 
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8.4 Counting App Supervisor Menu 
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8.4.1 Counting App Supervisor Menu Setup   
Super ↓ Setpoint → Tare → Count 

Mode: This controls if the indicator uses Bulk or Dribble sampling.  

Bulk: In bulk sampling the user enters the specified number of items on the scale 
all at once (in bulk) and the scale automatically starts to calculate piece weight 
when the weight stabilizes. The count is then displayed. 

Dribble: In dribble sampling method users place the specified number of items 
onto the scale and ready, press the F1/SAMPLE key and the scale calculates 
piece weight and then shows the count. 

Accum: This allows the indicator to accumulate multiple Count Totals together. Each 
time the user presses the PRINT key the Printed Count Quantity is added to the 
Accumulated Count Total. To print the Accumulated Print Totals press and hold the 
PRINT key. 
Min Sample Size: This controls the minimum sample size required when sampling. 5 is 
the default minimum sample size. 

Check: This controls the Checkcounting feature. When off, the bar graph annunciator 
features will not work.   

When enabled, the top check weight bar graph will turn on and work off of the set count 
quantity. If the count quantity is in the accept window the middle ACCEPT annunciator 
will light up and the back light display will turn GREEN. If the count is under the ACCEPT 
quantity window the left side UNDER annunciator will light up and the backlight will turn 
to RED. If over the right-side bar graph will light up and the backlight will turn ORANGE.  

In General Checkcounting the Low and High Limits must be set to control the Accept 
Count Window.  If the accept quantity needed to pack is just 100 parts the Low Limit and 
High Limit needs to be set to 100 making it so only a count of 100 parts will activate the 
ACCEPT bar graph segment.   

Under Seg Div: This controls the value each segment of Under bar graph 
annunciator represents. When set to 10 parts, each Under bar graph annunciator 
segment represents 10 parts. 

Over Seg Div: This controls the value each segment of Over bar graph 
annunciator represents. When set to 10 parts, each Over bar graph annunciator 
segment represents 10 parts.   

Low Limit: This controls the Low Quantity limit.  

High Limit: This controls the High Quantity limit. 

Backlight Mode: This controls the behavior of the display’s backlight color in relation to 
the checkweighing settings Near Zero, Under, Accept, Over. 

Near Zero: This controls the Near Zero backlight color (Default is Yellow).  

Under: This controls the Under backlight color (Default is Red)  

Accept: This controls the Accept backlight color (Default is Green) 

Over: This controls the Over backlight color (Default is Orange) 

Print Total: Enables or disables the ability to print totals. Totals are printed automatically 
at the end of a packrun or at any time by pressing and holding the PRINT key. 

Total Print Format: This allows users to choose a Print Format by entering the 
corresponding Print Format Number. To see a complete list of available Print Formats go 
to page 210. 
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Clear Total: When enabled, this allows users to clear a Transaction at the end of an 
accumulation by pressing and holding the PRINT key. The Transaction Total will be 
printed followed by clearing the Transaction Total for that Accumulator Channel. The 
display will flash PRN-TOT. When disabled, the only way to clear a Transaction is 
through the Supervisor Menu by using the Reset function. 

Print: This allows users to choose which available connection port Print commands are 
sent to: Port1, Port 2, or USB. A USB drive must be plugged into the USB port for any 
data to be Printed/Saved.   

Reset: This allows technicians to reset all counts to 0. 

1. With the indicator powered up and in normal operating mode, press and hold F1 
…  

Pass is now displayed, prompting the user to enter the password. 
2. Key in the Supervisor Password (1793) and press … 

SuPEr is now displayed. 
3. Press …  

SETPNT is now displayed. 
4. Press  until…  

COUNT is now displayed. Use this to set the items relating to counting: 

 Select between dribble and bulk mode (dribblE and bulK).  
 Accum (AccuM).  
 Min Sample Size (MiNSAMP).  
 Check (ChEcK).  
 Enable/Disable the ability to print the count total (Prt TOT).  
 Key in a print format number for printing the total count information 

(ToT FMt).  
 Enable/Disable the ability to clear the total count information when 

the total is printed (clr TOT). The following steps describe the 
procedure to set these items. 

Mode 
Count ↓ Mode 

5. Press …  
ModE is now displayed. There are two modes for sampling: buLK and 
dribbLE. 

6. With ModE displayed, press …  
dribblE is now displayed. 

7. Press  or  to toggle between the options and press  to make a 
selection…  

ModE is now displayed. 
Accum 
Count ↓ Mode  → Accum 

8. Press …  

AccuM is now displayed. 
9. Press …  

OFF is now displayed. 
10. To turn on the Accumulation function, press … 

ON is now displayed.  

11. Press … 

AccuM is now displayed. 
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Minimum Sample Size 
Count ↓ Mode  → Accum → Minimum Sample Size  

12. Press …  

MiNSAMP is now displayed 
13. Press …  

5 is now displayed. 

14. To change the minimum sample size, key in a new value 
15. Press … 

MiNSAMP is now displayed. 
Checkcounting 
Count ↓ Mode  → Accum → Minimum Sample Size  → Checkcounting 

16. Press …  

ChEck is now displayed. 
17. Press …  

ON/OFF is now displayed 
18. Press …  

OFF is now displayed. 

19. Use  or  to toggle to ON and press  to activate Checkcounting 
mode. 

ON/OFF is now displayed. 
20. Press  … 

Low LiM is now displayed 

21. Press …  
100 is now displayed. 

22. To change the Low Limit, key in a new value and press … 
Low LiM is now displayed 

23. Press  … 
Hi LiM is now displayed. 

24. Press …  
100 is now displayed. 

25. To change the High Limit, key in a new value and press … 
Hi LiM is now displayed 

26. Press  … 
U-SEG is now displayed. This stands for Under Segment Division. 

27. Press …  
10 is now displayed. 

28. To change the Under Segment Division, key in a new value and press … 
U-SEG is now displayed 

29. Press  … 
O-SEG is now displayed. This stands for Over Segment Division. 

30. Press …  
10 is now displayed. 

31. To change the Over Segment Division, key in a new value and press … 
O-SEG (Segment Division) is now displayed. 
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32. Press  … 
bcKModE is now displayed 

33. Press …  
NEAr ZEr is now displayed 

34. Press …  
yEllow is now displayed 

35. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

NEAr ZEr is now displayed 
36. Press  … 

UNdEr is now displayed 

37. Press …  
REd is now displayed 

38. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

UNdEr is now displayed 
39. Press  … 

AccEPt is now displayed 

40. Press …  
GrEEN is now displayed 

41. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

AccEPt is now displayed 
42. Press  … 

OvEr is now displayed 

43. Press …  
OrANgE is now displayed 

44. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

OvEr is now displayed 
45. Press F1 until ChEck is displayed 

Print Total 
Count ↓ Mode  → Accum → Minimum Sample Size  → Checkcounting  → 
Print Total 

46. Press …  
Prt TOT is now displayed. This stands for print total. 

47. Press …  
ON or OFF is now displayed. Default is ON. 

48. Press  when ON is displayed to enable printing of the count total press  
or  to toggle to OFF and press  to keep the print total function 
disabled…  

Prt TOT is now displayed.  
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Total Format 
Count ↓ Mode  → Accum → Minimum Sample Size  → Checkcounting  → 
Print Total → Total Format 

49. Press …  
ToT FMt is now displayed. This stands for the total print format. 

50. Press …  
The current print format number is now displayed with a flashing right-
most digit.  

51. Press  to accept the existing setting or key in a new print format number and 
press  to accept …  

ToT FMt is now displayed. 
Clear Total 
Count ↓ Mode  → Accum → Minimum Sample Size  → Checkcounting  → 
Print Total → Total Format → Clear Total 

52. Press …  
clr TOT is now displayed. The message cLr-tot will flash. The total is 
printed prior to clearing if this was enabled in step 8 above. 

53. Press …  
The current setting is now displayed. 

54. Press  or  to toggle between ON and OFF and press  to make a 
selection…  

clr TOT is now displayed. 
Print 
Count ↓ Mode  → Accum → Minimum Sample Size  → Checkcounting  → 
Print Total → Total Format → Clear Total → Print 

55. Press …  
Print is now displayed. This stands for “print the count totals report.” 
Choose a port to print the count totals report. 

56. Press …  
Port 1 is now displayed. 

57. Press F1 to abort the print process or press  to scroll to the desired port and 
press  to print the information…  

Print is now displayed after either action. 
Reset 
Count ↓ Mode  → Accum → Minimum Sample Size  → Checkcounting  → 
Print Total → Total Format → Clear Total → Print → Reset 

58. Press …  
rESEt is now displayed. Use this to reset all the items under count to the 
factory defaults. 

59. Press …  
no is now displayed. 

60. Press  to abort the reset or press …  
YES is now displayed. 

61. Press  to reset the settings to factory defaults…  
rESEt is now displayed. 
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8.5 Checkweighing Simple-Level App Supervisor Menu 
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8.5.1 Checkweighing Simple-Level Supervisor Menu Setup   
Super ↓ Setpoint → Tare → Check 

Outputs: This controls the behavior of the relay controlling any peripheral device 
connected to the ZM223.   

Unlatch: This means that the relay and annunciator will change instantly as the 
weight swings above and below the output value.  

Latch: This means that weights will have to stabilize at or above the output value 
before the relay or annunciator changes. 

Under Seg Div: This controls the value each segment of Under bar graph annunciator 
represents. When set to 0.05 lbs, each Under bar graph annunciator segment represents 
0.05 lbs.   

Over Seg Div: This controls the value each segment of Over bar graph annunciator 
represents. When set to 0.05 lbs, each Over bar graph annunciator segment represents 
0.05 lbs.   

Back Light Mode: This allows users to select the Back Light Color for the Near Zero, 
Under, Accept, and Over settings.  

Reset: This allows users to reset application specific settings to default settings. 

1. With the indicator powered up and in normal operating mode, press and hold F1 
…  

Pass is now displayed, prompting the user to enter the password. 
2. Key in the Supervisor Password (1793) and press … 

SuPEr is now displayed. 
3. Press …  

SETPNT is now displayed. 
4. Press  until…  

CHECK is now displayed 

Outputs 
Check ↓ Outputs  

5. From chEcK, press …  
outPutS is displayed. There are two choices for outputs, LAtch and 
unLAtch (default).  

6. Press …  
The current choice is displayed.  

7. Press  or  to toggle between the choices and press  to select an 
option… 

outPutS is displayed. 

Under Segment Divisions 
Check ↓ Outputs → Under divisions 

8. From outPutS press …  
USEGdIV is now displayed.  

9. Press …  
The current value is shown with a flashing right-most digit. 

10. Press  to accept the current value or key in a new value and press  to 
accept…  

USEGdIV is now displayed. 
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Over Segment Divisions 
Check ↓ Outputs → Under divisions → Over divisions 

11. From USEGdiv press …  
OSEGdIV is now displayed. 

12. Press …  
The current value is shown with a flashing right-most digit. 

13. Press  to accept the current value or key in a new value and press  to 
accept…  

OSEGdIV is now displayed. 

Backlight Mode 
Check ↓ Outputs → Under divisions → Over divisions → Backlight Mode 

14. From OSEGdIV, press … 
bcKModE is now displayed 

15. Press …  
NEAr ZEr is now displayed 

16. Press …  
yEllow is now displayed 

17. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

NEAr ZEr is now displayed 
18. Press … 

UNdEr is now displayed 

19. Press …  
REd is now displayed 

20. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

UNdEr is now displayed 
21. Press … 

AccEPt is now displayed 

22. Press …  
GrEEN is now displayed 

23. To change the Backlight Color, use   or  to toggle through the options 
and press  to make a selection… 

AccEPt is now displayed 
24. Press … 

OvEr is now displayed 

25. Press …  
OrANgE is now displayed 

26. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

OvEr is now displayed 
27. Press … 

bcKModE is displayed 
 
 
 



 

Page 162 of 224 
 

Reset 
Check ↓ Outputs → Under divisions → Over divisions → Backlight Mode 
→ Reset 

28. From bcKModE, press …  
RESEt is now displayed. Use this to reset the all the checkweigher 
variables to the factory defaults. 

29. Press …  
No is now displayed. 

30. Press F1 to abort the reset or press …  
YES is now displayed. 

31. Press  to reset the settings to factory defaults…   
buSy is briefly displayed, then RESEt is now displayed.  

32. Press …  
CHECK is now displayed. 
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8.6 Checkweighing Mid App Supervisor Menu 
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8.6.1 Checkweighing Mid Supervisor Menu Setup 
Outputs: This controls the behavior of the relay controlling any peripheral device 
connected to the ZM223.   

Unlatch: This means that the relay and annunciator will change instantly as the 
weight swings above and below the output value.  

Latch: This means that weights will have to stabilize at or above the output value 
before the relay or annunciator changes. 

Under Seg Div: This controls the value each segment of Under bar graph annunciator 
represents. When set to 0.05 lbs, each Under bar graph annunciator segment represents 
0.05 lbs.   

Over Seg Div: This controls the value each segment of Over bar graph annunciator 
represents. When set to 0.05 lbs, each Over bar graph annunciator segment represents 
0.05 lbs.   

Print Total: Enables or disables the ability to print totals. Totals are printed automatically 
at the end of a packrun or at any time by pressing and holding the PRINT key.  

Total Print Format: This allows users to choose a Print Format by entering the 
corresponding Print Format Number. To see a complete list of available Print Formats go 
to page 210. 

Clear Total: When enabled, this allows users to clear a Transaction at the end of an 
accumulation by pressing and holding the PRINT key. The Transaction Totals will be 
printed followed by clearing the Transaction Totals for that Accumulator Channel. The 
display will flash PRN-TOT. When disabled, the only way to clear a Transaction is 
through the Supervisor Menu by using the Reset function. 

Digits: This controls if the indicator’s display digits are on or off. When off, the display will 
only change color to signal under, over, or at target.  

Graph: This controls if the indicator’s display bar graph is on or off. If turned off, it also 
disables the backlight from changing with outputs.   

Stats: This controls which statistical model the application uses to generate graphs. The 
ZM223 supports Standard Deviation and X-Bar/R Charts.  
Type: This controls how checkweighing targets are captures. The options are SAMPLE 
(default) to LIMITS. Sample means the Target Weight, and High and Low Accept 
Windows are acquired by using a sample weight. Limits means the user enters upper and 
lower weight limits to establish the acceptable weight range. 

A-Tare: This controls if the Automatic Tare function is on or off.  This is mainly used  
when negative checkweighing. 

BckMode: This allows users to select the Back Light Color for the Near Zero, Under, 
Accept, and Over settings.  

Reset: This allows users to reset application specific settings to default settings. 

1. With the indicator powered up and in normal operating mode, press and hold F1 
…  

Pass is now displayed, prompting the technician or user to enter the 
password. 

2. Key in the Supervisor Password (1793) and press … 
SuPEr is now displayed. 
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3. Press  until…  
CHECK is now displayed. This stands for checkweigher. Use this to set 
the items relating to checkweighing: 
 Set under divisions for acceptable target weight (USEGdIV)  
 Set over divisions for acceptable target weight (OSEGdIV)  
 Turns on print total (Prt TOT)  
 Selects print total format (ToT FMt)  
 Turns on clear total (CLR TOT)  
 Turns off Weight digits (digitS)  
 Turns off bar graph (GrAPh)  
 Turns on Stats (STATS)  
 Select the type of checkweighing window (TYPE)  
 Turns on Auto Tare (A-TARE)  
 Changes the backlight colors used in Under, Over, and Accept 

(bcKModE)  
 Reset the target values to zero (RESEt) 

Outputs - Latch & Unlatch 
Check ↓ Outputs ↓ Latch & Unlatch 

4. From CHECK press …  
OUTPUTS is now displayed.  

5. Press …  
UNLATCH is now displayed. 

6. Press  or  to toggle between the options (LATCH and UNLATCH) and 
press  select an option…  

OUTPUTS is now displayed. 

 
Note:  If the checkweigh mode is currently using the LO and HI limit values, viewing or 
entering the Under or Over division settings will change these Limit values accordingly. 

 
Under Segment Divisions 
Check ↓ Outputs → Under Divisions 

7. From OUTPUTS press …  
USEdIV is now displayed. 

8. Press  …  
The current value is shown with a flashing right-most digit. 

9. Press  to accept the current value or key in a new value and press  to 
accept…  

USEdIV is now displayed. 

Over Segment Divisions 
Check ↓ Outputs → Under divisions → Over Divisions 

10. From USEdIV press …  
OSEGdIV is now displayed. 

11. Press …  
The current value is shown with a flashing right-most digit. 

12. Press  to accept the current value or key in a new value and press  to 
accept…  

OSEGdIV is now displayed. 
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Print Total  
Check ↓ Outputs → Under divisions → Over divisions → Print Total 

13. From OSEGdIV press …  
Prt TOT is now displayed. Use this to enable/disable printing of the Total 
report. Choose ON (default) to enable and OFF to disable this function.  

14. Press …  
The current choice is displayed. 

15. Press  or  to toggle between the choices and when your choice is 
displayed, press to accept…  

Prt TOT is displayed. 

Total Format 
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total 
Format 
To print the Total Format for the ZM223 Mid-Level Checkweighing application you must 
either perform a reset shown below (see page 168), which sets the Total format to 9 or 
manually key in 9 under the Total Format menu item. 

17. From Prt TOT Press …  
ToT FMt is now displayed. Use this to choose a print format for the Total 
report.  

18. Press …  
The current print format number is displayed.  

19. Press  to accept this or key in a new print format number and press  to 
accept…  

ToT FMt is displayed.  
Clear Total  
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total 
Format  → Clear Total  

20. From ToT FMt Press  …  
CLR TOT is displayed. Use this to enable or disable the clearing of the 
transaction counter. Choose ON (default) to enable and OFF to disable 
the clearing of the transaction counter.  

21. Press …  
The current choice is displayed.  

22. Press  or  to toggle between the choices and press  to select an 
option… 

CLR TOT is displayed.  
Digits  
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total 
Format  → Clear Total →  Digits  

23. From CLR TOT press …  
digitS is now displayed. Use this to enable or disable the clearing of 
the transaction counter. Choose ON (default) to enable and OFF to 
disable the clearing of the transaction counter. 

24. Press …  
The current choice is displayed. 

25. Press  or  to toggle between the choices and press  to select an 
option… 

digitS is displayed. 
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Graph  
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total 
Format  → Clear Total →  Digits  → Graph 

26. From digitS press …  
GrAPh is displayed. Use this to enable or disable the clearing of the 
transaction counter. Choose ON (default) to enable and OFF to 
disable the clearing of the transaction counter. 

27. Press …  
The current choice is displayed. 

28. Press  or  to toggle between the choices and press  to select an 
option… 

GrAPh is displayed. 
Stats 
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total 
Format  → Clear Total →  Digits  → Graph → Stats 

29. From GrAPh, bress …  
STATS is now displayed. 

30. Press …  
OFF is now displayed.  

31. Use  or  to toggle between the choices (OFF, Std dEV, X-bAR) and 
press  to select an option… 

STATS is now displayed. 
Type  
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total 
Format  → Clear Total →  Digits  → Graph → Stats → Packrun → Type  

32. From STATS press …  
TYPE is now displayed. Use this to choose which type of 
checkweighing you want to do: SAMPLE or LIMITS. Select SAMPLE 
mode (default) if you want to enter a target weight by placing a 
sample on the scale and pressing the TARGET key. The upper 
tolerance is automatically set to +1 division and the lower tolerance is 
automatically set to -1 division. The Tol Hi and Tol Low work from 
this target point. Select LiMitS mode to enter an upper and lower limit 
which defines the acceptable weight range.  

33. Press …  
The current choice is displayed.  

34. Press  or  to toggle between the choices and press  to select an 
option… 

TYPE is displayed. 
Auto Tare  
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total 
Format  → Clear Total →  Digits  → Graph → Stats → Type → Auto Tare  

35. From TYPE press  …  
A-TARE is displayed. Use this to disable or enable (OFF (default) or 
on) an auto tare when the target weight is reached. This allows you to 
add items to a box or pallet and auto-tare the weight of each item if it 
falls in the target range.  

36. Press …  
The current choice is displayed.  
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37. Press  or  to toggle between the choices and press  to select an 
option… 

A-tArE is displayed. 
Backlight Mode 
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total 
Format  → Clear Total →  Digits  → Graph → Stats → Type → Auto Tare  → Backlight 
Mode 

38. From A-TARE, press  … 
bcKModE is now displayed 

39. Press …  
NEAr ZEr is now displayed 

40. Press …  
yEllow is now displayed 

41. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

NEAr ZEr is now displayed 
42. Press  … 

UNdEr is now displayed 

43. Press …  
REd is now displayed 

44. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

UNdEr is now displayed 
45. Press  … 

AccEPt is now displayed 

46. Press …  
GrEEN is now displayed 

47. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

AccEPt is now displayed 
48. Press  … 

OvEr is now displayed 

49. Press …  
OrANgE is now displayed 

50. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

OvEr is now displayed 
51. Press  until bcKModE is displayed. 
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Reset  
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total 
Format  → Clear Total →  Digits  → Graph → Stats → Type → Auto Tare  → Backlight 
Mode → Reset  

52. From A-TARE press …  
RESEt is displayed. Use this to reset the factory defaults for the 
checkweighing parameters.  

53. Press …  
No is displayed.   

54. Press  to abort the reset or, to reset the defaults, press UNITS…  
YES is displayed. Accepting this will reset the defaults.  

55. Press  to accept…  
RESEt is now displayed.  
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8.7 Checkweighing Adv App Supervisor Menu 
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8.7.1 Checkweighing Advanced-Level Supervisor Menu 
Setup   

Super ↓ Setpoint → Tare → Check 
Outputs: This controls the behavior of the relay controlling any peripheral device 
connected to the ZM223.   

Unlatch: This means that the relay and annunciator will change instantly as the 
weight swings above and below the output value.  

Latch: This means that weights will have to stabilize at or above the output value 
before the relay or annunciator changes. 

Under Seg Div: This controls the value each segment of Under bar graph annunciator 
represents. When set to 0.05 lbs, each Under bar graph annunciator segment represents 
0.05 lbs.   

Over Seg Div: This controls the value each segment of Over bar graph annunciator 
represents. When set to 0.05 lbs, each Over bar graph annunciator segment represents 
0.05 lbs.   

Print Total: Enables or disables the ability to print totals. Totals are printed automatically 
at the end of a packrun or at any time by pressing and holding the PRINT key. 

Total Print Format: This allows users to choose a Print Format by entering the 
corresponding Print Format Number. To see a complete list of available Print Formats go 
to page 210. 

Clear Total: When enabled, this allows users to clear a Transaction at the end of an 
accumulation by pressing and holding the PRINT key. The Transaction Totals will be 
printed followed by clearing the Transaction Totals for that Accumulator Channel. The 
display will flash PRN-TOT. When disabled, the only way to clear a Transaction is 
through the Supervisor Menu by using the Reset function. 

Digits: This controls if the indicator’s display digits are on or off. When off, the display will 
only change color to signal under, over, or at target.  

Graph: This controls if the indicator’s display bar graph is on or off. If turned off, it also 
disables the backlight from changing with outputs.   

Stats: This controls the statistical model the application uses to provide summary data. 
The ZM223 supports Standard Deviation and X-Bar/R Charts.  

Packrun: Set the number of pieces that must be weighed to make up a complete 
packrun. This also sets the quantity needed for Standard Deviation and X bar/R 
functionality. 
Type: This controls how the indicator acquires the Target Weight. Choose between 
SAMPLE or LIMITS. 
A-tare: This controls if the Automatic Tare function is on or off.  

Back Light Mode: This allows users to select the Back Light Color for the Near Zero, 
Under, Accept, and Over settings.  

Reset: This allows users to reset application specific settings to default settings. 

1. With the indicator powered up and in normal operating mode, press and hold F1 
…  

PASS is now displayed, prompting the user to enter the password. 
2. Key in the Supervisor Password (1793) and press … 

SuPEr is now displayed. 
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3. Press …  
SETPNT is now displayed. 

4. Press  until…  
CHECK is now displayed. This stands for checkweigher. Use this to set 
the items relating to checkweighing: 
 Set under divisions for acceptable target weight (USEGdIV)  
 Set over divisions for acceptable target weight (OSEGdIV)  
 Turns on print total (Prt TOT)  
 Selects print total format (ToT FMt)  
 Turns on clear total (CLR TOT)  
 Turns off Weight digits (digitS)  
 Turns off bar graph (GrAPh)  
 Turns on Stats (STATS)  
 Select the type of checkweighing window (TYPE)  
 Set Packrun quantities (PACKRUN)  
 Turns on Auto Tare (A-TARE)  
 Changes the Backlight colors used in Under, Over, and Accept 

(bcKModE)  
 Reset the target values to zero (RESEt) 

Outputs - Latch & Unlatch 
Check ↓ Outputs ↓ Latch & Unlatch 

5. From CHECK press …  
OUTPUTS is now displayed. There are 

6. Press …  
UNLATCH is now displayed. 

7. Press  or  to toggle between the options (LATCH and UNLATCH) and 
press  select an option…  

OUTPUTS is now displayed. 

 
Note:  If the checkweigh mode is currently using the LO and HI limit values, viewing or 
entering the Under or Over division settings will change these Limit values accordingly. 

 
Under Segment Divisions 
Check ↓ Outputs → Under Divisions 

8. From OUTPUTS press …  
USEGdIV is now displayed. 

9. Press  …  
The current value is shown with a flashing right-most digit. 

10. Press  to accept the current value or key in a new value and press  to 
accept…  

USEGdIV is now displayed. 

Over Segment Divisions 
Check ↓ Outputs → Under Divisions → Over Divisions 

11. From USEGdIV press …  
OSEGdIV is now displayed. 

12. Press …  
The current value is shown with a flashing right-most digit. 

13. Press  to accept the current value or key in a new value and press  to 
accept…  

OSEGdIV is now displayed. 
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Print Total  
Check ↓ Outputs → Under Divisions → Over Divisions → Print Total 

14. From OSEGdIV press …  
Prt TOT is now displayed. Use this to enable/disable printing of the Total 
report. Choose on (default) to enable and oFF to disable this function.  

15. Press …  
The current choice is displayed. 

16. Press  or  to toggle between the choices and when your choice is 
displayed, press to accept…  

Prt TOT is displayed. 

Total Format 
Check ↓ Outputs → Under Divisions → Over Divisions → Print Total → Total 
Format 
To print the Total Format for the ZM223 Mid-Level Checkweighing application you must 
either perform a reset shown below (see page 175), which sets the Total Format to 9 or 
manually key in 9 under the Total Format menu item. 

17. From Prt TOT Press …  
ToT FMt is now displayed. Use this to choose a print format for the Total 
report.  

18. Press …  
The current print format number is displayed.  

19. Press  to accept this or key in a new print format number and press  to 
accept…  

ToT FMt is displayed.  
 

Clear Total  
Check ↓ Outputs → Under Divisions → Over Divisions → Print Total → Total 
Format  → Clear Total  

20. From ToT FMt, press  …  
CLR TOT is displayed. Use this to enable or disable the clearing of the 
transaction counter. Choose ON (default) to enable and OFF to disable 
the clearing of the transaction counter.  

21. Press …  
The current choice is displayed.  

22. Press  or  to toggle between the choices and press  to select an 
option… 

CLR TOT is displayed.  
Digits  
Check ↓ Outputs → Under Divisions → Over Divisions → Print Total → Total 
Format  → Clear Total →  Digits  

23. From CLR TOT press …  
digitS is now displayed. Use this to turn the weight display OFF or ON 
(default) when in checkweighing mode. When set to OFF the bar graph 
is the only part of the display that is on.  

24. Press …  
The current choice is displayed. 

25. Press  or  to toggle between the choices and press  to select an 
option… 

digitS is displayed. 
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Graph  
Check ↓ Outputs → Under Divisions → Over Divisions → Print Total → Total 
Format  → Clear Total →  Digits  → Graph 

26. From digitS press …  
GrAPh is displayed. Use this to turn the weight display OFF or ON 
(default) when in checkweighing mode. When set to OFF the bar graph 
is the only part of the display that is on.  

27. Press …  
The current choice is displayed. 

28. Press  or  to toggle between the choices and press  to select an 
option… 

GrAPh is displayed. 
Stats 
Check ↓ Outputs → Under Divisions → Over Divisions → Print Total → Total 
Format  → Clear Total →  Digits  → Graph → Stats 

29. From GrAPh, press …  
STATS is now displayed. 

30. Press …  
OFF is now displayed.  

31. Use  or  to toggle between the choices (OFF, Std dEV, and X-bAR) and 
press  to select an option… 

STATS is now displayed. 
Packrun 
Check ↓ Outputs → Under Divisions → Over Divisions → Print Total → Total 
Format  → Clear Total →  Digits  → Graph → Stats → Packrun 

32. From STATS, press …  
PACKRUN is now displayed. 

33. Press …  
0 is now displayed.  

34. Key in the desired packrun size and press … 
PACKRUN is now displayed. 

Type  
Check ↓ Outputs → Under Divisions → Over Divisions → Total Format  → Clear 
Total →  Digits  → Graph → Stats → Packrun → Type  

35. From PACKRUN press …  
TYPE is now displayed. Use this to choose which type of 
checkweighing you want to do: SAMPLE or LIMITS. Select SAMPLE 
mode (default) if you want to enter a target weight by placing a 
sample on the scale and pressing the TARGET key. The upper 
tolerance is automatically set to +1 division and the lower tolerance is 
automatically set to -1 division. The Tol Hi and Tol Low work from this 
target point. Select LiMitS mode to enter an upper and lower limit 
which defines the acceptable weight range.  

36. Press …  
The current choice is displayed.  

37. Press  or  to toggle between the choices and press  to select an 
option… 

TYPE is displayed. 
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Auto Tare  
Check ↓ Outputs → Under Divisions → Over Divisions → Print Total → Total 
Format  → Clear Total →  Digits  → Graph → Stats → Packrun → Type → Auto Tare  

38. From TYPE press  …  
A-TARE is displayed. Use this to disable or enable (OFF (default) or 
on) an auto tare when the target weight is reached. This allows you to 
add items to a box or pallet and auto-tare the weight of each item if it 
falls in the target range.  

39. Press …  
The current choice is displayed.  

40. Press  or  to toggle between the choices and press  to select an 
option… 

A-TARE is displayed. 
Backlight Mode 
Check ↓ Outputs → Under Divisions → Over Divisions → Print Total → Total 
Format  → Clear Total →  Digits  → Graph → Stats → Packrun → Type → Auto Tare  
→ Backlight Mode 

41. From A-TARE, press  … 
bcKModE is now displayed 

42. Press …  
NEAr ZEr is now displayed 

43. Press …  
yEllow is now displayed 

44. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

NEAr ZEr is now displayed 
45. Press  … 

UNdEr is now displayed 

46. Press …  
REd is now displayed 

47. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

UNdEr is now displayed 
48. Press  … 

AccEPt is now displayed 

49. Press …  
GrEEN is now displayed 

50. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

AccEPt is now displayed 
51. Press  … 

OvEr is now displayed 

52. Press …  
OrANgE is now displayed 
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53. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

OvEr is now displayed 
54. Press  until bcKModE is displayed. 

Reset  
Check ↓ Outputs → Under Divisions → Over Divisions → Print Total → Total 
Format  → Clear Total →  Digits  → Graph → Stats → Packrun → Type → Auto Tare  
→ Backlight Mode → Reset  

55. From bcKModE, press …  
RESET is displayed. Use this to reset the factory defaults for the 
checkweighing parameters.  

56. Press …  
No is displayed. This is the default value.  

57. Press  to abort the reset or, to reset the defaults, press UNITS…  
YES is displayed. Accepting this will reset the defaults.  

58. Press  to accept…  
RESEt is now displayed.  
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8.8 Check Percentage App Supervisor Menu 
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8.8.1 Checkweighing by Percentage Supervisor Menu 
Setup   

Outputs: This allows users determine when the relay or annunciator changes once a 
weight is above or below the output value.   

Latch: Weights will stabilize at or above the output value before the relay 
or annunciator changes.  
Unlatch: The relay and annunciator will change instantly as the weight 
swings above or below the output value.   

Under Seg Div: This controls the value each segment of Under bar graph annunciator 
represents. When set to 10%, each Under bar graph annunciator segment represents 
10%.   

Over Seg Div: This controls the value each segment of Over bar graph annunciator 
represents. When set to 10%, each Over bar graph annunciator segment represents 
10%.   

Low Tolerance: This controls the active Low Tolerance %.  

High Tolerance: This controls the active High Tolerance %. 
Print Total: This allows users to print the Total Printing print format by holding down the 
PRINT key. This prints an accumulated total for the day, shift, etc., rather than the current 
value of the current run.  

Total Print Format: This allows users to choose a Print Format by entering the 
corresponding Print Format Number. To see a complete list of available Print Formats go 
to page 210. 

Clear Total: When enabled, this allows users to clear a Transaction at the end of an 
accumulation by pressing and holding the PRINT key. The Transaction Totals will be 
printed followed by clearing the Transaction Totals for that Accumulator Channel. The 
display will flash PRN-TOT. When disabled, the only way to clear a Transaction is 
through the Supervisor Menu by using the Reset function. 

Digits: This controls if the indicator’s display digits are on or off. When off, the display will 
only change color to signal under, over, or at target.  

Graph: This controls if the indicator’s display bar graph is on or off. If turned off, it also 
disables the backlight from changing with outputs.   

Stats: This controls which statistical model the application uses to generate graphs. The 
ZM223 supports Standard Deviation and X-Bar/R Charts.  

Type: This controls how the indicator acquires the Target Weight. Choose between 
SAMPLE or LIMITS. 

Back Light Mode: This allows users to select the Back Light Color for the Near Zero, 
Under, Accept, and Over settings.  

Reset: This allows users to reset application specific settings to default settings. 

1. With the indicator powered up and in normal operating mode, press and hold F1 
…  

Pass is now displayed, prompting the technician or user to enter the 
password. 

2. Key in the Supervisor Password (1793) and press … 
SuPEr is now displayed. 

3. Press …  
SETPNT is now displayed. 
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4. Press  until…  
CHECK is now displayed. This stands for checkweigher. Use this to set 
the items relating to checkweighing: 
 Set conditions for using the outputs (OUTPUTS)  
 Set under divisions for acceptable target weight (USEGdIV)  
 Set over divisions for acceptable target weight (OSEGdIV)  
 Reset the target values to zero (RESEt) 

Outputs - Latch & Unlatch 
Check ↓ Outputs ↓ Latch & Unlatch 

5. From CHECK press …  
OUTPUTS is now displayed. There are 

6. Press …  
UNLATCH is now displayed. 

7. Press  or  to toggle between the options (LAtch and UnLAtch) and 
press  select an option…  

OUTPUTS is now displayed. 

 
Note: If the checkweigh mode is currently using the LO and HI limit values, viewing or 
entering the Under or Over division settings will change these Limit values accordingly. 

 
Under Segment Divisions 
Check ↓ Outputs → Under divisions 

8. From OUTPUTS, press …  
USEGdIV is now displayed. 

9. Press …  
The current value is shown with a flashing right-most digit. 

10. Press  to accept the current value or key in a new value and press  to 
accept…  

USEGdIV is now displayed. 

Over Segment Divisions 
Check ↓ Outputs → Under divisions → Over divisions 

11. From USEGdIV, press …  
OSEGdIV is now displayed. 

12. Press … 
The current value is shown with a flashing right-most digit. 

13. Press  to accept the current value or key in a new value and press  to 
accept…  

OSEGdIV is now displayed. 

Print Total  
Check ↓ Outputs → Under divisions → Over divisions → Print Total 

14. From OSEGdIV press …  
Prt TOT is now displayed. Use this to enable/disable printing of the Total 
report. Choose ON to enable and OFF (default) to disable this function.  

15. Press …  
The current choice is displayed.  

16. Press  or  to toggle between the choices and when your choice is 
displayed, press to accept…  

Prt TOT is displayed. 
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Total Format 
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total Format 
To print the Total Format for the ZM223 Mid-level Checkweighing application you must 
either perform a reset shown below, which sets the Total Format to 9 or manually key in 9 
under the Total Format menu item. 

17. From Prt TOT Press …  
ToT FMt is now displayed. Use this to choose a print format for the Total 
report.  

18. Press …  
The current print format number is displayed.  

19. Press  to accept this or key in a new print format number and press  to 
accept …  

ToT FMt is displayed.  
Clear Total  
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total Format 
→ Clear Total  

20. From ToT FMt Press  …  
CLR TOT is displayed. Use this to enable or disable the clearing of the 
transaction counter. Choose ON (default) to enable and OFF to disable 
the clearing of the transaction counter.  

21. Press …  
The current choice is displayed.  

22. Press  or  to toggle between the choices and press  to select an 
option… 

CLR TOT is displayed.  
Digits  
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total Format 
→ Clear Total → Digits  

23. From CLR TOT press …  
digitS is now displayed. Use this to turn the weight display oFF or on 
(default) when in checkweighing mode. When set to oFF the bar graph 
is the only part of the display that is on.  

24. Press …  
The current choice is displayed. 

25. Press  or  to toggle between the choices and press  to select an 
option… 

digitS is displayed. 
Graph  
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total Format 
→ Clear Total → Digits → Graph 

26. From digitS press …  
GrAPh is displayed. Use this to turn the graph display oFF or on 
(default) when in checkweighing mode. When set to oFF the weight 
digits are the only part of the display that is on.  

27. Press …  
The current choice is displayed. 

28. Press  or  to toggle between the choices and press  to select an 
option… 

GrAPh is displayed. 
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Stats 
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total Format 
→ Clear Total → Digits → Graph → Stats 

29. From GrAPh, press …  
STATS is now displayed. 

30. Press …  
OFF is now displayed.  

31. Use  or  to toggle between the choices (OFF, Std dEV and X-bAR) and 
press  to select an option… 

STATS is now displayed. 
Type  
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total Format 
→ Clear Total → Digits → Graph → Stats → Type  

32. From STATS press …  
TYPE is now displayed. Use this to choose which type of 
checkweighing you want to do: SAMPLE or LiMitS. Select SAMPLE 
mode (default) if you want to enter a target weight by placing a 
sample on the scale and pressing the TARGET key. The upper 
tolerance is automatically set to +1 division % and the lower tolerance 
is automatically set to -1 division %. The Tol Hi and Tol Low work 
from this target point. Select LiMitS mode to enter an upper and lower 
limit which defines the acceptable weight range.  

33. Press …  
The current choice is displayed.  

34. Press  or  to toggle between the choices and press  to select an 
option… 

TYPE is displayed. 
Backlight Mode 
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total Format 
→ Clear Total → Digits → Graph → Stats → Type → Backlight Mode 

35. From TYPE, press  … 
bcKModE is now displayed 

36. Press …  
NEAr ZEr is now displayed 

37. Press …  
yEllow is now displayed 

38. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

NEAr ZEr is now displayed 
39. Press  … 

UNdEr is now displayed 

40. Press …  
REd is now displayed 

41. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

UNdEr is now displayed 
42. Press  … 

AccEPt is now displayed 



 

Page 182 of 224 
 

43. Press …  
GrEEN is now displayed 

44. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

AccEPt is now displayed 
45. Press  … 

OvEr is now displayed 

46. Press …  
OrANgE is now displayed 

47. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

OvEr is now displayed 
48. Press  until bcKModE is displayed 

Reset  
Check ↓ Outputs → Under divisions → Over divisions → Print Total → Total Format 
→ Clear Total → Digits → Graph → Stats → Type → Backlight Mode → Reset  

49. From bcKModE press …  
RESEt is displayed. Use this to reset the factory defaults for the 
checkweighing parameters.  

50. Press …  
No is displayed. This is the default value.  

51. Press  to abort the reset or, to reset the defaults, press …  
YES is displayed. Accepting this will reset the defaults.  

52. Press  to accept…  
RESEt is now displayed. 

 

 

 



 

Page 183 of 224 
 

8.9 Batching App Supervisor Menu 
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8.9.1 Batching App Supervisor Menu Setup   
Type: This allows users to choose between the available filling options: 2 Speed, 
Ingredients, Independent, and Fill Discharge 

Mode: This determines if the indicator is using Manual or Automatic batching.  

Manual: When Manual, the preact values entered in the SETPNT submenu for 
PREACT4, PREACT5 and PREACT6 are used. 

Auto: When set to Auto, preact is automatically calculated. The amount of 
compensation is calculated based on the average variance between the entered 
setpoint value and the actual fill weights recorded during the most recent batch 
cycles. 

Clear: When cLEAr is selected, the current preact values will be set to 0. If PREACT 
was set to Auto, a new set of compensation values will be calculated on continuing 
batches. If preact was set to Manual, then preact will be disabled or new values can be 
manually entered in the setpoint menu. 

Display: This allows users to determine if the batching weights are based on Net or 
Gross values. 

Preact: Is used to compensate for product weight that continues to fill into a bag or 
container after the setpoint output turns off and before the final weight stabilizes. 
Neg Fil: Negative filling dispenses a smaller amount of product from a large vessel, tank, 
or hopper type scale. 

Backlight Mode: This controls the behavior of the display’s backlight color in relation to 
the batching settings (Running, Paused, Stopped). 

1 With the indicator powered up and in normal operating mode, press and hold F1 
…  

PASS is now displayed, prompting the technician or user to enter the 
password. 

2 Key in the Supervisor Password (1793) and press … 
SuPEr is now displayed. 

3 Press …  
SETPNT is now displayed. 

4 Press  until…  

bATCH is now displayed. Use this to set the items relating to batching:  
 Set the type of batch operation (TYPE)  
 Select auto or manual operation (MOdE)  
 Set gross or net display mode (dISP)  
 Set the conditions for preact (PREACT)  
 Select negative filling operation (NEG FIL)  
 Set the Backlight Modes (bcKModE) 

Type 
Batch ↓Type 

5. From bATCH press …  
TYPE is now displayed. There are 4 choices under Type: INGREd, 
INdEP, FIL-dSC and 2 SPEEd. Each is explained below:  
INGREd: Choose ingredient for sequential filling for up to 3 products at a 
single speed.  
INdEP: Choose independent when the filling process is run based on the 
values set for the outputs.  
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FIL-dSC: Choose fill-discharge when performing a fill operation to a 
hopper before the dispense process to fill bags or boxes from that 
hopper by a set weight until the hopper is closer to empty (negative 
weight) from something like a hopper scale.  
 
2 SPEEd: Choose 2 speed when using a speed control device for one 
ingredient.  

6. Press … 
The current setting is now displayed. 

7. Press  to scroll through the options and press  to make a selection…  
TYPE is now displayed. 

Mode 
Batch ↓ Type → Mode 

8. From TYPE press …  
ModE is now displayed. Mode has two choices: Auto or MAnuAL.  

9. Press  …  
The current setting is now displayed. 

10. Press  or  to toggle between the options and press  to make a 
selection…  

ModE is now now displayed. 

Display 
Batch ↓ Type → Mode → Display 

11. From MOdE press … 

dISP is now displayed. Display has three choices: NET, NET-A and 
GROSS. Each is explained below:  
NET: Choose Net to base batching on net weights.  
NET-A: Missing explanation  
GROSS: Choose Gross to base batching on gross weights. 

12. Press …  
The current setting is now displayed. 

13. Press  or  to toggle between the options and press  to make a 
selection…  

diSP is now displayed. 

Preact 
Batch ↓ Type → Mode → Display → Preact 

14. From diSP press … 

PREACT is now displayed. 

Preact can be used to compensate for product weight that continues to 
fill into the bag or container after the setpoint output turns off and before 
the final weight stabilizes. If a preact value is automatically calculated or 
manually entered, the actual cutoff weight will equal the entered setpoint 
value minus the preact value. Preact has three choices: MANUAL, 
AUTO or CLEAR. 
MANUAL: When set to Manual, the preact values entered in the 
SETPNT submenu for PREACT4, 5, and 6 are used.  
AUTO: When set to Auto, preact is automatically calculated. The amount 
of compensation is calculated based on the average variance between 
the entered setpoint value and the actual fill weights recorded during the 
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most recent batch cycles. Preact is only available in certain Batch Types 
as noted in their descriptions. Calculated Preact values can be viewed in 
the SETPNT submenu for PREACT4, 5, and 6.  
CLEAR: When Clear is selected, the current preact values will be set to 
0. If PREACT was set to Auto, a new set of compensation values will be 
calculated on continuing batches. If PREACT was set to Manual, then 
preact will be disabled or new values can be manually entered in the 
Setpoint menu.  

15. Press …  

The current setting is now displayed. 

16. Press  to scroll through the options and press  to make a selection…  

PREACT is now displayed. 

Negative Fill 
Batch ↓ Type → Mode → Display → Preact → Negative Fill  

17. From PREACT press …  

NEG FIL is now displayed. This stands for negative fill and has two 
choices: ON or OFF. Each is explained below: 

Choose ON to enable negative fill (default). Operation varies 
depending on Type chosen.  

Choose OFF to disable negative fill. 

18. Press …  

The current setting is now displayed. 

19. Press  to scroll through the options and press  to make a selection…  

NEG FIL is now displayed. 

Backlight Mode 
Batch ↓ Type → Mode → Display → Preact → Negative Fill → bcKModE 

20. From NEG FIL, press  … 
bcKModE is now displayed 

21. Press …  
RUNNING is now displayed 

22. Press …  
GrEEN is now displayed 

23. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

RUNNING is now displayed 
24. Press  … 

PAUSEd is now displayed 

25. Press …  
REd is now displayed 

26. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

PAUSEd is now displayed 
 



 

Page 187 of 224 
 

27. Press  … 
STOPPEd is now displayed 

28. Press …  
yEllow is now displayed 

29. To change the Backlight Color, use  or  to toggle through the options and 
press  to make a selection… 

STOPPEd is now displayed 
30. Press  until bcKModE is displayed 
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8.10 Remote Display Supervisor Menu 
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8.10.1 Remote Display App Supervisor Menu Setup   
To configure the indicator for remote display operation the user must choose the mode of 
operation in the Supervisor Menu and configure the port. Configuring the port is done 
through a password protected menu. Contact a supervisor or the local Avery Weigh-
Tronix representative for more information. 

Bind Forward: Bind Forward passes a Print Format from the Primary Display Indicator 
through the Remote Display Indicator. However, this only works if the Print Format starts 
with a STX character and ends with an ETX character. This allows printing on both the 
Primary and Remote Displays. The firmware watches the data coming in and if there is a 
STX it just passes it through until the ETX. This can work using RS232 or Ethernet 
Connections. 

1. With the indicator powered up and in normal operating mode, press and hold F1 
…  

PASS is now displayed, prompting the technician or user to enter the 
password. 

2. Key in the Supervisor Password (1793) and press … 
SuPEr is now displayed. 

3. Press …  
R-dISP is now displayed. 

4. Press …  
EnAbLE is now displayed. Choices are: ON (default) and OFF. 

5. Press …  

ON is now displayed. 

6. Use  or  to toggle between the options and press  to accept… 
EnAbLE is now displayed. 

7. Press … 

ModE is now displayed. Choices are: Rd4000 and SMACLNT. 

8. Press …  

Rd4000 is now displayed. 

9. Use  or  to cycle through the options and press  to accept the 
displayed choice…  

ModE is now displayed.  
10. Press …  

biNdFwd is now displayed. Use this to choose which port will be used 
for printing/communication forwarding from the Primary Indicator. 
Choices are: OFF, Port 1, Port 2, ENEt 1-10. 

11. Press …  
OFF is now displayed.  

12. Use  or  to toggle between the choices and press  to accept…  
biNdFwd is now displayed. 
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8.10.2 Remote Display Configuration Using Ztools 
We recommend that all users and technicians follow the below steps using Ztools to 
ensure proper configuration of a Remote Display. 

 
Note: When a Remote Display indicator says OFFLINE it means either there is no signal 
between it and the Primary Display or print format or communication settings are 
incorrect. 
 

1. Connect the PC running Ztools to the Primary Display Indicator with an Ethernet 
Cable.  

2. Scan for the Primary Display Indicator and double click on it. 
3. Upload from the Primary Indicator 

Rd4000 Configuration 
Serial Port Connection 
Must configure/wire for primary to transmit and Remote Display to receive and 
grounding. If the keys on the Remote Display need to be operational see the Bind 
Forwarding section below.   

Settings for Primary Display 
1. Open whatever application you would like to broadcast the displayed weight with. 

In this example we will be using the General Application.  
2. From the Ztools home screen click on Serial Port. 

 
3. Click on the serial port number that the Primary Display Indicator is transmitting 

to the Remote Display Indicator through. Port 2 in this example. 
4. Verify that the Baud Rate (9600 in this example). The Baud Rate must be the 

same on both Primary and Remote Display Indicators.   
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5. Click on Protocol  

 
6. Set the Protocol 2 Type to B-Cast. 
7. Verify that the protocol is set to Print Format #7 or Display Weight. 
8. Verify that Parse Key Messages is set to Keys. This allows the keys from the 

Remote Display Indicator to function on the Primary Indicator.  
9. Download configuration to the connected indicator.  

Settings for Remote Display 
10. Ensure that the Remote Display Indicator is running the Remote Display 

Application. 
11. From the Ztools home screen click on Serial Ports. 

 
12. Click on the serial port number that the Remote Display Indicator is receiving 

from the Primary Display Indicator through. Port 1 in this example. 
13. Verify that the Baud Rate (9600 in this example). The Baud Rate must be the 

same on both Primary and Remote Display Indicators.   
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14. Click on Protocol  

 
15. The Remote Display App is preconfigured with the RD Protocol on Protocol 1. 
16. Verify that the Type is set to RD (Remote Display). 
17. Ensure that Binding is set to the communication port being used.  
18. Download configuration to the connected indicator.  

Ethernet Connection 
Setting for Primary Display 

1. Open whatever application you would like to broadcast the displayed weight with. 
In this example we will be using the General Application.  

2. Click on Protocol  

 
3. Verify that Protocol 8 is set to B-cast (Broadcast) and that it is bound it to Enet 3 
4. Enet 3 is already set up to be a Server to communicate with the Remote 

Display’s to Enet 1. 
5. Verify that the Protocol is set to Print Format #7 or Display Weight. 
6. Verify that Parse Key Messages is set to Keys. This allows the keys from the 

Remote Display Indicator to function on the Primary Indicator.  
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7. Click on Ethernet Port to view an example Enet 3 configuration. 

 
8. Download configuration to the connected indicator. 

Settings for Remote Display 
9. Ensure that the Remote Display Indicator is running the Remote Display 

Application. 
10. Click on Protocol 

 
11. Verify that the Protocol Type is set to RD (remote display) and bound it to Enet 1 
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12. Click on Ethernet Port. 

 
13. Verify that Enet 1 Configuration matches the example above. 
14. Download Configuration to the connected indicator.  

 

SMA Mode 
Primary Display 

1. Follow the steps above but set Protocol Modes to SMA rather than B-Cast for 
the Primary Indicator Configuration.   

Protocol 2 = Serial  
Protocol 8 = Ethernet 

 
Note: The SMA mode allows our indicators to communicate with any device that uses 
SMA, whether it is an Avery Weigh-Tronix device or not.    

 

8.10.3 Bind Forward 
Bind Forward: Bind Forward passes a Print Format from the Primary Display Indicator 
through the Remote Display Indicator. However, this only works if the Print Format starts 
with a STX character and ends with an ETX character. This allows printing on both the 
Primary and Remote Displays. The firmware watches the data coming in and if there is a 
STX it just passes it through until the ETX. This can work using RS232 or Ethernet 
Connections. 
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8.11 In-Motion App Supervisor Menu 
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8.11.1 In-Motion App Supervisor Menu Setup 
Enable: This controls if the In-Motion function is on or off. 
Start IO: This is photo entrance eye to start the weighing process 
Stop IO: This is photo exit eye to stop the weighing process 
Delay: This controls the delay in seconds (between 0 and 60) 
Sw 2 GR: This would switch back to Gross Weight automatically based on your delay 
setting above. Default setting is OFF. 

1. Press and hold F1… 

PASSis now displayed 

2. Enter 1793 and press … 

SuPEr is now displayed 

3. Press  until I/O 1 is displayed 

4. Press  until I/O 4 is displayed 

5. Press … 

EdIT4 is now displayed 

6. Press …  

MOdE 4 is now displayed 

7. Press … 

diSAblE is now displayed  

8. Press  until ACT-IN is displayed… 

9. Press …  

MOdE4 is now displayed 

10. Press … 

bKLT4 is now displayed 

11. Press … 

GrEEN is now displayed. Use  to cycle through the backlight color 
option (YEllow, OrANgE, REd, and NoNE) 

12. Press  to select a backlight color… 

bKLT4 is now displayed 

13. Press …  

I/O4 is now displayed 

14. Press …  

I/O 5 is now displayed 
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15. Repeat steps 5 thru 12 to set I/O 5…  

MOdE5 to ACT- IN 

16. With bKLT5 displayed press …  

I/O 5 is now displayed 

17. Press  …  

I/O 6 is now displayed 

18. Press  …  

EdIT6 is now displayed 

19. Press  …  

MOdE6 is now displayed 

20. Press … 

diSAblE is now displayed  

21. Press  … 

ACT-AbV 

22. Press …  

MOdE6 is now displayed 

23. Press  … 

bKLT6 is now displayed 

24. Press … 

GrEEN is now displayed. Use  to cycle through the backlight color 
option (YEllow, OrANgE, REd, and NoNE). 

25. Press  to select a backlight color… 

bKLT6 is now displayed 

26. Press  until SETPNT is displayed 

27. Press  until IN-Mo is displayed 

28. Press …  

ENAblE is now displayed 

29. Press  and  if necessary to make sure ON is displayed 

30. Press … 

 ENAblE  is now displayed 

31. Press …  

StArtIO is now displayed 
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32. Press  and enter 1 and press  

The “1” corresponds to Input 1 on TB2-2 of the ZM223. This setting 
assumes the entrance photo-eye module is configured to trigger a pulse 
on a dark to light transition to ensure the item has cleared the photo-eye. 
To improve weighing accuracy a slight time delay (~0.1 to 0.2 sec) is 
typically set on the entrance photo-eye programming switches/trim pot so 
that the signal to start weight averaging is delayed slightly after the item 
comes onto the scale. A smooth transition of the item from entrance to 
weighing conveyor can shorten the necessary delay time. 

If using a negative edge signal to start weight averaging, then this value 
would be set to -1 

33. With StArtIO displayed press … 

StoPIO is now displayed. 

34. Press  and enter 2 and press  

The “2” corresponds to Input 2 on TB2-3 of the ZM223. This setting 
assumes the exit photo-eye module is configured to trigger a pulse on a 
light to dark transition so that the weight averaging stops as soon as the 
item first breaks the path of the beam. Typically, the exit photo-eye is 
positioned a short distance (a few inches) before the end of the weighing 
conveyor. No delays should be set on the programming switches/trim pot 
of the exit photo-eye module. 

 
Note: the minimum amount of time an item should be on the scale is 100 milliseconds but 
to achieve better accuracy 300ms or longer is recommended. 

  
35. With StoPIO displayed press … 

dELAy is now displayed. The Delay value will set the length of time the 
calculated weight is displayed and the check-weigh setpoint output is 
activated. If the Delay timer is set to 0 then the displayed weight and 
setpoint output will remain on indefinitely or until the next Start IO signal 
is received. 

36. Press  and enter a value for the Delay Timer and press … 

dELAY is now displayed. 

37. Press  until the display returns to normal operation. 
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8.12 Grading App Supervisor Menu  
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8.12.1 Grades App Supervisor Menu Setup 
Grading 1 – 11: This allows users to define the weight range for each Grade. The value 
that is entered in each Grade becomes the top limit of the grade before it. For example, if 
you set Grade 1 = 1.01 pound and Grade 2 = 2.01 pounds, everything that weighs 
between 1.01 pound (the value after the decimal is probably determined by division size) 
all the way up to and INCLUDING 2.00 pounds will be classified as Grade 1. 

Type: This allows users to toggle between Positive and Negative Grading 

Tare: This allows users to toggle between the Manual Tare (default) and the Auto Tare 
functions.  

Print: This allows users to choose which available connection port Print commands are 
sent to: Port1, Port 2, or USB. A USB drive must be plugged into the USB port for any 
data to be Printed/Saved.   

Labels: This allows users to customize how different grades are displayed. For example, 
if you have items that are below your GRAD1 (Under), it can say, "REJECT" or "FAIL". 

Reset Accum: This allows users to reset all accumulator channels back to Zero. Press 
any numeric key followed by the set RPN key to reset accumulation.  

Print Accum: This allows users to print the stored grade values without clearing the 
accumulated totals. Press any numeric key followed by the set RPN key to reset 
accumulation.  

Press and hold F1. 

1. Press and hold F1. 

2. Key in the Weight Value and press … 
GRAdING is displayed. 

3. Press … 
GRAd 1 is displayed. This is the first weight point that defines the lower 
limit of Grade 1. 

4. Press  …  
The current GRAd 1 value flashes indicating that you can edit this. 

5. Key in the weight for this and press  … 
GRAd 1 is now displayed. 

6. Press  to move to the next grading weight point. 
GRAd2 is now displayed.  

7. Repeat steps 3 through 5 until all grade weight points have been set. 
8. Once all the GRAD points have been entered, press  multiple times to exit 

and return to weighing. 
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8.13  AutoLoc Setup 
AutoLoc: AutoLoc allows the ZM223 to be used for weighing and recording an animal’s 
weight automatically on an animal livestock scale. There are two modes, Standard and 
Advanced. 

1. Press and hold F1… 
Pass is briefly displayed before the text input prompt 

2. Enter the Supervisor Menu Password (1793) and press … 
Super is now displayed 

3. Press  … 

Ld-Unld is now displayed 

4. Press  … 

AccuM is now displayed. 

5. Press  … 

AutoLoc is now displayed. 

AutoLoc Mode 

AutoLoc Mode: This parameter allows users to select the current AutoLoc Mode 
(Standard, Advanced, and Disable). The difference between Standard and Advanced 
modes is that in Advanced mode the ZM223 will lock on to the weight and stay locked 
even when the weight is removed from the scale. A new AutoLoc weight will only be 
retriggered upon placing a new weight onto the scale. 

6. Press  … 

ALCMode is now displayed 

7. Press  … 
disAblE is now displayed  

8. Use  or  to cycle through the print options (Disable, Standard, or 
Advanced)… 
Disable turns off the AutoLoc function.  
Standard allows the indicator to do Standard AutoLoc functions.  
Advanced allows the indicator to do Advanced AutoLoc functions. 

9. Press  to make a selection… 
ALCMode is now displayed 

AutoLoc Min 

AutoLoc Min: This parameter allows users to set the Minimum Weight for AutoLoc to 
trigger.  

10. Press … 

ALC MiN is now displayed. 

11. Enter the Minimum Weight for the AutoLoc to lock onto a stable weight and press 
… 

ALC MiN is now displayed. 
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AutoLoc Control 

AutoLoc Control: This parameter allows users to enter the Percent Weight Change for 
AutoLoc to trigger. 

12. Press  … 

ALCRTOL is now displayed. 

13. Press … 
The current value is displayed. 

14. Enter the desired weight percentage for AutoLoc Filter to restart after locking 
onto a stable weight and press  to accept… 

ALCRTOL is now displayed. 

8.14 PLUs 
Super ↓ Setpoint → Tare → [App Menu] → PLU [when applicable] 

PLU databases are available with some applications like Counting, Checkweigh 
Advanced and Percentage Checkweighing. When configured internally, up to 2000 PLUs 
can be stored on the indicator’s micro-SD card.  

PLUs are used to quickly recall pre-stored tares and piece weights, along with other 
useful parameters using a PLU Slot from (1-2000).  

Checkweighing Advanced PLU Menus 

 
Checkcounting PLU Menus 
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Edit 
PLU ↓ Edit 
For the Counting App the first PLU Menu is PLU Enable (see below) Followed by the Edit 
menu item. 

1. From PLU, press  … 

Edit is now displayed  

2. Press … 

0 is now displayed 

3. Key in the desired PLU number and press  … 

4. Use  or  to cycle through the different PLU data fields (TARGET, TOL-
LO and TOL-HI) for checkweighing or (Hi LiM, PiEcEW, TARE1, TARE2, and 
Low Li) for Checkcounting. 

5. Press  to edits any of these fields and press  when finished… 

6. Press … 

Edit is now displayed 

PLU Enable (only applicable to Counting App) 
PLU ↓ PlUEnbl  
This enables PLUs to be used in the Counting Application. 

7. With the Counting Application running, from PLU, press  … 

PluENbl is now displayed  

8. Press … 

OFF is now displayed 

9. Press  to toggle between OFF and ON. 

10. Press  to make a selection… 

PluENbl is now displayed  
Clear Accum (only applicable to Counting App) 
PLU ↓ PlUEnbl  → Edit → ClrAccm 

11. Press … 
ClrAccM is now displayed 

12. Press … 

PLU is briefly displayed, then a numeric entry screen is displayed. 

13. Key in Accum Channel Number and press … 
ClrAccM is now displayed. 
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Password Required (only applicable to Counting App) 
PLU ↓ PlUEnbl → Edit → ClrAccm → PASSREQ 
This allows for a password to be required before making any edits to PLUs in the 
Counting App.  

14. Press  … 

PASSREQ is now displayed  

15. Press … 

NO is now displayed 

16. Press  to toggle between NO and yES 

17. Press  to make a selection… 

PASSREQ is now displayed  

Note: When Password Required is active, the Supervisor Menu Password (1793 by 
default) is required to make any edits to PLUs in the Counting App.  

Print 
PLU ↓ Edit → Print 

18. Press … 

PriNT is now displayed 

19. Press … 

Port 1 is now displayed 

20. Use  or  to cycle through the different port options (Port 1, Port 2, and 
USB) 

21. Press  to select an option… 

PriNt is now displayed 

Import 
PLU ↓ Edit → Print → Import 
To use either the Import or Export function there must be a USB drive attached to the 
indicator. 

22. Press … 

IMPort is now displayed 

23. Press … 

BUSY will flash on the display while the indicator completes the Import 
Process before it returns to IMPort.  
If there is not a USB drive attached to the indicator “Err -1” will briefly 
display before returning to IMport.  
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Export 
PLU ↓ Edit → Print → Import → Export 

24. Press … 

ExPort is now displayed 

25. Press … 

BUSY will flash on the display while the indicator completes the Export 
Process before it returns to ExPort.  
If there is not a USB drive attached to the indicator “Err -1” will briefly 
display before returning to ExPort.  

Reset 
PLU ↓ Edit → Print → Import → Export → Reset 

26. Press … 

RESET is now displayed 

27. Press … 

No is now displayed. 

28. Use  or  to cycle through the different port options (No or yES) 

29. Press  to select an option… 

RESET is now displayed 

8.15  Battery  
Super ↓ Setpoint → Tare → [App Menu] → PLU [when applicable] → Battery 

Battery: Use this to enable the battery and to set a timeout length (in minutes). If this 
time expires with no scale or keypad activity, setpoint #3 will change states so the 
battery will shut off if the proper external circuitry is provided. 

1. From Tare, press  … 

bATTERy is now displayed.  

Enable 
Battery ↓ Enable 
Only enable the battery and set the timeout value if the battery has the 
proper external shutoff circuitry. If battery use is enabled, setpoint output 
3 cannot be used for setpoints in any application. It is used as a shutoff 
signal. 

 
2. Press  … 

EnAbLE is now displayed. Choices are oFF and on. Choose oFF to disable 
battery usage. Choose on to enable battery usage. 

3. Press  to toggle between the choices and when your choice is 

displayed, press  to accept … 

EnAbLE is now displayed. 
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Timeout 
Battery ↓ Enable → Timeout 
Timeout: This stands for timeout. Use this to set the length of 
time before inactivity of the scale and keypad cause battery 
power to be shut off. Values between 1 and 3600 minutes are 
valid. This function only works if the battery has shutoff 
circuitry. 

4. Press  … 

tMout is now displayed.  

5. Press  … 

A numeric entry screen appears. 

6. Key in a value, in minutes and press  to accept … 

tMout is now displayed. 

7. This completes the Supervisor menu for General Weighing. Repeatedly press  
until the indicator returns to normal weighing mode. The current weight value is now 
displayed. 
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8.16 RPN 
Super ↓ Setpoint → Tare → [App Menu] → Battery → RPN 

 
RPN (Reverse Polish Notation): This allows users to program some of the indicator's 
keys to have a secondary function. RPN works by entering the required function number 
and the desired key selected for that function. RPN functions allow operators to enter in 
numeric data for a secondary key function like entering a known Piece Weight, an 
Operator ID, a Target Value, an Output Value, or PLU. Once a key has been selected for 
the RPN function, like a Target Weight, key in the value using the numeric keypad and 
then press the set RPN activation key. The display will flash the entered value and RPN 
function before returning to the live weight display. To cancel the RPN entry and return to 
normal operation press the C key. The above menu map is for the General Weighing 
Application. Other applications will have different RPN functions available. 

Av
ail

ab
le 

RP
N 

Fu
nc

tio
ns

 

 Application 
 General Accum Count Check 

Simp 
Check 

Mid 
Check 

Adv 
Check 
Grade 

Check 
by % 

Truck 
In/Out 

Batch
-ing 

P-
Hold 

Remote 
Display 

In-
Motion 

Tare X X X  X X X X X X  X X 
Base X X X X X X X X X X X X X 
ID X X X X X X X X X X X X X 
Print Format X X X X X X X X X X X X X 
I/O 4 X X X      X X X X X 
I/O 5 X X X      X X X X X 
I/O 6 X X X      X X X X X 
Accumulation 
Channel   X            

Preact 4          X    
Preact 5          X    
Preact 6          X    
Start          X    
Stop          X    
Truck ID         X     
Light Setting         X     
Under Segment 
Division    X  X  X      

Over Segment 
Division    X  X  X      

Under Division    X  X  X      
Over Division    X  X  X      
Target    X X X  X      
Target Low    X X X  X      
Tolerance Low    X X X  X      
Target High    X X X  X      
Tolerance High    X X X  X      
Piece Weight   X           
Sample Size   X           
PLU   X   X  X      
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8.20 Mobile 
Super ↓ Setpoint → Tare → [App Menu] → Battery → RPN → Mobile 

 
Mobile: This controls what fields can be seen/used on the Remote Assist Mobile App. 
This section is split into two sections: Scale-Related fields and UDF fields. The available 
fields depend on what app the ZM223 is running. 

 

Note: The above menu map is for the General Weighing Application. Other applications 
will have different Remote Assist Mobile App options available.  

 
 
 
 
 
 
 
 

Av
ail

ab
le 

RP
N 

Fu
nc

tio
ns

 

 Application 
 

General Accum Count Check Check 
Grade 

Check 
by % 

Truck 
In/Out 

Batch-
ing 

P-
Hold 

Remote 
Display In-Motion 

Simp Mid Adv 
Tare Weight X X X  X X X X X X X X X 
ID X X X X X X X X X X X X X 
I/O 4-6 X X      X X X X X X 
Accumulation 
Channel   X            

Preact 4 – 6          X    
Gross, Net, Tare         X     
Description   X           
Inbound WT         X     
Outbound WT         X     
PLU   X   X  X      
Grade 1-11       X       
Transaction         X     
Target   X  X X  X      
Low   X X X X  X      
High   X X X X  X      
Piece Weight   X X X X        
Part Number   X X X X  X      
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8.21 App Info 
Super ↓ Setpoint → Tare → [App Menu] → Battery → RPN → Mobile → App Info 
App Info: This allows users to view the Name, Part 
Number, and Version of the software running on the 
ZM223. 

The viewable fields are: 

 Bootloader 
 Firmware  
 Application  
 Lua 
 SQLite 
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9 Communications 
The ZM223 can communicate through these ports: 

 Serial 
 Ethernet 
 USB 
 Bluetooth 
 Wireless 802.11g 

 

9.1 Default Print Formats 
Users can quick select a Print Format by using the keypad. For example, key in 1 9 and 
press the PRINT key to print a ticket using Print Format 19, 3 5 to get Print Format 35, 
etc.  

 
Note: The below ticket examples are close approximations of how the different print 
formats look when used. There may be small differences in font, size, and formatting 
when printing in the field. 

 
Print Format Number Description Example Ticket 

1 General App. 
Default 

 
2 Accumulate App. Default (see PF 8 for 

Totals) 

 
3 Count App. 

Default (see PF 31 for 
Totals) 

 
4 Net Weight 

 
5 Displayed 

Weight 

 
6 Peak App. Default 

 
7 Remote App. 

Default (broadcast this format to 
remote) 
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Print Format Number Description Example Ticket 
8 Accummulate Totals App. 

Default (see PF 2 for 
print out) 

 
9 CONDEC 

clone format 

 
10 Displayed Weight with Tare Register 

number 

 
11 Displayed Weight with Status (3- bytes) 

 
12 Displayed Weight with Status 

(Alphanumeric) 

 
13 Basic Weight Ticket with Time, Date, 

and Site ID number 

 
14 Basic Weight Ticket with Time, Date, 

and Tare Register number 

 
15 Accumulated Gross Weight (Used with 

Accumulate or Count Apps.) 

 
16 Accumulated Net Weight (Used with 

Accumulate or Count Apps.) 

 
17 Basic Accumulate Ticket for GTN 

values 
(Used with Accumulate or Count Apps.) 

 
18 Minimum Peak Weight Value 

Or 
Peak Min and Max 

 
N/A 
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Print Format Number Description Example Ticket 
19 2.5 in. X 4.0 in. Barcode Ticket with Site 

ID, Time and Date 

 
 

20 1.25 in. X 1.0 
in. Thermal Label Ticket with Time and 
Date 

 
21 2.50 in. X 4.0 

in. Thermal Label Ticket with ID, Time 
and Date 

 
22 4.0 in. X 6.0 in. Thermal Label Ticket 

with ID, Time and Date 

 
23 Same as PF1 

with Time and 
Date first 
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Print Format Number Description Example Ticket 
24 Same as PF1 

with Time and 
Date last 

 
25 Gross Weight & Time & Date 

 
26 Brecknell RD- 65 (Setup RD for Data 

Format #3) 

 
27 In-Motion App. 

Default 

 
28 In_Motion App. (Alternate) 

 
29 Data Stream for (UK) Legacy PC 

application 
 

3327 0 00M99 9 
 

30 Bind Forward 

 
31 Count Totals App. Default (see PF 3 for 

print out) 

 
32 Used for 

Analog Output Option Card (Gross Cal 
Weight) 

 
33 XR4500TL 

Remote Display setup for Command 
Mode #3 

 
34 GSE Remote HUB interface format. 

 
35 Single 

transaction of 
accumulated 

GTN data (see 
PF 8 or PF 9 
for Totals Mode 

dependant) 
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Print Format Number Description Example Ticket 
36 Accumulate Totals for PLU # (see PF 2 

for print out) Advanced 
Mode only 

 
37 Accumulate 

Totals (see PF 
2 for print out) 

Mid375 Mode 
only 

 
38 ZM223 

Checkweigher Under/Accept/ Over Band 

 
39 ZM223 

Checkweigher Accept/Reject Band 

 
40 ZM223 Net 

Weighment with Band 

 
41 ZM223 

Standard Deviation Stats. 

 
42 ZM223 X-Bar/R 

Stats. with Trend Message if a trend 
condition exists. 

 
43 ZM223 Grading 

 
45 Scale 1  

Gross 1    0 lb 
Tare 1    0 lb 
Net 1    0 lb 

 
46 Scale 2  

Gross 2    0 lb 
Tare 2    0 lb 
Net 2    0 lb 
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Print Format Number Description Example Ticket 
47 Scale 1 and 2 Total  

Gross 1        0 lb 
Tare 1        0 lb 
Net 1        0 lb 

Gross 2        0 lb 
Tare 2        0 lb 
Net 2        0 lb 

Gross Total    0 lb 
Tare Total    0 lb 
Net Total    0 lb 

 
48 Inbound Ticket 

 
 

49 Inbound Report Header 

 
50 Inbound Report Body of Data 

 
 

51 Inbound Report Footer Gross    0 lb 
Tare     0 lb 
Net      0 lb 

End of Fleet Report 
End of Inbound Report 

 
52 Outbound Ticket  

 
 

53 Outbound Report Header 

 
54 Outbound Report 

Body of Data 

 
55 Outbound Report Footer 
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Print Format Number Description Example Ticket 
56 Fleet Ticket 

 
57 Fleet Report Header 

 
58 Fleet Report Body of Data 

 
 

59 Fleet Report Footer  

 
 

60 Reprinted Data Identifier  

 
 

61 GTN Boca  
 

01:45:26 
04-15-2026 

Gross    0 lb 
Tare    0 lb 
Net    0 lb 

 

 
62 Inbound Ticket Label Boca  

In Date        0 
In Time         0 
TRUCK ID        0 

In Weight      0        0 
63 Inbound Rpt Header Label Boca Inbound Vehicle Report 

14:29:24   04-15-2026 
TRUCK    Time     Date       Weight 
-------- ----- --------- ----------- 

64 Inbound Rpt Body Label Boca 0        0          0        0  0 
 

65 Inbound Rpt Footer Label Boca End of Inbound Report 
 

66 Outbound Ticket Label Boca In Date        0 
In Time         0 
Out Date        0 

Out Time         0 
TRUCK ID        0 

Trans#      0 
Gross      0        0 
Tare      0        0 
Net      0        0 

67 Outbound Rpt Header Label Boca Outbound Vehicle Report 
14:44:42   04-15-2026 

TRUCK     # Trans Total Net Wt 
-------- ------- ------------ 

 
68 Outbound Rpt Body Label Boca 0       0         0  0 

 
69 Outbound Rpt Footer Label Boca End of Outbound Report 
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Print Format Number Description Example Ticket 
70 Fleet Ticket Label Boca Date        0 

Time         0 
Fleet ID        0 

Trans#      0 
Gross      0        0 
Tare      0        0 
Net      0        0 

 
71 Fleet Rpt Header Label Boca Fleet Vehicle Report 

15:29:00   04-15-2026 
TRUCK     Tare Wt   # Trans Total Net Wt 
-------- --------- ------- ------------ 

 
72 Fleet Rpt Body Label Boca  

0      0  0       0         0  0 
 

73 Fleet Rpt Footer Label Boca Gross    0 lb 
Tare     0 lb 
Net      0 lb 

End of Fleet Report 
 

74 Normal Print Identifier Boca Gross    0 lb 
Tare     0 lb 
Net      0 lb 

End of Fleet Report 
 

75 RePrint Identifier Boca ***** REPRINT ***** 
 

76 Inbound Rpt Header Inbound Vehicle Report 
15:32:28  04-15-2026 

ID    Time        Date       Weight 
----- ------ ---------- ----------- 

 
77 Inbound Rpt Body  

0,       0,         0,       0  0 
 

78 Inbound Rpt Footer  
End of Inbound Report 

 
79 Outbound Rpt Header  

Outbound Vehicle Report 
15:33:42  04-15-2026 

ID     # Trans  Total Net Wt 
--------  -------  ------------ 

 
80 Outbound Rpt Body  

0,      0,        0  0 
 

81 Outbound Rpt Footer  
End of Outbound Report 

 
82 Fleet Rpt Header  

Fleet Vehicle Report 
15:34:25  04-15-2026 

Fleet ID Tare Wt # Trans Total Net Wt 
   -------- --------- ------- --------- 
 

83 Fleet Rpt Body  
0,     0  0,      0, 

 
84 Fleet Rpt Footer  

End of Fleet Report 
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Print Format Number Description Example Ticket 
85 Inbound Ticket Label Boca with barcode  

In Date        0 
In Time         0 
TRUCK ID        0 

In Weight      0        0 
*       0* 

 
86 GTN ID T&D 1.25x1 Zebra              

    12:25:51 04-21-2026 
ID        0 
G     0 lb 
T      0 lb 
N      0 lb  

 
87 GTN ID T&D 2.25x4 Zebra              12:25:51   04-21-2026 

ID        0 
G     0 lb 
T      0 lb 
N      0 lb 

88 GTN ID T&D 4x6 Zebra       12:25:51   04-21-2026 

ID        0 
G     0 lb 
T      0 lb 
N      0 lb 
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Print Format Number Description Example Ticket 
89 GTN ID T&D 2.25x4 Zebra Ticket Roll 

Paper 12:25:51   04-21-2026 

ID        0 

G     0        lb 

T      0       lb 

N      0       lb 

90 GTN T&D 4x6 Zebra Ticket Roll Paper 12:25:51   04-21-2026 

    G     0        lb 

    T      0       lb 

    N     0        lb 

91 GTN ID T&D Customer 2.25x3 r270 
Zebra              04-21-2026    12:25:51    

ID        0 
G     0 lb 
T      0 lb 

             N      0 lb 
             Customer Name 

92 GTN ID T&D NtBC 4x3 Zebra 12:29:58     04 

    G           0 

T           0 

   N           0 

       
          *0* 
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Print Format Number Description Example Ticket 
93 GWT lb/kg ID T&D 4x3 Zebra 0 

4-21-2026                   12:30:30 
GROSS WT:              0 lb 
                                 0.0 kg 

94 DSPWT T&D 4x6 r270 Zebra  

0 lb 
 

12:31:24 4/21/2026 
 

95 GTN T&D 4x6 w UDF 1-5 Ticket Roll 
Paper Zebra 12:29:58          04-21-2026 

G      0               lb 
T      0               lb 
N      0               lb 
PartNum   ABC 
Desc         ABC 
Loc           ABC 
Name       ABC 
Address    ABC 
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Print Format Number Description Example Ticket 
96 GTN T&D 4x6 UDFs Ticket Roll Paper 

w_Cutter Zebra 12:29:58          04-21-2026 
G      0               lb 
T      0               lb 
N      0               lb 
PartNum   ABC 
Desc         ABC 
Loc           ABC 
Name       ABC 
Address    ABC 

 
97 2.25x4 GTN T&D GoDex 11:03:34       4-24-2026 

G      0             lb 

T      0             lb 

N      0             lb 

98 4x6 GTN ID T&D GoDex 11:03:34       4-24-2026 

ID     0 

G      0            lb 

T      0             lb 

N      0            lb 

99 Peak Net w T+D Peak Max    0 lb 03:37:21 pm  04-15-2026 
100 Peak Net w T+D CSV Peak Max,   0,lb,03:37:04 pm,04-152026 
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9.2 Error Messages 
The following error messages may be displayed during use of the indicator: 

Message Display 
 

Overload 
 

 
 

Can’t fit on display or load cell 
not properly connected 

 
- - - - - - - 

Underload 
 
 

_ _ _ _ _ _ _ 

Can’t 
 
 

cAnt 

Entry not in valid range 
 
 

boundS 

Password entry failed 
 
 

inVALid 

Remote display not receiving 
data from the master indicator 

 
no dAtA 

Indicator did not reach a stable 
zero weight within time window 

set for automated weighing 
process. 

2-LocH 
PrESS 
ZEro 

Indicates the battery is 
enabled and TMOUT value is 

set but the indicator is not 
operating with the proper 
battery shutoff circuitry 

--oFF-- 
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10. Technical Illustrations 
10.1  Desktop Indicator 
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